
For an index to help topics, click the Search button at the top of the Extreme 3D Help 
window.

For more online help, choose the Show Status Bar command from the Window menu--
instructions appear in the status bar at the bottom of the Extreme 3D window.



Extreme 3D menu commands

Click a menu for information on commands in it:

File menu
Edit menu
View menu
Object menu
Render menu
Animate menu
Window menu
Help menu

Or click a command or submenu:
About Extreme 3D
Adaptive Smoothing
Align Camera
Align
All (Hide)
All (Show)
Animation Controls
Animation Path
Auto Rotate
Auto Working Plane to View
Back (Orient to Object's)
Back Faces (Display Polygon Faces)
Back
Bitmap (Export)
Both (Align)
Both (Display Polygon Faces)
Bottom (Orient to Object's)
Bottom
Bounding Box (Render Style)
Camera (Hide)
Camera (Show)
Cascade
Change Motion Style
Clear All Tracks
Clear Construction Objects
Close Geometry
Close
Construction Objects (Hide)
Construction Objects (Show)
Control Points
Convert Path to Profile
Convert Profile to Path
Copy
Custom (Perspective)
Cut
Delete
Display Polygon    Faces
Duplicate with Link
Duplicate
DXF (Export)



DXF (Import)
Ease Settings
Edit Network Jobs
Enter Render Server Mode
EPSF (Import)
Exit
Export
Extreme 3D Tracks (Export)
Extreme 3D Tracks (Import)
Faceted (Render Style)
Faceted Wireframe (Render Style)
Fast Forward
Final Render Setup
Final Render to Screen
Find
Fit Polylines
Fit to Window
Four-View Setup
FreeHand 4.0/5.0 (Import)
Front (Orient to Object's)
Front Faces (Display Polygon Faces)
Front
Get Info
Global Effects
Help
Hidden Wireframe (Render Style)
Hide (Animation Path)
Hide
History Backward
History Forward
Home
Import
Insert Keyframe
Join Profiles
Layers
Left (Orient to Object's)
Left
Lights
Linear (Motion Style)
Local Lights (Hide)
Local Lights (Show)
Lock Working Plane
Materials
Metafile (Export)
Metafile (Import)
Moderate (Perspective)
Narrow (Perspective)
New View
New Window
New
Next Keyframe
Objects
Open Geometry
Open
Orient to Object's



Orient to Working Plane
Orient Working Plane
Orientation (Align)
Orthographic (Perspective)
Paste
Perspective
Play
Position (Align)
Preferences
Previous Keyframe
Print Setup
Print
Redo
Refresh
Render Style
Render to Disk
Repeat Track
Reverse Ordering (Control Points)
Revert
Rewind
Right (Orient to Object's)
Right
Save As
Save
Scale Time
Scenes
Score
Select All
Select First Control (Control Points)
Select Next Control (Control Points)
Selected Objects (Hide)
Selected Objects (Show)
Separate End Caps
Set Background
Shaders (Render Style)
Show (Animation Path)
Show Ground Plane
Show Status Bar
Show Tool Space
Show Working Plane
Show
Simplify Geometry
Simplify Position Track
Smooth (Motion Style)
Smooth (Render Style)
Smooth Polylines
Step Backward
Step Forward
Stop
Three-Quarters
Tile
To Ground (Orient Working Plane)
To Object (Align Camera)
To View (Align Camera)
To View (Orient Working Plane)



To World (Orient Working Plane)
Top (Orient to Object's)
Top
Trim Curves (Hide)
Trim Curves (Show)
Undo
Uniform Smoothing
Units
Very Wide (Perspective)
Views
Watch Links
Wide (Perspective)
Window Setup
Wireframe (Render Style)
World



Keyboard shortcuts

Click a category for more information:

Object snapping

Tool modifiers

Object manipulation

In addition, keyboard shortcuts for menu commands are shown in the menus.



Object Snapping Keys

Key Snapping Constraint

v Constrains the movement of the object vertically across the working plane, 
along the x-axis.

h Constrains the movement of the object horizontally across the working plane, 
along the y-axis.

n Constrains the movement of the object along a line normal to the working 
plane, along the z-axis.

p Constrains the movement of the object perpendicular to geometry in the hit 
radius.

t Constrains the movement of the object tangent to geometry in the hit radius.
o Snaps to the plane on which the selected object was created.
x Disables snapping.
2 Snaps to a location on the working plane.
3 Snaps to a location in 3D space, off the working plane.



Tool Modifier Keys

To specify a new tool as default tool, press F3 and select the tool.
To rotate the view, press F3 or F4 and drag with the hand tool.
To scale the view, press F2 and drag with the hand tool.
To zoom out, press F3 and click with the zoom tool.
To break a profile at a single point, press F3 and click with the trim tool.
To apply a material to an object and all its child objects, press F2 and click the 
parent object with the bucket tool.
To delete a control point, press F3 and click with the control point tool.
To undo a trim, show the trim curve, then press F3 and click the trim curve with the 3D 
trim tool.



Object manipulation keys

To break a tangent line, creating a sharp corner on a spline curve, press B while 
dragging the tangent line.
To nudge the selected object one unit at a time, press the Up, Down, Left, or Right 
arrow key.
To nudge the selected object forward or backward on the z-axis one unit at a 
time, press Shift+Up arrow or Shift+Down arrow.
To rotate the selected object freely, press F3 (to rotate around y and z only) or F4 (to
rotate around x and y only) and drag.
To rotate the selected object one unit at a time, press F3 (to rotate around y and z 
only) or F4 (to rotate around x and y only) with the Up, Down, Left, or Right arrow key.
To scale the selected object freely, press F2 and drag.
To scale the selected object by a factor specified in the Preferences dialog box,
press F2 with the Up or Down arrow key.
To duplicate an object, select the object and press Ctrl+D.
When moving an object to a new layer in the Layers browser, you can move its 
children to the same layer by pressing F3 and clicking the Move button.
To automatically watch link the camera to an object, press F3 and select the object
with the watch link tool.



Glossary

Click a glossary term to see a definition:
absolute value
adaptive smoothing
alpha channel
ambient
angle of view
animation controls
animation value
anti-aliasing
aspect ratio
back-facing polygons
ball-joint link
bevel
Bezier curve
bitmap
booleans
browser
bump map
cartesian coordinate system
center point
champfer
child object
clipping plane
codec
color
compound profile
compression
cone angle
construction objects
cross-section
cubic mapping
current time field
cycle
cylindrical mapping
default materials
default tool
defining geometry
deformation animation
delta change
diffuse
distant light
distributed rendering
dithering
dolly
down tree
dynamic display area
easing
end cap
end time
environment map
establishing shot
extrude



eye point
fall off
final rendering
flipping
fog
frame
frames per second
free form deformation
free link
fresnel factor
front-facing polygons
gimbel lock
Gouraud shading
grid scale
ground plane
heads-up orientation axis
hierarchy
hither plane
hit radius
hot key area
hue
intensity
interactive renderer
interpolate
intrinsic mapping
keyframe
layer
lathe
lights browser
light editor
light objects
light switch
line
linear motion style
linking
local lights
lock link
look-at point
luminance
materials browser
material editor
mercator map
menu bar
model
moire pattern
negative lights
noise function
normal
nudge
object
object axis
objects browser
objects filter
objects of rotation
offset the animation



omni light
opacity
orthographic perspective
pan
parent-child relationship
parent object
parent relative
paste-replace
perspective
Phong shading
pitch
pixel
playback controls
playback head
playback modes
polygon
polygon normal
polygon resolution
polylist
polyline
polymesh
preset views
preview FPS
profile
projection mapping
projection tool
property
quaternion
RGB
reflection
refraction
render
roll
roughness
roughness map
saturation
scale
scale an animation
scanline renderer
scene
score
shading
shadows
simplifying geometry
skin
smooth motion style
smoothing
specular
specular map
spherical mapping
spline
spotlight
start time
status bar
substitution animation



surface
surface color
surface objects
surface geometry
sweep
tangent line
texture map
tiling
tilt
timeline
time mode
time scale
time value
time zero
tool palette
tool space
track
trackball
track filter
tracking shot
trucking shot
translucent
transparency
trim curve
uniform smoothing
up vector
u-v coordinates
value
velocity
vertex
vertex animation
vertex normals
view
view angle
view relative
views browser
view distance
view distance line
view distance vector
watch link
window
working plane
workspace
world
world scale
Yaw
yon plane
Z-buffer render



absolute value: A value or change in a value of a property that is made with respect to the 
original value.



adaptive smoothing: Smoothing that is applied where needed, rather than uniformly.



alpha channel: The piece of information about a pixel that describes its transparency, 
relative to the other pixels. This is used in compositing images together; it is distinct from 
object transparency.



ambient: A light or color that saturates a whole scene. It simulates the light that suffuses a 
scene after reflecting off of many objects. Ambient color in Extreme 3D is used to do shading
calculations and exists as compensation for the fact that light that bounces off other objects 
in the real world is not present in the Extreme 3D world. 



angle of view: The angle between opposite faces of the viewing pyramid. The viewing 
pyramid is created at the center of the view by two lines that are drawn from the view 
center to the bounds of the view. The angle of view is larger for a more extreme perspective.



animation controls: The Extreme 3D window that contains the VCR-like controls used to 
change the current time and playback an animation.



animation value: The value of a keyframe that represents the change in the object's 
property. The animation value of each keyframe, in combination with its time values and the 
motion style applied to keyframe ranges, determines how the animation for a property is 
interpolated.



anti-aliasing: Removes jaggies, the stair-casing effect that occurs when object edges are 
rendered as pixels. It does so by blending the object's color with what is behind it. Anti-
aliasing also refers to filtering texture maps to prevent distracting moire patterns. 



aspect ratio: The ratio of height to width of an image.



back-facing polygons: Those polygons whose normals point away from the viewer or 
camera.



ball-joint link: A link in which the child can rotate around its center point and be scaled 
independently of its parent, but cannot move independently of its parent.



bevel (also champfer): An angled or shaped cut, such as the kind found on the edge of a 
mirror or a piece of molding. Use the Bevel Extrude tool to create beveled objects from 
profiles.



Bezier curve: The type of spline used in Extreme 3D.



bitmap: A 2D raster image that is composed of pixels. Extreme 3D creates BMP, PICT, and 
TARGA bitmaps.



booleans: Refers to the joining or removing of one shape from another. See also trim 
curve.



browser: One of several windows in Extreme 3D that organizes scene elements. There is a 
browser associated with each type of scene element (Objects browser, Views browser, 
Lights browser, and Materials browser). The Lights and Materials browsers each have 
editors associated with them that allow you to edit the properties of the scene elements 
they contain (Light editor and Material editor). 



bump map: A bitmap image file (PICT or BMP) that is used to modify surface normals. When
applied like a texture map to a surface, the values in the image are treated like a height 
field. The normal is perturbed accordingly, creating the illusion of bumps on the surface. The
color of the map is not applied to the surface.



cartesian coordinate system: A geometry system in which numbers are used to locate a 
point on a plane in relation to an origin where one or more lines intersect.



center point: The point of an object around which the object rotates. The center point of all
objects can be moved. The location of an object's center point determines how it will be 
linked or aligned, and how its surface control points will move when edited.



child object: The subordinate object in a linked object hierarchy. By default, all objects are 
children of the world, so their positions and orientations are relative to the world's 
coordinate system until they are linked to another object. When linked, the child's position 
and orientation is relative to its parent. 



clipping plane: A plane beyond which an object is not visible. A view of the world has six 
clipping planes: top, bottom, left, right, hither, and yon.



codec: a technique for compressing and decompressing a sequence of images (such as 
QuickTime or AVI movies) so they take up less space but can be displayed without a loss of 
information when they are re-opened. See also compression.



color: A property of lights and materials. Materials can be comprised of several colors. Color
is represented as a combination of three values: red, green, and blue. 



compound profile: A profile that is created by modifying or combining other profiles or 
parts of profiles.



compression: One of several techniques for storing images so they take up less space. 
These techniques can be based on color comparisons, difference comparisons, or hardware 
requirements. See also codec.



cone angle: Angle of the cone of light of a spotlight. In Extreme 3D, the maximum cone 
angle is 50 degrees.



construction objects: A set of reference objects--grids, axes, points, and lines--to which 
you can snap or align the components of your model. Construction objects do not appear in 
a final render.



cross-section: A means of creating a surface from two profiles by stretching one profile 
(the cross-section) along the shape of the second profile (the face). 



cubic mapping: A method of placing a texture map on an object such that the map is 
replicated six times. When cubic mapping is applied to a cube, each face is covered by one 
copy of the map.



current time field: The fields at the top of the both the animation controls and the score 
that show and set the current animation time.



cycle: The repetition of a segment of animation used to create repetitive motions like 
pistons pumping, birds flying, and flags waving.



cylindrical mapping: A method of placing a texture map on an object such that the map is 
wrapped into a cylindrical shape around the object and then shrink-wrapped onto it. For 
example, cylindrical mapping can be used to place a label on a bottle. 



default materials: The set of material prototypes in Extreme 3D that are used to generate 
a number of custom materials by editing their basic properties. Extreme 3D has 9 default 
materials. 



default tool: The tool that automatically becomes the selected tool when you finish using 
any other tool. When you first launch Extreme 3D the arrow tool is the default tool. If you 
use a tool different from the arrow tool repeatedly, you might want to make it the default 
tool by selecting it while pressing the F4 key. 



defining geometry: The profiles and tool settings from which a surface was created. 
Extreme 3D lets you edit defining geometry even after the surface has been created. 



deformation animation: A method of animating changes to the shape of an object by 
using the free-form deformation tools. 



delta change: The values of an object's position or orientation that represent the amount 
the value has changed from its previous value. If you know how much you want a value to 
change, use Delta to View and enter the known value into the position or orientation field.



diffuse: The surface color of an object. How the diffuse color looks in the Extreme 3D world 
depends on the angle at which the lights in the scene strike it. This is why the diffuse color 
of a sphere falls off as the surface curves away from the light source.



distant light: A light in the Extreme 3D scene that exists at a point infinitely far away and 
whose effect does not diminish over distance. Distant lights have orientation but not position
values.



distributed rendering: The process of rendering one or more files on a single machine or 
over a network. With distributed rendering you can simultaneously render different frames of
a single scene by using the processing power of several machines on a network. 



dithering: A way of using many pixels of different colors to create the appearance of a color
in-between those of the pixels. 



dolly: A camera motion made with a film or video camera by moving the camera in a 
smooth gliding motion along the sight of the camera. With film and video cameras this move
is usually performed with the aid of a wheeled vehicle called a dolly.



down tree: All those objects that are children to an object.



dynamic display area: The fields at the top of the score that display the keyframe values 
for the currently selected track at the current time.



easing: Controls the way animation is interpolated between keyframes. Easing in gradually 
accelerates the animation from zero velocity; easing out gradually decelerates the animation
to zero velocity.



end cap: A special piece of geometry created by the lathe, sweep, and extrude operations 
and linked to the object to close their otherwise open ends.



end time: The field on the animation controls where you set the end point of the animation 
playback.



environment map: An image file (PICT or BMP) that provides an environment for reflective 
surfaces to reflect. This allows the user to "fake" reflections of a scene surrounding an 
object.



establishing shot: The initial view that usually encompasses the entire scene from which 
camera animation is begun. It is common in traditional film and video work to use 
establishing shots.



extrude: Creates a surface by extending a profile into space along a specified line. In a real-
world example of this process, wood, metal, or clay are forced through a die of a certain 
shape. Water system conduit and pasta are made by extruding.



eye point: The location of the viewer relative to the Extreme 3D world. Views and the 
camera have an eye point.



fall off: The distance at which a light is at half intensity. In the real world, intensity falls off 
with respect to the distance of a light. In Extreme 3D you control the fall-off through this 
value.



final rendering: Uses the high-quality renderer, and can calculate all materials and effects.
It takes longer to render with the final renderer. The time difference varies greatly depending
on how complicated the scene is, the effects used, and which rendering options are 
selected. 



flipping: A method of placing a texture map on an object that mirrors the texture map 
across the axis you specify.



fog: A lighting effect that simulates the effect of fog or haze. In Extreme 3D, use Global 
Effects to add fog to the scene. 



frame: One of the many individual images contained in an animation. 



frames per second: A preference that controls the number of frames that will be 
generated for each second of animation.



free form deformation: A technique for deforming the shape of objects. To use the free 
form deformation tools objects must be simplified. Extreme 3D has five different free-form 
deformation tools--stretch, twist, bend, taper and skew.



free link: A link in which the child object can move independently of its parent, but moves 
when the parent moves. The child changes scale, orientation, and position in response to 
corresponding changes in the parent's scale, orientation, and position.



fresnel factor: An optical effect that makes objects look more optically realistic. When 
brighten edges is selected in one of the smoothing dialog boxes, the reflection intensity 
increases at the object edges. That is, the edges are brighter and the same color as the 
light.



front-facing polygons: Those polygons whose normals point towards the viewer or 
camera.



gimbel lock: A situation in which an object loses the freedom to rotate around one or more 
of its axes. Extreme 3D's use of quaternions to calculate rotations prevents gimbel lock.



Gouraud shading: A shading calculation that computes shading only at polygon vertices 
and averages that color information across polygon faces to create a smooth rendered look 
and a fairly accurate idea the effect of lights. The Smooth render style uses Gouraud 
shading for interactive and final renders. The Shader render style use Gouraud shading 
for interactive renders.



grid scale: That part of the world to grid scale ratio that represents the size an object would
be in the real world.



ground plane: A grid that is located at the center of the Extreme 3D world. It is oriented to 
the x-z plane to create a reference for the ground.



heads-up orientation axis: The axis that appears in the lower left corner of the 
workspace. It indicates the orientation of the view with respect to the world's coordinate 
system. The positive directions of each of the world's coordinates are represented by their 
letter names: x, y, and z.



hierarchy: The relationship of all the objects in Extreme 3D world to each other and to the 
world itself. The World browser and the score present a schematic way of looking at the 
Extreme 3D hierarchy.



hit radius: An area four pixels in diameter around the cursor in which Extreme 3D searches 
for objects to snap to.



hot key area: The space at the left end of the tool space that provides feedback about the 
current snap-to-grid setting.



hue: The particular shade or tint of a color.



intensity: The brightness of a light.



interactive renderer: Creates an approximate render of the scene. It works much more 
quickly than the final renderer. With this renderer, you can see shapes and colors, but some 
of the scene's details, like shadows and fog, are not rendered.



interpolate: The calculation done by the computer to estimate the unknown values that fall
between two known values. The animation values between two keyframes are interpolations
done by the computer.



intrinsic mapping: A means of placing a texture map on a surface using the object's own 
geometry as a guide to placement. Other placement techniques, such as spherical and 
cylindrical, assume the geometry of a sphere or a cylinder to guide the placement.



keyframe: The animation information that a property has at a specific time. Keyframes are 
indicated in the score as small rectangles distributed across the property's track. Keyframes 
are automatically created when you change values at any time other than time zero.



layer: A means of organizing objects in the Extreme 3D world so that they can be hidden 
and shown in related groups.



lathe: A means of creating a surface by rotating a profile around an axis. In the real world, 
wood or metal are turned on lathes against different shaped carving tools to create table 
legs and stair rails. In Extreme 3D the profile can be thought of as the carving tool which 
carves a surface.



lights browser: The window in Extreme 3D used for creating, organizing, and manipulating 
lights.



light editor: Displays the properties for the default lights and lets you edit the properties of
lights as you customize them.



light objects: The objects in the workspace that represent omni lights and spotlights in the 
Extreme 3D world.



light switch: The property of a light that allows you to toggle the light's effect off and on. 
The default state for all lights is on.



line: The length that extends between two points. Use the line tool to draw a straight line in 
the workspace.



linear motion style: Calculates the unknown frame values between two known keyframe 
values or an animation track by figuring out the shortest distance between the two values.



linking: A technique for creating object hierarchies. When you link one object to another 
object, the second object becomes subordinate to the first object. The first object is called 
the parent object and the second object is called the child object. The child object's position 
and orientation are relative to its parent rather than to the world. Parents can have any 
number of children, which in turn can have their own children. A child, however, can only 
have a single parent.



local lights: The generic term for omni light and spotlight objects.



lock link: A link in which the child object is bound to its parent, changing scale, orientation, 
and position in response to corresponding changes in the parent's scale, orientation, and 
position. Neither the parent nor the child object can move, rotate, or be scaled 
independently of each other.



look-at point: The center of the view, that is, the point in the world at which the view 
converges. Views and the camera have a look-at point.



luminance: The brightness or value of a color. It also refers to the total amount of light 
emitted by an object. 



materials browser: The main window in Extreme 3D for creating, organizing, and 
manipulating materials.



material editor: Displays the properties of the default materials and lets you edit the 
properties of materials as you customize them.



mercator map: A 2-dimensional map in which meridians are straight lines at right angles to
the equator. A mercator map of the world distorts the north and south poles, but when 
mapped to a sphere or reflection mapped these features appear to be correct.



menu bar: Contains editing, viewing, object manipulation, animation, rendering, and file 
and window management commands.



model: An object hierarchy that is created by orienting and aligning surfaces with one 
another and linking them together.



moire pattern: A watery, wavy pattern that occurs when the stripes in striped patterns are 
close together and become aliased. 



negative lights: lights with intensity values less than 0.



noise function: A mathematical calculation that uses randomness to generate a color 
pattern. This improves photorealism in 3D scenes.



normal: The direction that is perpendicular to a polygon's surface that is used by Extreme 
3D to perform shading and smoothing calculations (also known as a polygon normal). 
Normals are not displayed and cannot be directly manipulated in Extreme 3D. However, the 
Display Polygons and Reverse Ordering commands, and the Render Edges Sharper option in 
the Uniform and Adaptive smoothing dialog boxes use surface normals to calculate shading 
when objects are rendered.



nudge: To move, scale, and rotate objects in very small increments in the workspace using 
the arrow keys. Set nudge increments in the Preferences dialog box.



object: Any reference guide, profile, surface, or model that can be moved, scaled, or rotated
in the Extreme 3D workspace.



object axis: The axis that appears at the center of all objects when the Display Object Axis 
preference is selected. This axis indicates the orientation of the object in the 3D world's 
coordinate system.



objects browser: The window in Extreme 3D used for naming, moving, reorienting, and 
manipulating 3D objects and profiles.



objects filter: A filter field in the score that allows you to choose the type of objects to be 
displayed in the score list and for which you want animation information displayed.



objects of rotation: Objects created with the lathe tool. They are inherently circular, 
although they may be lathed through only a portion of the circle. Also called surface of 
rotation. 



offset the animation: To move the beginning and ending times of an animation.



omni light: A light that has a position in the 3D world and is represented as an object within
the 3D scene. It shines in all directions (360 degrees).



opacity: Determines how much an object's surface occludes those objects behind it. In 
Extreme 3D, the opacity value directly manipulates the alpha channel. 



orthographic perspective: A viewing perspective that uses an infinite viewing distance. 
With an orthographic view there is no distortion of objects. Objects are lined up in the order 
they recede from the viewer and object size is displayed as if each object were the same 
distance from the viewer.



pan: A camera move accomplished by rotating the camera side-to-side about its vertical (y) 
axis.



parent-child relationship: The hierarchical relationship of linked objects that comprise a 
model.



parent object: An object that has one or more objects subordinate to it in a linked 
hierarchy. 



parent relative: Each object in the world and the world itself exists within a coordinate 
system. The world's coordinate system is always indicated by the head-up orientation axis. 
The coordinate system of each object is indicated by the object's axis. When you enter 
values for an object's position and orientation properties in the Objects browser and parent 
relative is chosen, the object moves relative the its parent's coordinate system. 



paste-replace: Pastes and replaces an object to the position and orientation of a selected 
object.



perspective: A way of viewing objects in 3D space that distorts them according to their 
view distance from the eye point of the view to duplicate the perspective of the real world. 
The shorter the view distance, the wider the perspective and the more distorted the object 
appears; the greater the view distance, the narrower the perspective.



Phong shading: A rendering algorithm that computes shading at every pixel, creating 
higher quality surfaces than Gouraud shading. Phong shading takes more time to render. 
Extreme 3D uses Phong shading in its 32-bit final render.



pitch: Rotation around an x-axis.



pixel: One of the small dots (picture elements) that make up a computer image.



playback controls: The buttons on the animation controls that work like standard VCR 
controls: play, stop, rewind, fast forward, step backward, step forward.



playback head: The marker in the score that can be dragged along the timeline to set the 
current time. The playback head updates automatically to the current frame when the 
current time is changed. 



playback modes: The three settings on the animation controls that determine how the 
animation plays back. The normal setting plays the animation once from the start time to 
the end time; loop plays the animation repeatedly from the start time to the end time until 
you choose to stop; reverse playback plays the animation forward (from the start time to 
the end time), then plays it in reverse (from the end time to the start time continuously.)



polygon: A portion of a surface define d by straight edges. In Extreme 3D, polygons are the 
smallest unit of geometry and assumed to be flat or planar surfaces. Surfaces can be 
reduced to polygons by simplifying them twice. The process of reducing surfaces to polygons
is sometimes called tessellating, or faceting the surface. For purposes of rendering control, 
any surface in Extreme 3D can be displayed or rendered as polygons without simplifying the 
surface by using the render styles available on the Object menu. Extreme 3D converts all 
surfaces to polygons in order to render them. 



polygon resolution: The number of polygons that are drawn to represent an object's 
surface, as seen when you choose the wireframe render style.



polylist: A collection of polygons that describe a surface. A surface with a hole that is twice 
simplified results in a polylist. The polygons of polylist surfaces can have any number of 
sides. The vertices of adjacent polylist polygons are not necessarily shared.



polyline: A line that has more than two points and defines a sequence of straight lines.



polymesh: A rectangular array of vertices that describe a surface. Most surfaces that are 
twice simplified result in a polymesh. The polygons of a polymesh surface are created by 
connecting vertices in a prescribed rectangular pattern. The vertices of adjacent polymesh 
polygons are always shared.



preset views: A set of views available in the View menu that allow you to quickly change 
your view of the workspace and Extreme 3D world. These views enable you to see a model 
or a scene from several preset angles, including front, top, and right.



preview FPS: The field on the animation controls where you set a temporary frames-per-
second rate for previewing animation sequences in the workspace.



profile: The fundamental defining geometry of any Extreme 3D object. Typically, models in 
Extreme 3D are created by drawing profiles using the line, polyline, spline, rectangle, 
square, polygon, circle, ellipse, arc, or tangent arc tools. Extreme 3D's geometry tools--
extrude, lathe, sweep, or skin--can then be used to turn one or more profiles into a surface.



projection mapping: A method of placing a texture map on an object such that the texture
is projected through the object's surface in much the same way that a photo transparency is 
projected through a movie screen or curtain.



projection tool: A tool that projects the shape of a profile onto a surface for the purpose of 
trimming the surface. 



property: An attribute of an object that can be animated. Position, color, and visibility are 
all examples of object properties.



quaternion: A set of four values used by Extreme 3D to describe an object's axis and its 
rotation relative to that axis. Use of quaternions avoids gimbel lock.



RGB: An acronym that stands for red, green, blue. It is the combination of red, green, and 
blue color values that create a given color. Each pixel has its own RGB value. When 32-bit 
color depth is selected, each pixel also has alpha channel (opacity) information.



reflection: Light that is thrown back from the surface of an object.



refraction: Light that is bent as it passes through one medium (air for example) into 
another medium of a different density (glass for example).



render: Creating a two-dimensional picture or series of pictures from the 3-dimensional 
geometry, lights, and materials information contained in a scene file.



roll: Rotation of an object or camera around the z-axis.



roughness: One of the material attributes that affects the specular reflections from an 
object. In the real world this quality is the determined by the physical roughness of a 
surface. The finish of a paint, for example, is determined by the height of particles left 
suspended on the paint. Paints that have high gloss finish contain fewer bumps than paints 
that have a flat finish. The roughness attribute lets you have the same kind of control in 3D 
shading calculations. Extreme 3D uses a color for roughness that allows independent control
of the red, green, and blue roughness values. 



roughness map: A texture map that is used instead of a roughness color to control 
highlights. Roughness maps are often used with specular maps to achieve this effect. 



saturation: The degree of intensity of a color. A color that has less gray in it is more highly 
saturated.



scale: Makes an object proportionately smaller or larger in all three dimensions.



scale an animation: Lengthen or shorten an animation.



scanline renderer: Extreme 3D uses a scanline renderer for 32-bit final renders. All 3D 
renderers need to solve the same problem: What happens when two pixels are in the same 
place, such as when one object is in front of another? Scanline renderers solve this problem 
by keeping track of the geometry of all objects in the scene and sorting objects by their 
distance from the camera at render time.    



scene: An Extreme 3D world that you have customized by adding models, lights, materials 
and/or animation to, and saved in an E3D file.



score: The Extreme 3D window that contains all the time information about each object and
property in the scene.



shading: The coloration of a surface that results from the light striking the surface at an 
angle. 



shadows: A property of distant lights and spotlights that accurately renders shadows cast 
by one object onto the surface of another object. How dark the shadows are depends in part 
on the ambient color, as set in Global Effects.



simplifying geometry: The process of providing access to all the surfaces, splines, 
polygons, and vertices of the geometry that make up an object. When a 3D object is 
simplified in Extreme 3D, the geometry is accessible first as a surface. Each successive 
simplification removes a level of geometry until the geometry is represented as a set of 
polygons.



skin: Stretches a surface over a series of profile ribs. A canoe or an airplane wing are 
examples of objects that can be built by skinning.



smooth motion style: Calculates the unknown frame values between two known keyframe
values or an animation track by interpolating the distance as a curve rather than as a 
straight line.



smoothing: A technique that allows you to interactively change the polygon resolution of a 
surface and set the polygon resolution for the final render. Extreme 3D supports two kinds of
smoothing. Adaptive smoothing interprets the surface of a model as polygons that are 
concentrated more in areas where the surface bends or changes direction rather than in 
broad or flat expanses of surface. Uniform smoothing converts the surface of a model into
a gridwork of evenly spaced polygons.



specular: The direct reflection of light off of a surface. The specular color determines the 
color of the specular highlight of a material.



specular map: A texture map used instead of a specular color to control highlights. Often 
specular maps are used with roughness maps to achieve this effect. Typical specular maps 
include images that are created with noise filters and images composed of cross-hatches or 
scratches.



spherical mapping: A method of placing a texture map on an object style that wraps the 
map like a cylinder around a sphere and then pinches the top and bottom of the image into 
poles, reducing the top and bottom into one point. Then the image is shrink-wrapped onto 
the object. By using a mercator map of the world and using spherical mapping on a sphere 
you can create a globe of the world. See also mercator map.



spline: A curve that is defined by three or more control points. The angle of the curve at 
each control point can be controlled by adjusting the control point's tangent lines. Extreme 
3-D is a spline-based modeler, which means that all surfaces consist of a matrix of spline 
curves instead of a matrix of polygons. This gives you the ability to edit and animate 
surfaces as spline curves.



spotlight: A light that is represented as an object within the Extreme 3D scene whose beam
is emitted as a cone of light that can be specified to be brighter in the middle than at the 
edge. Spotlights can have both positions and orientations.



start time: The field on the animation controls where you set the beginning point of the 
animation playback.



status bar: A help bar at the bottom of the Extreme 3D screen that gives you information 
about using Extreme 3D tools, menu items, and controls. When the cursor is over a tool in 
the tool palette, the status bar displays the name of the tool. When a tool is selected and the
cursor is in the workspace, the status bar tells you how to use the tool. If there are several 
steps involved in using a tool, the status bar displays each step in succession--when you 
complete one step, the next is displayed.



substitution animation: A method of animating seemingly instant changes in which one 
object is substituted for another object at a specific frame.



surface: A matrix of spline-based control points and tangent line end points created by 
applying one of Extreme 3D's geometry tools to a profile.



surface color: This color is combined with the diffuse value to calculate the final color of an
object. 



surface objects: Three-dimensional objects built from one or more profiles using one of the
3D geometry tools.



surface geometry: The geometry that is exposed when a surface object has been 
simplified once. At this level the object appears as a matrix of spline-based control points.



sweep: Creates a surface by pulling a profile along a specified path. Sweeping is similar to 
extrusion, except that sweeping allows you to create more complex shapes that twist and 
bend because the profile can be swept along a curve instead of being restricted to a line. 
Sweeping does not have a real-world parallel, however an object like a faucet can be 
thought of as a swept object. 



tangent line: A line that passes through the control point of a spline and is tangent to the 
curve. The tangent line can be used to adjust the angle of the curve.



texture map: A picture in the form of a PICT or BMP file that is applied to a surface by 
relating the internal coordinates of the picture (sometimes called u-v coordinates) to the 
object coordinates of the surface. Specular and bump maps are special kinds of texture 
maps.



tiling: A method of placing a texture map on an object that replicates the texture map 
across the surface of the object. The number of times the map is tiled is determined by the 
map's scale. You specify the scale when you place the map with one of the texture map 
placement tools.



tilt: A camera move that is performed by rotating the camera up and down about its 
horizontal (x) axis. Tilts are usually less than 180 degrees. They are sometimes called 
vertical pans. 



timeline: The graduated scale along the top of the score that displays the time continuum 
of an animation as calculated by the frames-per-second value set in the Preferences dialog 
box.



time mode: A preference that determines how time is displayed in the current time field of 
the animation controls and the score.



time scale: The filter field in the score that allows you to set the granularity of the score's 
display of keyframes.



time value: The keyframe value that represents the moment in the animation in which a 
change takes place. The time value for each keyframe, in combination with its animation 
values and the motion style applied to keyframe ranges, determines how the animation for a
property is interpolated.



time zero: The point at which animation begins in the Extreme 3D score. You can go to time
zero by setting the current frame field or moving the playback head in the score to 0. 



tool palette: The window that contains tools for creating, modeling, editing, and 
manipulating profiles and surfaces.



tool space: Displays numerical text and measurement information. When creating profiles 
and surfaces, you can edit these values. 



track: Stores all the animation information that belongs to a single property for the length 
of the animation.



trackball: The cube in the browsers that represent the orientation of the current view or 
object.



track filter: A filter field in the score that allows you to choose the properties whose names 
you want displayed in the score list and for which you want animation information displayed.



tracking shot: A camera move that involves moving the camera in a smooth gliding motion
past the subject on a plane parallel to it. Sometimes this is called a trucking shot.



translucent: A substance that lets light through but diffuses it so that objects cannot be 
clearly seen on the other side of it, such as frosted glass.



transparency: See opacity and alpha channel.



trim curve: A curve drawn on an object's surface after a profile has been projected onto the
surface or another object has been intersected with it. The trim curve allows you trim away 
parts of the surface. 



up vector: A line perpendicular to the eye point of the camera that allows the camera 
object to be rolled around the eye point. The up vector also keeps the camera from turning 
upside down when it is watch linked to another object. Any object that is watch linked has an
implied up vector.



u-v coordinates: A rectangular 2D coordinate system imposed on a surface for the purpose
of matching a texture map to a three dimensional surface.



value: The brightness of a color in a Hue, Saturation, Value color system.



velocity: The rate of change in an object's position relative to time.



vertex: The x, y, and z location of each corner of a polygon or control point.



vertex animation: A method of animating changes to the shape of an object by animating 
its surface control points directly in the workspace.



view: A means of changing your position relative to the world. Views can be thought of as 
the directions you give to the computer to fly you through the world in order to look at 
objects in it.



view relative: In view space, the positive X-axis always points to the right of the screen and
the Y-axis always points up. When you enter values for an object's position and orientation 
properties in the Objects browser and select view relative, the object moves relative the 
view's coordinate system. For example, entering a value of one in the X field moves the 
object one unit to the right. 



views browser: The window in Extreme 3D used for creating, organizing, and manipulating 
views.



view distance: The distance between the eye point and the look-at point of the camera or 
a view.



view distance line: The part of the camera object that represents the camera's view 
distance. It is indicated by a line between the eye point and look-at point.



view distance vector: The control point on the camera that adjusts the camera's view 
distance line and its perspective.



watch link: A linking technique in which the z-axis of an object stays oriented to, and 
"watches" the center of another object. When the parent moves, the child rotates to orient 
its z-axis to the watched object's new position. Both objects can move independently of one 
another. This link is most useful for making the camera and lights follow animated objects. 
Both objects can be part of other linked hierarchies.



window: The frame around and boundary of the workspace. The workspace size is 
determined by the size of the window. Up to ten windows can be open simultaneously in 
Extreme 3D and windows of different sizes are supported. The size of a final rendered image 
is determined by the size of the window that is selected when rendering begins. 



working plane: The drawing grid that appears by default in the center of the workspace 
when you first open Extreme 3D. There is always one (and only one) working plane in the 
workspace. The working plane can be oriented to any position in the Extreme 3D world.



workspace: The portion of the Extreme 3D world that is visible in each Extreme 3D window.
The workspace allows you to directly interact with the objects in the Extreme 3D world.



world: The volume of simulated 3D space in which Extreme 3D models are built and scenes 
are created. Every point in the world can be defined as a coordinate of the world's x, y, and z
axes. This virtual world can accommodate almost any size model or scene including objects 
scaled to actual size. It is limited only by your computer's memory capacity and speed.



world scale: That part of the world to grid scale ratio that represents the size an object is 
on the screen. 



Yaw: Rotation around the y-axis.



Z-buffer render: Extreme 3D uses a z-buffer renderer for interactive renders. All 3D 
renderers need to solve the same problem: What happens when two pixels are in the same 
place, such as when one object is in front of another? Z-buffer renderers solve this problem 
by storing the distance of each pixel from the camera plane (the z-distance). The pixel that 
corresponds to the object closest to the camera is rendered last (on top). 



File menu
Click a command or submenu to see information about it.

New
Open
Close
Save
Save As
Revert
Import
Export
Print Setup
Print
Exit

The File menu includes commands for creating, opening, closing, saving, and printing 
Extreme 3D scenes, and for exporting and importing files to and from other applications. 
Depending on the amount of memory in your computer, you can have up to four scenes 
open at a time. 



New
Shortcut:Control+N
Opens a new, untitled scene in Extreme 3D.
When it is first opened, the new scene has the attributes defined in the Extreme 3D 
defaults file. This file is called Default.E3D and is located in the Scripts folder or directory.
You can customize the defaults file. For example, you may choose to add commonly used
views and lighting setups to it or change the measurement system to metric. To use the 
settings of the current file as the defaults, back up the current Default.E3D by renaming 
it. Then choose Save As from the File menu, choose the Scripts directory or folder, and 
name the current file Default.E3D.
Another way to save library items such as lights, custom views, and materials to the 
default file is to copy and paste those items from any Extreme 3D file to the Default.E3D 
file. To do so, open both files. Copy the desired items from the World browser of the first 
file and then paste them into the default file's World browser. 



Open  

Shortcut:Control+O
Opens an existing scene file or MacroModel model. The standard directory dialog box 
appears, showing a list of scene files. All Extreme 3D scene files have the extension .E3D
and MacroModel files use the extension .MDL (Windows). Locate the scene files by 
navigating the directories or folders. Open a scene by double-clicking its name or by 
selecting its name and clicking Open. Up to four scene files can be open at once, but only
one scene is visible at a time.
Note: When opened in Extreme 3D, MacroModel models are converted to Extreme 
3D scenes. Once saved in Extreme 3D format, they cannot be opened in MacroModel.



Close 

Shortcut:Control+F4
Closes the current scene.



Save 

Shortcut:Control+S
Saves the current version of the active scene. This replaces the previous version saved 
under the same name and allows you to continue working on the scene. 
The first time you choose Save after creating a new scene, the Save As dialog box opens 
so that you can name the scene and choose a directory or folder in which to save it.
Extreme 3D scenes are in a cross-platform file format. Scenes created on the Macintosh 
can be opened in the Windows version and vice versa.
Note: The keyboard characters / \ . ? < > | and curly quotation marks can be used in
Macintosh filenames but are not valid in Windows. Filenames that have illegal characters 
are automatically corrected in Windows.
Extreme 3D saves the following information with the scene:

Current window configurations (to change default window configurations, change 
them in the DEFAULT.E3D file)

Units settings
Visibility of the working plane, construction objects, and ground plane
Model information:
- All geometry information
- Render style
- Linking information
- Smoothness settings
- Background color and background picture
Animation information:
- Tracks and keyframes
- Score configurations, including object and track filters, and score position
- Frame rate information
- Time mode setting
- Total length of the animation
Views and camera settings
Materials used in the scene
Global effects settings.
Final render settings.



Save As

Allows you to save an untitled scene, change the name of the current scene, or save the 
scene to a different location. Type the name of the scene in the file name text field. If you
change the location or drive listed in the directory dialog box, that location becomes the 
default in the Open dialog box.



Revert

Reverts to the last saved version of the current scene. Extreme 3D asks you to confirm 
this command, since any changes you've made to the scene since the last time you 
saved the file will be lost.



Import

Imports a file into Extreme 3D and merges the file's contents into the current scene. You 
can import information about profiles, 3D geometry, animation, or text, depending on the
type of file you import. You cannot import information about lights or materials.
There are three options in the Files section of the Preferences dialog box that affect the 
type of files that you can import. For example, to import text into Extreme 3D, you must 
select the Import Text checkbox under the Files page in the Preferences dialog box.
The Import submenu lists the following file types:

Metafile--A 2D image file format that can contain vector information.
EPSF--A 2D file format created by illustration products such as Macromedia 

FreeHand. Extreme 3D reads files in EPSF format and creates profiles from them. Only 
geometry information is imported.

DXF--An ASCII file format that can be converted into 2D or 3D geometry. (Note: There
are a few variations within the DXF format; some will not import successfully.)

Extreme 3D Tracks--ASCII files that allow motion data generated from Extreme 3D 
or other sources to be imported. The name of an object and the data that will be applied to it
must appear in the file.

FreeHand 4.0/5.X--A 2D file created with Freehand; Extreme 3D imports the 
geometry only, ignoring fill patterns and bitmaps.

When you choose an option from the Import submenu, the Import dialog box appears.
Use the options in the directory dialog box to locate the file to import. Click Open to 
import the file. After the file is imported, you may need to choose Fit to Window from the 
View menu to see all imported geometry in the workspace.
Note: Extreme 3D scene files cannot be imported. To include elements from a 
previously created scene in the current scene, open the desired file, copy the elements 
you want, and paste them into the current scene.



Export
Related topic: Exporting scenes

Exports an Extreme 3D scene as a DXF, metafile, or bitmap file. Metafile and bitmap files
are 2D file formats. DXF is a 3D file format. When you choose an option from the Export 
submenu, the Export dialog box appears. 
Type the scene's filename in the file name field. Choose a location for the exported file 
and click Save. See the Exporting scenes help topic for a description of the attributes 
that are retained by each format.



Exporting scenes
The following sections describe file format information for 2D and 3D file formats that 
Extreme 3D exports.
Note: There are options under the Files page of the Preferences dialog box that 
affect the export of some file types. For example, to export a DXF file with the 
construction geometry included, you must select the Output Construction Geometry to 
DXF checkbox.

Exporting scenes in 2D formats
Depending on the file format, 2D scenes exported by Extreme 3D can contain 2D 
geometry, colors, shading, shadows, and anti-aliasing information. The following table 
describes the 2D formats that Extreme 3D uses to export 2D model information. Each of 
these formats retains some but not all of the model information that Extreme 3D exports.

Metafile: A scene in metafile format contains rendered 2D geometry plus a bounding
rectangle. Extreme 3D uses a metafile format that can be placed, offset, and scaled after it 
is imported. When you export scenes in metafile format, smooth shading, shadows, and anti-
aliasing are not retained. Metafile format is useful for technical desktop publishing and high-
resolution printing, and allows for rescaling of polygons. 

Bitmap: A scene exported in bitmap format is an image of the current frame of your 
Extreme 3D scene. When exported, all elements of the current frame are rendered exactly 
as they are on screen, except for any red selection lines. Bitmapped files do not retain 
information about individual objects from which the scene was created. However, the 
bitmapped image retains the appearance of shadows, shading, and anti-aliasing.

Attribute Metafile Bitmap
2D geometry X
Colors X X
Shading X X
Shadows X
Anti-aliasing X

Exporting scenes in 3D format
DXF is a 3D format. Extreme 3D scenes saved in DXF format can be used in applications 
that use DXF files for CAD, rendering, and animation.
DXF models are exported as triangles. Adjust the surface smoothness of objects to 
control each object's polygon density.
To export the working plane and construction geometry (except construction points) with 
DXF files, use the Output Construction Geometry to DXF option on the Files page of the 
Preferences dialog box.
Extreme 3D Tracks exports position and orientation tracks only.

Extreme 
Attribute DXF 3D Tracks
2D geometry X
3D geometry X



Object hierarchy
Lights
Object names
Layers X
Materials
Animation X*

*Position and orientation tracks only

Note: When you export a 3D object, you lose some 3D geometry information. Only 
information about polygons is saved. Therefore, if you later reimport the scene into 
Extreme 3D, levels of information about geometry are lost. Polygon resolution can be 
controlled through the Adaptive or Uniform Smoothing dialog boxes.



Print Setup
Opens the Print Setup dialog box for the installed printer. See the documentation that 
came with your computer for an explanation of the standard features in this dialog box.



Print
Shortcut:Control+P
Prints the workspace of the current window of the scene. When you choose the Print 
command, the standard Print dialog box for the installed printer appears.
Bitmaps print at screen resolution. For information about rendering large images, or 
images whose size is different from the current window size, see the Render to Disk help 
topic.



Exit

Shortcut:Alt+F4
Exits Extreme 3D. If any of the currently open scenes have unsaved changes, you are 
prompted to save.



Edit menu
The Edit menu contains commands for undoing and redoing operations in Extreme 3D, 
and for handling Clipboard operations such as cutting, copying, and pasting, and for 
setting preferences. This menu also contains a command for finding items in the current 
scene.
Click a command to see information about it:

Undo/Redo
History Backward
History Forward
Cut
Copy
Paste
Delete
Duplicate
Select All
Get Info
Find
Preferences



Undo, Redo, History Backward, and History Forward commands

Undo/Redo
The Undo command undoes the last action in the active window. When you choose this 
command, the menu item changes to Redo.
Shortcut:Control+Z
In general, use this command when you've made a mistake. If you haven't executed an 
operation after the error, the screen is restored as it was before the mistake was made. 
Undo is also useful for double-checking your last action because the command name 
changes to indicate what will be undone.
Some commands--such as opening or saving a file, or selecting objects--are irreversible. 
When an action cannot be undone, you can revert to the last saved version of the file by 
using the Revert command on the File menu.
To undo more than one action, choose History Backward. 

History Backward
Shortcut:Control+H
Moves backwards through a history list of actions that have been performed and undoes 
up to the last 10 actions performed in the active window. All changes in the workspace, 
including view changes, enter the undo queue. If there are no more changes to undo, or 
if no changes have been made to the current scene since the last Save, this command is 
dimmed. When you make another scene active, the existing list of actions that you can 
undo is lost. 

History Forward
Shortcut:Shift+Control+H
Moves forward through a history list of actions that have been undone and performs 
those actions again. There are 10 undo actions in the history list. If there are no more 
actions left to redo, the command is dimmed. 



Cut

Shortcut:Shift+Delete or Control+X
Removes the selection from the scene and places it on the Clipboard. The Clipboard 
contents can then be pasted elsewhere in Extreme 3D. This command operates on 
multiple selected geometry objects in the workspace or a single selected geometry 
object in the World browser, a selected animation path in the workspace, selected tracks 
in the score, a selected keyframe or range of keyframes in the score, and a selected item
in a current browser including a view, light, material, or image. When you cut an object 
that is a parent link to other objects, the child objects are cut as well. Child objects are 
highlighted in gray when the parent is selected. When cutting an animated object from 
the workspace, its animation tracks are cut as well. You can cut and copy objects among 
multiple open scenes.

Cutting multiple objects
If the selection includes more than one geometry object, Extreme 3D adds a construction
point to the selection when it is cut to the Clipboard. The construction point becomes a 
parent to the selected objects and serves as a reference point for maintaining the 
objects' spatial relationships to each other. This object appears in the World browser as 
ParentOfPasted. 
Cutting an object that is selected by name in the score list cuts only the track data, not 
the object itself. Use this feature to share animation data with other objects. When an 
animated object is selected in the workspace and cut, the object and all its animation 
tracks are cut.

Cutting tracks and keyframes
When a track is cut from the score, all the keyframes for the track are cut. The property 
itself is not removed. 
Note: When cutting keyframe ranges, keyframes later in time adjust to fill in the 
space. To avoid this, cut each keyframe in the range separately. When tracks are cut from
the score, the properties of the object to which they belong retain the values of the 
current time setting.

Cutting elements from browsers
Selecting an element by name in a browser and using cut removes that element from the
browser and from the scene. Only one element can be cut from a browser at a time.



Copy

Shortcut:Control+Insert or Control+C
Places a copy of the selection on the Clipboard. The copied selection can then be pasted 
elsewhere. This command operates on multiple selected geometry objects in the 
workspace or a single selected geometry object in the World browser, selected animation
paths in the workspace, selected tracks in the score, a selected keyframe or range of 
keyframes in the score, and a selected item in a current browser including a view, light, 
material, or image. When you copy an object that is a parent to other objects, the child 
objects are copied as well. Child objects are highlighted in gray when the parent is 
selected.
When copying an animated object, its animation tracks are copied as well. Materials are 
not copied with the object. 

Copying multiple objects
You can cut and copy objects among multiple scenes. If the selection includes more than 
one object, Extreme 3D links the selection to a construction point when it is copied to the
Clipboard. The construction point becomes a parent to the selected objects and serves as
a reference point for maintaining the objects' spatial relationships to each other. This 
object appears in the World browser as ParentOfPasted. 
When an animated object is selected in the workspace and copied, its animation tracks 
are copied as well.
Copying an object that is selected by name in the score list copies only the track data, 
not the object itself. Use this feature to share animation data with other objects.



Paste

Shortcut:Shift+Insert or Control+V
Pastes the Clipboard contents into the active window. This command operates on 
multiple selected geometry objects in the workspace or a single selected geometry 
object in the World browser, a selected animation path in the workspace, a selected track
in the score, a selected keyframe or range of keyframes in the score, and a selected item
in a current browser including a view, light, material, or object. When copying and 
pasting an element from one file to another, its values are retained. The copy has the 
same name as the original in any browser list in which it appears.

Pasting objects into the workspace
If an object is selected in the workspace when another object is pasted, the pasted object
replaces the selected object. This is useful for working with simple placeholder objects 
and then pasting the real objects in later. 
If multiple objects are pasted in the workspace, the ParentOfPasted construction point is 
pasted into the workspace as well. Use the unlink or reparent tool to unlink the objects 
from the ParentOfPasted and reparent them to the world or another object in the scene.
Note: If multiple objects from one scene are scaled incorrectly when pasted into 
another scene, scale the ParentOfPasted to scale all of the pasted objects. This must be 
done before unlinking or reparenting objects from the ParentOfPasted.

Pasting tracks and keyframes
Pasting a track into the score replaces all the values in the currently selected track with 
the values of the pasted track. Single keyframes are pasted at the current time into the 
currently selected track.
Single keyframes and single and multiple rotation keyframes retain their values when 
pasted into a new track. Multiple keyframes are pasted with values relative to the new 
track.
To paste all the tracks copied or cut from one object into another, select the object by 
name in the score. All tracks that apply to this object are pasted. Those that do not apply
are ignored. The object itself is not replaced.

Pasting elements into browsers
When an element is pasted into the Views, Lights, Materials, or World browser, the new 
element is added to that browser's list. Replacing the currently selected element with the
element being pasted does not apply when pasting into a browser.
If you attempt to paste clipboard contents into an inappropriate browser--materials into 
the Views browser, for example--or into an inappropriate area in the appropriate 
browser--material color track keyframes into an object position track, for example--
Extreme 3D beeps and does not execute the command. 
Tip: Cutting and pasting objects to a library of Extreme 3D files is an excellent way
to reduce display time, experiment with a copy of a scene in a new file, build a complex 
scene, or create a library of materials, lights, and views, which you can copy into other 
scenes. To create a library file, open a new Extreme 3D scene and use a name that 



distinguishes it as a library. Then when you create materials, lights, and views that you 
want to use again, copy them into the library file. When you want to use the item in 
another scene, copy it from the library file. To avoid time-consuming screen redraws, 
keep the library scene small and copy and paste items between browsers.



Delete

Shortcut:Delete
Removes the selection without copying it to the clipboard. This command operates on 
single or multiple selected geometry objects in the workspace, single selected geometry 
objects in the World browser, selected animation paths in the workspace, a selected 
track in the score, a selected keyframe or range of keyframes in the score, and a 
selected item in a current browser including a view, light, or material. If you accidentally 
clear a selection, reverse the action with the Undo command. 
If you clear a numeric entry field in a browser, the field's value reverts to its minimum or 
zero.
Note: Clearing a light or material from the browser list does not remove it from the 
catalog. Delete is not available for items in catalog lists.



Duplicate

Shortcut:Control+D
Duplicates the current selection. This command operates on selected geometry objects 
in the workspace and on a selected item in the current browser.
The results of using this command differ depending on whether a browser or the 
workspace is active. If a browser is active, a duplicate browser item is created that has 
all the same values as the original selection. When an object is selected in the 
workspace, a duplicate object is created and is offset from the original by 1 unit. All link 
and attribute information is preserved, except for watchlinks. Animation tracks are also 
preserved.
The duplicate object is named after the current selection with a period and a sequential 
number added to the end of the object's name (.1, .2, and so on) in the active browser's 
list.
Note: When you duplicate the Working Plane, the duplicate is created as a 
construction grid.



Select All 

Shortcut:Control+A
Selects all visible objects in the current window. All objects are highlighted as selected. 
Note: In a scene containing parent objects, children objects are selected but are not 
affected by some operations. Those tools and commands that apply to children as well as
parents are noted under the specific tools and commands.



Get Info 

Shortcut:Control+I
This command opens the appropriate browser and displays the settings for a selected 
item. For example, when you select a light in the World browser and choose Get Info, the 
Lights browser opens with the selected light highlighted. Open the Edit dialog box in the 
Lights browser to display settings for the selected light. 
Use the About Extreme 3D command to find the number of objects, patches, and 
polygons in the scene. Choose About Extreme 3D from the Help menu.



Find  

Shortcut:Control+F
Opens the Find dialog box, in which you can search by name for any object--including 
geometry, lights, materials, and views--in the current scene.
If the same name is used for more than one item, the Find command searches the 
browsers in the order that they appear in the World browser. When it finds the named 
object, it opens the appropriate browser with the found object selected. Find is not case 
sensitive. 

Find What
Enter the partial or whole name of the item you're searching for in this text box. 

Use Whole Words
Finds only words that exactly match the find text. For example, if you are searching for 
the word "ax," Extreme 3D will find all single occurrences of "ax," but will not find 
"saxophone" or "fax."

Add to Selection
Selects all the objects that match the text in the Find What field and adds them to the 
current selection. For example, if you enter "cat" in the Find What text field, Find will 
make everything that matches "cat" a part of the current selection in the workspace. 
Tip: It's a good idea to use a consistent convention for naming objects. For 
example, you might name a selection of chair styles Chair 1, Chair 2, and so on. You 
could then use the Find command with Add to Selection to select all your chair models at 
one time.

Find
Searches for the text in the Find What Field. Continue clicking Find until you have found 
all occurrences of the text.



Preferences

Opens the Preferences dialog box, in which you can set Extreme 3D options the way that 
you find most convenient.
All preferences are saved in the Extreme 3D preferences file. Preferences are restored 
whenever a scene is opened. This file is called E3Dprefs.PRF.
The Preferences dialog box contains five pages that categorize preferences by operation.
Each page is tabbed and labeled. Click a category for more information:

Geometry
Animation
Views
Files



Geometry preferences

Contains options that affect creating and manipulating geometry in the workspace.

Cap Ends
Automatically includes front and back caps on all lathed, swept, and extruded objects. 
Caps are geometry created by the lathe, sweep, and extrude operations and linked to the
object to close their otherwise open ends. The default is on.
Note: End caps are separate objects and are a different geometry type than the 
patches that define the sides of an extrusion, sweep, or lathe. You cannot use the project
or 3D trim tools on end caps unless you first use the Separate End Caps command on the
Object menu to convert the geometry type.

Snap to Ground Plane
Includes the ground plane as an object to consider in determining the snap location. With
this option on, you can snap to the ground plane just like any other construction object. 
The default is on.

Display Object Axis
Displays the object axis for all 3D geometry objects when they are selected in the 
workspace. The default is on.

All Tools Sticky
Makes the most recently selected tool remain selected, rather than reverting to the 
current default tool. When this option is not checked, Extreme 3D always reverts to the 
default tool after a tool is used. The default is off.
Note: When All Tools Sticky is not active, you can make any tool the default tool by 
pressing F3 when selecting it. 

Nudge Position 
Sets the increments for how much an object moves when it is nudged with the arrow 
keys. The nudge position uses the unit of measurement specified in the Units dialog box. 
The default is 0.1 units.

Nudge Angle
Sets the increments for how much an object moves when its rotation is nudged with the 
arrow keys. The nudge angle is in degrees. The default is 5 degrees.

Nudge Scale
Sets the increments for how much an object is scaled when its size is nudged with the 
arrow keys. The nudge scale amount is a scaling factor. The default is 1.2.



Display Width
Sets the number of decimal places for all numeric entry fields. The default is 4 decimal 
places.

Entry Width
Sets the number of decimal places for all numeric entry fields. The default is 4 
characters.

Fit Tolerance
Used by the Fit Polylines command to determine how closely the new spline will conform 
to the original polyline. The default value is 0.5 pixels.



Cap Ends on vs. Cap Ends off



Animation preferences

Contains options that affect animation.

Play Animations Using
Sets the render style that is used for animation previews. Bounding Box Render Style 
redraws faster. Previewing animation using the Currently Selected Max Render Style may
be slower, depending on the maximum render style for that window (set in the Window 
Setup dialog box). It is best for previewing the animation of background images, 
materials, texture maps, and lights. The default is Bounding Box Render Style.

Display Time In
Determines the time scale for the score and animation controls windows. Choose either 
Frames, or Seconds, which displays the time in seconds: hundredths of seconds. The 
default is Frames.

Frames Per Second
Controls the number of frames that will be generated for each second of animation. The 
fewer frames per second, the faster the motion appears. This value may be temporarily 
overridden by changing the preview value in the animation controls or the rate value in 
the Render to Disk dialog box. The default value is 30 frames per second, which is the 
standard frame rate for images output to NTSC video.
Note: Animations, once created, use absolute time, so even if you change the frame 
rate, the duration of the animation remains the same. For example, a 3 second animation
at 30 FPS is still 3 seconds long if you change the frame rate to 15 FPS. Use the Scale 
Time command on the Animation menu to change the duration of an animation.

Animate Visibility Changes
Determines whether changes to objects' visibility are animated. With this box checked, 
any change to the visibility of an object via Hide or Show, the use of layers, or the per-
object visibility checkbox in the Objects browser, will result in an animation track for 
visibility. The default is off.
There are different ways to make an object appear in an animated scene. The ideal way 
to do this is to use visibility settings rather than setting its opacity to zero or scaling it 
very small.



Views Preferences

Contains options that affect windows.

Create New View for New Window
Adds a new view to the views list in the Views browser every time a new window is 
created. If this is not selected, the new window displays the current view. The default is 
on.

Display Heads-up Orientation Axis
Displays the heads-up axis in the lower left corner of every window. This axis indicates 
the orientation of the view with respect to the world. The default is on.

Update All Windows During Animation Playback
Redraws all open windows during animation playback. The default is off.



Files Preferences

Contains options for importing images into Extreme 3D and saving files. 

Import Text
Imports text from a DXF or FreeHand 4.0 or 5.0 file as a separate object. The default is 
off.

Output Construction Geometry to DXF
Includes the working plane and construction geometry (except construction points) with 
other geometry in any scene that is exported as a DXF file. This is useful only when the 
working plane and construction geometry are needed for reference when working with 
the DXF file. The default is off.

Save Compact Files
Compresses an Extreme 3D file when it is saved. Compact files save all geometry. Some 
levels of geometry information are not saved, but are rebuilt the next time you open the 
file. It takes longer to open a file that has been saved with Save Compact Files enabled, 
but the file size is smaller. The default is off.

Distributed Rendering Path
Displays the directory on the network in which images rendered using distributed 
rendering will be stored. 

Set Distributed Rendering Path
Designates the network directory for storing images created with distributed rendering.
The directory must be the same for the server and all submitting machines, and each 
machine must be able to read and write files to it. If the directory is not set correctly, the 
system will attempt to give you a warning message, but it may also write network control
files to unintended places. 
To set the distributed rendering path, click the Set Distributed Rendering Path button and
locate the folder to use. Click OK to use that folder.

Render Server Name
Designates the name of the server machine. Designating the server name is not 
necessary but it helps identify the systems in use.



View menu

This menu contains commands for modifying the way you view objects in Extreme 3D. 
Commands on this menu do not modify objects, they only change your position relative 
to the object. 
Click a command or submenu to see information about it:

New View
Perspective
Fit to Window
Front
Back
Left
Right
Top
Bottom
Three-Quarters
Home
Align Camera
Orient to Object's
Orient to Working Plane



New View

Creates a new view by duplicating the current view. The new view then becomes the 
current view and is named after the view it duplicates. To help avoid confusion, a number
is appended to the end of new view's name in the Views browser's list of views. To 
change the name of the view, enter a new name in the Views browser's text entry field 
while the new view is selected and press Enter. Use the Views browser to change the 
view settings of the new view to those you want.
To recreate the view that is available upon opening Extreme 3D, choose Home from the 
View menu before selecting New View. The following table lists the settings that belong 
to the default view and describes the ways to change view settings.
Note: The camera view is the only view that can animate. All view settings for the 
camera view can be animated and are represented by tracks in the score. 
Here's how to change each view attribute:

Position (Default value x=0, y=0, z=0) -- Type values in the Views browser.
Use the hand tool.
Use the Fit to Window command on the View menu.
Use Orient to Working Plane command on the View menu.
Use Orient to Object's command on the Object menu.

Orientation (Default value y=0, x=0, z=0) -- Type values in the Views browser.
Use the F3 or F4 key with the hand tool.
Use the x, y, or z tools in the hand group.
Use the Orient to Working Plane command on the View menu.
Use the Orient to Object's command on the Object menu.

Scale (Default value 1.0) -- Type values in the Views browser.
Use the Fit to Window command on the View menu.
Use the zoom tool.
Use the F2 key with the hand tool.

Perspective (Default value Narrow) -- Use the Perspective command on the View 
menu.



Perspective

The commands on the Perspective submenu change the view distance to adjust the 
perspective of the view. 
The shorter the view distance, the wider the perspective; the greater the view distance, 
the narrower the perspective. By default, view distance units are in inches. Change the 
default units using the Units command on the Object menu.
Note: The perspective of the camera view can be animated. This is done by 
selecting one of the perspective commands when the current window contains the 
camera view or when the camera view is the currently selected view in the Views 
browser. Changing the camera's projection plane point animates the view distance and 
hence the camera view's perspective.
By choosing an option from the Perspective submenu, you can alter the view distance, 
and therefore the appearance, of objects. Objects' position and orientation remain 
unchanged. The default perspective is Narrow. When you choose Fit to Window, the 
Perspective setting automatically changes to Moderate unless you are in Orthographic 
perspective. Orthographic perspective uses an infinite viewing distance. There is no 
distortion of the objects because there is no perspective.

Perspective View distance if units are in inches*
Orthographic infinite
Narrow 13.9
Moderate 6.9
Wide 4.1
Very Wide 2.1
Custom The value you set in the Custom Perspective dialog box
* The view distance uses the unit of measurement set in the Units dialog box.

The Custom item on the Perspective submenu opens a dialog box in which you can 
define a custom perspective for the scene. By entering a number in the View Distance 
field, you establish the distance between the viewer's eye and the screen. Use the values
in the preceding table for reference when creating a custom perspective.
Note: You cannot set a custom perspective to a view distance less than 0.7 inches 
(17.63 centimeters) or greater than 13.9 inches (35.28 centimeters). Use the 
Orthographic view when you want a view distance greater than 13.9 inches.



Different perspectives: 1. Narrow, 2. Moderate, 3. Wide, 4. Very wide    



Fit to Window

Shortcut:Control+3
Scales the view and changes the perspective so that all visible objects can be seen in the
workspace. If the view is zoomed out, it can also scale the view larger to fill a larger 
portion of the window. This command is useful for finding objects that are not included by
the current view angle. 



Front 

Shortcut:Control+5
Reorients the eye point of the view to look along the positive z axis in the direction of the
negative z axis of the world. The look-at point (the focus of the view), does not change. 
All of the preset views use the following defaults:

Position: 0, 0, 0
Scale: 1.0
Perspective: Narrow

The following table summarizes each view's orientation.
Preset View Orientation
Front 0, 0, 0
Back 180, 0, 180
Left 0, -90, 0
Right 0, 90, 0
Top -90, 0, 0
Bottom 90, 0, 0
Three-quarters -30, -30, 0
Home 0, 0, 0



Back

Reorients the eye point of the view to look along the negative z axis in the direction of 
the positive z axis of the world. The look-at point (the focus of the view), does not 
change. 
All of the preset views use the following defaults:

Position: 0, 0, 0
Scale: 1.0
Perspective: Narrow

The following table summarizes each view's orientation.
Preset View Orientation
Front 0, 0, 0
Back 180, 0, 180
Left 0, -90, 0
Right 0, 90, 0
Top -90, 0, 0
Bottom 90, 0, 0
Three-quarters -30, -30, 0
Home 0, 0, 0



Left

Shortcut:Control+4
Reorients the eye point of the view to look along the negative x axis in the direction of 
the positive x axis of the world. The look-at point (the focus of the view), does not 
change. 
All of the preset views use the following defaults:

Position: 0, 0, 0
Scale: 1.0
Perspective: Narrow

The following table summarizes each view's orientation.
Preset View Orientation
Front 0, 0, 0
Back 180, 0, 180
Left 0, -90, 0
Right 0, 90, 0
Top -90, 0, 0
Bottom 90, 0, 0
Three-quarters -30, -30, 0
Home 0, 0, 0



Right

Shortcut:Control+6
Reorients the eye point of the view to look along the positive x axis in the direction of the
negative x axis of the world. The look-at point (the focus of the view), does not change. 
All of the preset views use the following defaults:

Position: 0, 0, 0
Scale: 1.0
Perspective: Narrow

The following table summarizes each view's orientation.
Preset View Orientation
Front 0, 0, 0
Back 180, 0, 180
Left 0, -90, 0
Right 0, 90, 0
Top -90, 0, 0
Bottom 90, 0, 0
Three-quarters -30, -30, 0
Home 0, 0, 0



Top 

Shortcut:Control+8
Reorients the eye point of the view to look along the positive y axis in the direction of the
negative y axis of the world. The look-at point (the focus of the view), does not change. 
All of the preset views use the following defaults:

Position: 0, 0, 0
Scale: 1.0
Perspective: Narrow

The following table summarizes each view's orientation.
Preset View Orientation
Front 0, 0, 0
Back 180, 0, 180
Left 0, -90, 0
Right 0, 90, 0
Top -90, 0, 0
Bottom 90, 0, 0
Three-quarters -30, -30, 0
Home 0, 0, 0



Bottom

Shortcut:Control+2
Reorients the eye point of the view to look along the negative y axis in the direction of 
the positive y axis of the world. The look-at point (the focus of the view), does not 
change. 
All of the preset views use the following defaults:

Position: 0, 0, 0
Scale: 1.0
Perspective: Narrow

The following table summarizes each view's orientation.
Preset View Orientation
Front 0, 0, 0
Back 180, 0, 180
Left 0, -90, 0
Right 0, 90, 0
Top -90, 0, 0
Bottom 90, 0, 0
Three-quarters -30, -30, 0
Home 0, 0, 0



Three-Quarters

Shortcut:Control+9
Displays the scene in -30, -30, 0 orientation. The look-at point (the focus of the view), 
does not change. 
All of the preset views use the following defaults:

Position: 0, 0, 0
Scale: 1.0
Perspective: Narrow

The following table summarizes each view's orientation.
Preset View Orientation
Front 0, 0, 0
Back 180, 0, 180
Left 0, -90, 0
Right 0, 90, 0
Top -90, 0, 0
Bottom 90, 0, 0
Three-quarters -30, -30, 0
Home 0, 0, 0



Home

Shortcut:Control+1
Reapplies the defaults to the current view.

Position: 0, 0, 0 
Orientation: 0, 0, 0 
Scale: 1.0
Offset: Center of the world
Perspective: Narrow 



Align Camera

Aligns the camera with the current view or selected object. 

To View
Aligns the camera's position, orientation, scale, and perspective to that of the current 
view and inserts keyframes at the current time in these camera property tracks.

To Object
Aligns the camera's position and orientation to that of the selected object and inserts 
keyframes at the current time in the camera's position and orientation tracks.



Orient to Object's

The commands on the Orient to Object's submenu determine the angle from which you 
view the selected object. When you choose a view from the submenu, the current view in
the workspace changes to the one you selected. This command is not available if 
multiple objects are selected, except for children of the selected object.
These commands set the look-at point to be coincident with the center of the object. This
is different from the view changes applied with the preset views on the View menu (such 
as Front, Back, Top). Orient to Object's interprets Front as the front of the object. The 
preset view commands on the View menu interpret Front as the view seen from the 
positive z direction of the world.

Orientation Shows
Front Front of the object at (0, 0, 0) orientation
Back Back of the object at (0, 180, 0) orientation
Left Left side of the object at (0, 90, 0) orientation
Right Right side of the object at (0, 90, 0) orientation
Top Top of the object at (90, 0, 0) orientation
Bottom Bottom of the object at (90, 0, 0) orientation



Orient to Working Plane

Sets the orientation of the current view to that of the working plane. This command is 
not available if Auto Working Plane to View is active.



Object menu

This menu contains commands for manipulating objects in Extreme 3D. 
Click a command or submenu to see information about it:

Hide
Show
Orient Working Plane
Show Working Plane
Lock Working Plane
Auto Working Plane to View
Show Ground Plane
Join Profiles
Fit Polylines
Smooth Polylines
Align
Open Geometry
Close Geometry
Simplify Geometry
Control Points
Render Style
Separate End Caps
Duplicate with Link
Clear Construction Objects
Units



Hide

Commands on the Hide submenu remove selected objects, the camera, local lights, 
construction geometry, and trim curves from view. 
Shortcut:Shift+Control+I
Hiding the camera hides the camera object only. The camera view is always available.
Hiding selected objects also hides the object's children.
Hidden objects are not rendered. To show a hidden object, select it by name in the World 
browser and then choose Show Selected Object. You may need to use Fit to Window to 
include it in the view. To show all hidden objects, choose All from the Show submenu.
Hiding construction geometry hides construction lines, points, and axes, and simplifies 
the appearance of the scene. To show and hide the working plane and ground plane, 
choose one of those commands on the Object menu. To show and hide the Heads-up 
Orientation axis or the object axis for all objects, select those options in the Preferences 
dialog box. 
Objects can also be hidden by using the layers browser to assign them to a layer and 
then hiding that layer, or by toggling the visibility checkbox for the object to off in the 
Objects browser.
Note: Hiding or showing an object can modify its visibility track in the score. Use the 
Animate Visibility Changes preference to control this.



Show

Shows a hidden object that has been selected by name in the World browser, the 
camera, local lights, construction objects, or trim curves. 
Choose All to display all objects that have been hidden with the Hide command, layers, 
or any visibility state toggle.
When Camera is selected, the camera object appears in the current window, unless the 
current window is displaying the camera's view or the view in the current window isn't 
zoomed out far enough to encompass it. If the current window is not displaying the 
camera's view and the camera does not appear when Camera is selected, use Fit to 
Window.
Showing Selected Objects also shows that object's children. You can also select a hidden 
layer on the Layers browser and click Show to show that layer.



Orient Working Plane 

Sets the working plane parallel to the chosen plane. This command is dimmed when the 
working plane is locked or when Auto Working Plane to View is selected.

To View 
Shortcut:Shift+Control+V
Sets the working plane parallel to the screen. To automatically orient the working plane 
so that it is parallel to the screen whenever you change views, choose Auto Working 
Plane to View on the Object menu.

To World
Shortcut:Control+U

Sets the working plane parallel to the world axes that most nearly face the current view. 

To Ground
Shortcut:Shift+Control+G
Sets the working plane coincident to the ground plane. The ground plane is always in a 
fixed location, oriented to the xz plane of the world with its center at 0, 0, 0. 



Show Working Plane

Shortcut:Control+Y
Toggles between displaying and hiding the working plane grid in the workspace. The 
working plane is displayed by default when Extreme 3D opens.
Regardless of whether the working plane grid is toggled on or off, all objects move 
relative to it. The labels h (horizontal) and v (vertical) provide orientation cues when the 
working plane is moved. The depth dimension is indicated by a line that extends from 
the center of the working plane. Snapping to this line is allowed. 



Lock Working Plane

Shortcut:Shift+Control+Y
Locks the working plane to its current orientation in the workspace. This command is not 
available when Auto Working Plane to View is active. 



Auto Working Plane to View 

Shortcut:Shift+Control+Z
When active, shifts the working plane to be parallel to the screen whenever you change 
the view. It does not change the position of the working plane, only its orientation. For 
example, if you change the view from the front to the right, the working plane 
automatically rotates so that it is parallel to your new view. If you do not want the 
working plane to shift automatically with every view change, leave this command 
inactive. The default is on. This command is not available when Lock Working Plane is 
active.
Auto Working Plane to View is useful when animating in multiple windows. You may want 
to turn it off when modeling.
When Auto Working Plane to View is inactive you can use the Orient Working Plane to 
View on the Object menu to reorient the working plane on a one-time basis. The working 
plane tool works regardless of the Auto Working Plane to View status.



Show Ground Plane

Toggles between showing and hiding the ground plane in the workspace. The ground 
plane is hidden by default. Snapping to the ground plane is optional and is set in the 
Preferences dialog box. The ground plane is always in a fixed location, oriented to the xz 
plane of the world with its center at 0, 0, 0. The ground plane cannot be selected.



Join Profiles

Shortcut:Control+J
Joins separate profiles into a single object. To create a joined shape, select two or more 
open 2D shapes (such as lines, arcs, and open polyline shapes) whose endpoints are 
touching or within the snap radius and choose Join Profiles from the Object menu. 
When the objects are joined, you can edit the object's shape by moving its control points.

Note: The connecting end points of profiles need to be within the snap radius for Join
Profiles to work. For profiles that are far apart, zoom out before joining. For detail work, it
is useful to zoom in on the profiles to be joined and snap points to each other before 
joining them. Move one point to another with the 3 key pressed to ensure that points are 
snapping in all coordinates.



The circle segment and the three-sided polyline were brought into contact and then joined.    



Fit Polylines

Changes polylines into splines by approximating the polyline's control points and 
rounding the edges. Fit differs from the Smooth command because it reduces the 
number of control points in the object. 

The Fit Tolerance option in the Preferences dialog box determines how closely the surface of 
a fitted object follows the shape of its underlying geometry. If the Fit Tolerance is 1, then the 
fitted surface can be as much as 1 model unit away from the original underlying geometry. If
the fit tolerance is very small, say 0.1, then the surface will approximate the original 
underlying geometry very closely.



Left: regular polyline. Right: fitted polyline.    



Smooth Polylines

Smooths objects that were created with the polyline tool by turning them into splines and
rounding their edges.



Align

The commands on the Align submenu control the position and orientation of selected 
objects in relation to their parents. If a selected object does not have a parent, it is 
aligned with the center of the world.

Position 
Places the center point of the selected object at the center point of its parent. 

Orientation 
Aligns the selected object so that it has the same orientation as its parent.

Both
Aligns the position and the orientation of the object with the center point of its parent. 
When aligning objects' center points, you often need to relocate the center point of the 
individual objects so that objects have the correct position relative to each other. For 
example, if the bolt in the above illustration had its center point at the bolt's head, the 
nut would attach at the end of the bolt rather than the middle. You can move the center 
point of an object using the object center tool in the tool palette. Or you can first align 
the bolt and the nut and then move the bolt under constraint.



The nut is the child and the bolt is the parent. In the center, the nut is aligned to the bolt's 
position but not its orientation. On the right, the nut is aligned to the position and orientation
of the bolt.      



Open Geometry and Close Geometry commands

Open Geometry    
Shortcut:Shift+Control+O (the letter)
Opens all selected objects so that they can be edited. This is the same as double-clicking
the object. When an object is open for editing, its current level of editable components--
profile, spline, or control points--appear in the workspace. These components appear by 
name in the World browser in hierarchical order under the object's name.
When editing geometry, you can drag control points to change the shape of the surface 
or profile (once the object has been simplified). However, when a control point is 
selected, pressing Delete or choosing Cut will delete the object. To delete individual 
control points, use the control point tool.

Close Geometry
Shortcut:Shift+Control+W
Closes the selected object so that its editable components do not appear in the 
workspace. You can also double-click an open object to close it.



Simplify Geometry

Changes the level of geometry at which an object can be edited. Simplifying a parent 
object does not simplify its children. Each child needs to be selected and simplified 
individually. There are three levels of geometry: 

Defining geometry--The original level of geometry. This geometry level provides the
highest level of control over the object's shape. At this level, the object's underlying profiles 
are left intact and the general form of the object is modified by adjusting those profiles. 

Surface geometry--Presents the object's underlying profiles as a mesh of splines, 
each having control points and tangent bar endpoints. You adjust the form of the object by 
dragging the control points and tangent bar endpoints or by numerically editing a selected 
point in the Objects browser.

Polymesh or polylist geometry--Presents the surface of the object as a mesh of 
polygons. An object with a hole, when simplified, produces the matrix as a polylist. Polygons 
in a polylist are triangular. An object without a hole, when simplified, produces the matrix as 
a polymesh. Polygons in a polymesh are rectilinear. The form of polylist or polymesh objects 
can be adjusted by dragging the points that represent the polygon vertices or by numerically
editing a selected point in the Objects browser. Polylists cannot be trimmed with the trim 
tools; polymeshes can be trimmed with the trim tools. Separated end caps are trimmed 
polymeshes.

When you select an object and choose Simplify Geometry, Extreme 3D removes the current 
level of geometry from the object. When you open the object for editing, it displays the 
highest level of geometry that it retains. Editing control points of polylist or polymesh 
geometry provides you with the most localized editing of an object's shape, but results in 
the greatest loss of data. 

Note: Extreme 3D cannot re-create a higher level of geometry after that information 
is removed. Only the Undo command can return to the higher level of an object once it is
simplified. However, you can undo only the last ten operations. Saving a duplicate of 
your original geometry provides more freedom in experimenting with simplifying 
geometry and editing objects.



These are the three levels of editable geometry for the same object. The top left object 
displays its defining geometry--the underlying circle and center points that define the object 
are visible. The middle object displays surface control points. The bottom right object 
displays mesh geometry.



Control Points

Use the commands on this submenu to select successive control points on an object or 
change their order.

Select First Control
Opens the selected object and selects the first control point. 

Select Next Control
Shortcut:Shift+Control+T
Selects the next control point in the sequence. If the object is not open, it opens the 
object and selects the first control point. 

Reverse Ordering
On a 2D object, Reverse Ordering changes the order in which control points are 

selected. Reversing the order of control points in a 2D profile often allows a skinned object 
built of several 2D profiles to be constructed without unexpected twists or folds in the 
object's surface. Reverse ordering of control points does not change the location of the 
spline's center point (the green point, usually located at one end of a spline).

On a 3D object that has been simplified once or twice, Reverse Ordering reverses the 
order of its surface control points and changes the orientation of the polygons that make up 
the object. The shape of the object isn't affected, but polygons that were front-facing 
become back-facing and vice versa. For more information, see the Display Polygon    Faces 
help topic.

Note: Some modeling applications orient shading normals in a direction opposite to 
those set in Extreme 3D. If you have imported such a model from another application, try
selecting the objects and using reverse ordering. This will reverse the order of all the 
control points in the model, thereby reorienting the normals. Using reverse ordering 
before exporting an Extreme 3D model to another modeling application may make the 
Extreme 3D model display correctly in the other application, as well. 



Render Style

Applies one of the render styles to the selected object. In the Window Setup dialog box, 
the Max Render Style pop-up sets an upper threshold for the render style available in a 
given window. (This determines the maximum render style for interactive rendering.) 
When a render style is selected for a parent object, that style is applied to all of its 
children.
If you select a render style for a selected object and the workspace does not redraw the 
object in the chosen render style, change the Max Render Style setting and try again. 
Click too see an illustration (each render style is applied to the same object):

Bounding Box
Wireframe
Hidden Wireframe
Faceted
Faceted Wireframe
Smooth
Shader

Bounding Box 
Draws the same red selection outline around the boundaries of the object that you see 
when you select it, but does not draw any of its other geometry features. This render 
style redraws the fastest of all render styles. It is most useful for animation previews or 
for speeding up the redrawing of finished objects in a complex scene while you build 
others.

Wireframe
Draws lines for all polygons. The wireframe render style reveals the internal structure of 
the object. To select an object rendered in wireframe style, click on the polygon bounds, 
not on the spaces. The resolution of polygons can be adjusted using the Adaptive or 
Uniform Smoothing dialog boxes. 
Note: Fast Wireframe is a special window render style that is useful for previewing 
animation. It is not available as an individual object render style.

Hidden Wireframe 
Draws lines only for the visible surface polygons of an object. All other polygon lines are 
hidden. Shading is done on a per polygon basis without using normals. Although this 
option does not reveal the internal structure of the object, for complex objects it may be 
easier to understand than the wireframe option. 

Faceted
Colors each polygon of the object, depending on the material properties of the object 
and the lighting. Polygon normals are used to do shading. 



Faceted Wireframe
Draws a combination of hidden wireframe and faceted rendering styles. Lines clearly 
delineate the object's front surface polygons, and shading is done using polygon normals
and a constant color, which shows the effect of the lights. 
Note: All of these fast interactive modes use the interactive renderer. They do not 
handle shadows or transparency.

Smooth 
Draws objects with smooth tonal gradations between polygons. Shading is calculated by 
interpolating vertex normals and reflected highlights are drawn using Gouraud shading.

Shader 
Draws objects using a preview renderer that provides a 32-bit draft mode preview of a 
model. For example, if an object has a texture map, Extreme 3D renders the image, but it
isn't sampled or anti-aliased, and transparencies are not rendered. The result is that the 
rendering is fast, but the quality is not as high as a final render. Shading is calculated on 
a per-pixel basis using Phong shading.
The Shader rendering style is available only if 32-bit depth is selected in Window Setup. 
If Shader is selected when you switch from 32-bit to 8-bit depth, the Smooth render style 
is used automatically, even though the menu does not reflect that change. 

















Separate End Caps

Causes the end caps of surfaces to act as separate objects that are lock-linked to the 
main object. Until they are separated, end caps are polylists. You can move and 
manipulate separated end caps without changing the main body of the object.
Note: You cannot project trim curves onto end caps until they have been separated.
Separate End Caps works only on objects that have end caps, that is, surfaces that were 
built from closed 2D profiles and cubes created with the cube tool.
After you separate the end caps, the object can be thought of as three objects: the main 
body of the object and two lock-linked caps, one on each end. Because end caps are 
lock-linked to the main object, moving an end cap moves the main object too, and vice 
versa. Use the unlink tool to remove the link between the end cap and the main object.
Note: You can apply different materials to the end caps once they have been 
separated.
To edit an end cap, double-click the end cap. Drag the control point in the middle of the 
end cap to move it. Drag any of the outer control points to manipulate the shape of the 
end cap.
The end caps appear in the Objects browser as surfaces. The separated end cap surfaces
consist of a trim curve and a surface from which the curve was made. The resolution of 
the trim curve is determined by the uniform or adaptive smoothing setting of the object 
when the end caps are separated. To see the trim curve, select it by name in the Objects 
browser or use Show Trim Curves on the Object menu.



Duplicate with Link 

Shortcut:Shift+Control+D
Duplicates the selected object and its children and makes the duplicate object a child of 
the original object. Duplicate with Link calculates the difference between 0,0,0 and the 
center point of the object and performs the same relative transformation to the duplicate
that the object has to its parent.
Because this command recreates the relative position between the two objects, this 
command is useful for creating geometrically repeating forms such as spokes of a wheel, 
links in a chain, a stairway, or a circuit board with evenly distributed components.
Note: Duplicate with Link does not duplicate watch links.



The Duplicate with Link command duplicated the components and their position relative to 
each other.



Clear Construction Objects

Deletes construction lines, points, axes, and grids from the world. When the construction 
object is the parent of an object, the construction object is not removed. The ground 
plane and working plane are special construction objects and cannot be cleared from the 
world. They may be hidden using the Show Ground Plane and Show Working Plane 
commands.



Units

Opens the Units dialog box, in which you set the units of measurement displayed in the 
Objects browser, the Views browser, and wherever else measurements are displayed in 
Extreme 3D. The default unit is inches. Units values are saved in the scene file.

World Scale
Sets the units used on the screen. 

Grid Scale
Sets the units for an object's size. The ratio established by World Scale and Grid Scale 
represents the ratio of the size an object appears in the view and the size it would be in 
the real world. For instance: If you are modeling a chair to scale and you want one inch 
on the screen to represent one foot in physical reality, set the World Scale to 1 inch and 
the Grid Scale to 1 foot. Grid Scale units do not affect how objects appear on the screen. 
They only affect values in numeric fields such as those in the Objects browser and the 
unit of measurement for font size in the Text Tool Preferences dialog box. 
Enter a number and select units in the fields to the left of each scale to define the ratio. 
For example, to set 1 inch in a model equal to 2 feet in the real world, set the World 
Scale to 1 inch and the Grid Scale to 2 feet.

Grid Divisions
This numeric field at the bottom of the dialog box sets the number of divisions that units 
in the Grid Scale are divided into. This affects the working plane, ground plane, and 
construction geometry. For example, if the Grid Scale is set to feet, entering 10 in the 
Grid Scale field sets 10 divisions for each foot of the grid. Each division of the grid equals
one-tenth of a foot.



Render menu

The Render menu contains commands that control how the model is rendered, including 
options for backgrounds and surface appearance. There are also commands for 
specifying final render options and performing a final render.
Click a command to see information about it.

Final Render Setup
Global Effects
Set Background
Uniform Smoothing
Adaptive Smoothing
Display Polygon    Faces
Edit Network Jobs
Enter Render Server Mode
Render to Disk
Final Render to Screen



Final Render Setup

Opens the Final Render Setup dialog box.

Quality
There are four quality options that affect the sharpness of the final image by adjusting 
anti-aliasing (that is, by setting the number of times Extreme 3D calculates each pixel in 
the image). Quality affects the entire rendered scene: Lights and shadows are antialiased
as well as objects.
As the quality gets better, Extreme 3D breaks some pixels into subpixels and then 
calculates the sharpness of each pixel. An adaptive process is used to determine which 
pixels should be divided, so the rendering time does not increase linearly. The increase in
rendering time depends on the type and complexity of materials used, the level of detail 
in the scene, and other factors. The greater the number of calculations, the more 
accurate the image. However, more calculations increase rendering time. 
The Best option gives the sharpest image. The following table lists the number of times 
Extreme 3D calculates the image for each anti-aliasing level. 

Quality level Number of subpixels 
of anti-aliasing per sample group
Low (1x1) 1
Good (2x2) Up to 4
Better (4x4) Up to 16
Best (8x8) Up to 64

Choosing the best quality option and using the 32-bit depth setting in the Window Setup 
dialog box produces the highest quality anti-aliased image.

Final Smoothness Settings
When Final Smoothness Settings is selected, final render uses the Final Render Settings 
specified for each object in either the Adaptive Smoothing or Uniform Smoothing dialog 
box. (All objects, except polymesh and polylist objects, use either Adaptive or Uniform 
Smoothing.) If this option is not checked, final render uses the Interactive Render 
Settings for uniform and adaptive smoothing. Each object can have its own surface 
smoothness setting, so objects in the same scene may have a slightly different 
resolution. 

Render Shadows
When Render Shadows is selected, the final rendering includes shadows, which are 
calculated for each light source listed in the Lights browser that has its shadows 
checkbox turned on. Because the scene is rendered once for each light, calculating 
shadows roughly multiplies the rendering time by the number of lights with shadows on. 
Depending on the material used, rendering time can be up to 30 percent longer with 
shadows.





The image on the left was rendered with Quality set to Low. The image on the right was 
rendered with quality set to Best. The magnified edges of each object show the difference in 
sharpness.



The image on the left shows how the joystick looks in the workspace using interactive 
rendering. The images on the right are both final renderings. The top right image has the 
Final Smoothness Settings option in the Final Render Setup dialog box turned off; therefore, 
the model is rendered using interactive render settings. The bottom right image has the 
Final Smoothness Settings option in the Final Render Setup dialog box turned on; therefore, 
the model is rendered using final render settings.



The scene on the left was rendered without shadows; the scene on the right was rendered 
with shadows.



Global Effects

Global Effects applies special effects that create the look of fog or haze and sets the 
color of the scene's ambient light. Global Effects affect the entire scene, including all 
views, not just individual objects. Global Effects only appear in 32-bit final render. The 
Global Effects dialog box is dimmed if the current window's color depth is set to 8-bit.

Fog
Make it Foggy--When enabled, fog is calculated for final render. As objects recede from 
the camera they are mixed with the color of the fog. You can turn off this option to render
without fog while still retaining fog settings. Including fog in the scene does increase 
rendering time.
Color--Defines the color of the fog when it is totally saturated. The default color is blue. 
To achieve a realistic looking fog, set the color very close to the scene's ambient light 
color.
Transparency--The color from all lights in the scene that passes through the fog, 
affecting the color of the fog. For example, if the transparency color is red, the red color 
passes through the fog, while blue and green hues are mostly absorbed by the fog, 
thereby not influencing the color of the fog. The transparency color affects objects that 
are farther away from the eye point more intensely.
Depth--The distance at which the fog's density is approximately 50 percent. The density 
of the fog increases as it moves farther away from the eye point. The units used for the 
Depth Value are set in the Units dialog box on the Object menu.

Ambient
Ambient Color--Sets the color for ambient light in the scene. In the real world, light is 
reflected multiple times off every object. Extreme 3D allows you to approximate ambient 
light with a single pervasive color that affects everything in the world. Ambient light 
provides a base level of illumination for a material. Each material's response to this color 
is controlled by its own Ambient slider in the Material's editor. Both the Ambient Color 
and each object's reaction to this color can be animated.



Set Background

Opens the Set Background dialog box, which lets you change the background color or 
select an image to place behind the scene. The options in the Set Background dialog box 
apply to all views of the scene. 

Background Color
The color swatch shows the current background color. Click the color swatch to open the 
System Color Picker dialog box. 

Use Background Image
Check the Use Background Image checkbox to use the current image. To speed up 
redrawing, uncheck this box.

Image
This option allows you to select a BMP image as a background for the scene. Click Load 
to choose the image you want to use. A standard directory dialog box opens. Once you 
have selected an image, its name appears in the display field above the Load button. 
When loaded, the background picture registers to the upper left corner of the workspace.
The image is displayed at a constant scale, regardless of the Zoom setting. Any 
background image that you want to use for high resolution output must be a high 
resolution image. Click Remove to remove the current image and have no image 
selected. 



Uniform Smoothing

Shortcut:Shift+Control+U
Opens the Uniform Smoothing dialog box. Objects are defined and edited as smooth 
curves. The renderers sample polygons from these curves for display. Through these 
Uniform and Adaptive Smoothing dialog boxes you can control how these display 
polygons are sampled from the spline-based geometry and precisely control each 
object's rendering speed and quality. 
Uniform smoothing samples the surface of a model into a gridwork of evenly spaced 
polygons. This dialog box sets the number of gridwork divisions (that is, the number of 
polygons) that are drawn between the object's control points during rendering. The 
greater the number of subdivisions, the finer the mesh and the smoother the rendered 
object will appear. Objects with a finer mesh take more time to render. 
All geometry is created using the current smoothing type, either Uniform or Adaptive, the
default, which is described in the next section. 
To make Uniform the current smoothing type for all new objects, choose Uniform 
Smoothing from the Render menu while nothing is selected and click Default. The dialog 
box closes. All new geometry will use the current Uniform Smoothing settings.
If no object is selected in the workspace, you can set the surface smoothness defaults by
setting the options and clicking Default. These changes will apply to any subsequently 
created objects. When no object is selected in the workspace, changes are discarded 
when you click OK or Cancel. 
When Update is selected, changes are applied to currently selected objects. However, 
surface smoothness settings do not apply to the child objects of a selected parent object.
Note: To use the Final Render settings for the final render, you must also select Final 
Smoothness Settings in the Final Render Setup dialog box. If Final Smoothness Settings is
not selected, Extreme 3D uses the Interactive Render Settings for the render. 

Smoothness Settings
Each object has two smoothness settings:

Final Render Settings--Applies the resolution specified in the Row and Column 
subdivisions entry fields when the final object is rendered. To use the Final Render Settings 
values for the final render, you must also select Final Smoothness Settings in the Final 
Render Setup dialog box. If Final Smoothness Settings is not selected, Extreme 3D uses the 
interactive render settings values for the final render.

Interactive Render Settings--Applies the resolution specified in the Row and 
Column subdivisions entry fields to the scene in the workspace.

Note: High smoothness settings take longer to render than low smoothness settings.
You'll probably want a low interactive setting for speedy manipulation while creating the 
scene and a higher setting for final renders. Objects further away from the camera can 
frequently afford lower settings than those near the camera, so scenes will render faster.

Row Subdivisions
Sets the number of row subdivisions used for smoothing objects. Rows are the polygons 
in the gridwork that are perpendicular to the object's defining profiles.



Column Subdivisions
Sets the number of column subdivisions used for smoothing objects. Columns are the 
polygons in the gridwork that are parallel to the object's defining profiles.

Render Edges Sharper
If this option is checked, Extreme 3D bases the rendering on the object's actual surface 
geometry rather than the approximation used for the polygon mesh. This gives objects 
with corners sharper edges.
Tip: You can use Adaptive rather than Uniform smoothing to improve the 
appearance of an object that has curves or twists, such as one that has been bent with 
the bend tool. Adaptive smoothing increases the number of polygons in the areas where 
the object bends the most.



The three footballs have different numbers of row and column subdivisions. From left to 
right, the number of rows and columns in each football increases.



Adaptive Smoothing 

Shortcut:Shift+Control+E
Opens the Adaptive Smoothing dialog box. Objects are defined and edited as smooth 
curves. The renderers sample polygons from these curves for display. Through these 
Uniform and Adaptive Smoothing dialog boxes you can control how these display 
polygons are sampled from the spline-based geometry and precisely control each 
object's rendering speed and quality. 
Adaptive smoothing samples the surface of a model into polygons by concentrating more
polygons in areas where the surface bends or changes direction rather than in broad or 
flat expanses of surface. The slider determines, on a relative scale from 0 to 1.0, how this
polygon weighting is calculated. The value 1 gives the smoothest possible surface 
rendering but takes more time to render. 
All geometry is created using the current smoothing type, either Adaptive (the default) or
Uniform.
If you have changed the default smoothing type to Uniform, you can change it back to 
Adaptive by choosing Adaptive Smoothing from the Render menu while nothing is 
selected, then clicking Default. The dialog box closes. All new geometry will use the 
current Adaptive Smoothing settings.
Adaptive smoothing is useful for sampling polygons where they can be the most useful 
and is especially effective when exporting models to polygonally based tools. 
If any objects are selected when this dialog box is opened, changes made in the dialog 
box apply only to the selected objects. If no object is selected, changes are discarded if 
you click OK or cancel. To apply these changes to any subsequently created objects, click
the Default button.
Note: To use these settings in the final render, you must also select Final 
Smoothness Settings in the Final Render Setup dialog box. If Final Smoothness Settings is
not selected, Extreme 3D uses the Interactive Render Settings values for the render.

Smoothness Settings
Each object has two smoothness settings:

Final Render Settings--Applies the resolution specified on the slider when the final 
object is rendered. To use the Final Render Settings values for the final render, you must also
select Final Smoothness Settings in the Final Render Setup dialog box. If Final Smoothness 
Settings is not selected, Extreme 3D uses the interactive render settings values for the final 
render.

Interactive Render Settings--Applies the resolution specified on the slider during 
model creation.

Render Edges Sharper
If this option is checked, Extreme 3D bases the rendering on the object's actual surface 
geometry rather than the approximation used for the polygon mesh. This gives some 
surfaces sharper edges.



Display Polygon Faces

Determines which polygons are displayed for a selected 3D object. The options are Front 
Faces, Back Faces, and Both. In Extreme 3D, front facing polygons are those whose 
normals point towards you; back facing are those whose normals point away from you.
When you create an object in Extreme 3D, Display Polygon Faces defaults to the most 
useful option for that object type. For example, if an object appears as a solid, such as a 
closed sphere, the polygon display defaults to Front Faces because all the back facing 
polygons are assumed to be facing the inside of the sphere and do not need to be 
shaded or rendered. 
If you modify an object, you may need to change one of these options to make the object
appear correctly on screen. For example, if an object is initially made as a lathed object 
with end caps, and you then decide to remove the end caps, you will see that some of 
the polygons on the inside (that is, the back-facing polygons) are not displayed. From 
some viewing angles this can make it look as if part of the object is missing. Turning 
back-facing polygons on or selecting Both should allow you to see the parts that appear 
to be missing.
When you import a model from another program, the normals may be oriented opposite 
to the way they are oriented in Extreme 3D, so the model may not appear correctly in 
Extreme 3D. Select the object and choose one of the other Display Polygon options until 
the object displays as you expect.
When a polygon display type is selected for a parent object, it is not applied to its 
children. Each child needs to be selected and have Display Polygon Faces applied 
individually.

Front Faces
Draws all the surfaces of an object that are facing the viewer. Even if you are oriented to 
the back of the object, you are viewing the front-facing polygons, because the light-
reflecting surfaces are pointed toward you. 

Back Faces
Draws all the surfaces of the 3D object that are facing away from the viewer (for 
example, the surfaces on the inside of a closed object.) 

Both
Draws all the objects' surfaces, regardless of whether or not they are visible on screen. 
This option takes the longest to render.
Note: Some modeling applications orient shading normals in a direction opposite to 
those set in Extreme 3D. If you have imported such a model from another application, 
the Display Polygons options may seem to produce the opposite effect. Try selecting the 
model and using the Control Points from the Object menu and selecting the Reverse 
Ordering option. This will reverse the order of all the control points in the model, thereby 
reorienting the normals. Using Reverse Ordering before exporting an Extreme 3D model 
to one of these other modeling applications will make the Extreme 3D model display 
correctly in the other application.



Edit Network Jobs 

Opens a dialog box that shows you the status of the distributed rendering system. 

Jobs
Contains a list of jobs in the job queue and the percentage of completion for each one. 

Set Priority 
Allows you to edit the order of jobs in the queue list. The first job in the list has the 
highest priority as a scheduling task. To change a job's priority, select it and click one of 
the Set Priority buttons.

Highest--Moves the selected job to the top of the list. 
Lowest--Moves the selected job to the end of the list. 
Up--Moves the selected job up one space in the list.
Down--Moves the selected job down one space in the list.

Errors
Allows you to manage jobs that have stopped due to errors. 

Retry--Schedules tasks in the selected job that have errors for reprocessing. 
Skip--Omits tasks in the selected job that have errors. Corresponding frames will be 

missing from the final output. 
Delete Job--Deletes the selected job. All work related to that job is discarded.

Server Systems
Contains a list of server systems on the network and their status. There is no importance 
to the order of this list. The buttons allow you to control a particular server. 

Stop Server--Stops the selected server and takes the machine out of server mode. 
Extreme 3D either exits the program or takes you back to the menus, depending on how you
got the machine into server mode. 

Stop Task--Stops the task that the selected server is processing. This task is then 
flagged as an error and must be either retried or skipped. Stop task is useful for manually 
rescheduling a task that has stopped or restarted a server machine. 

Refresh--Reads the current status of the distributed rendering system and updates 
the window. Since rendering is going on all the time, the dialog box updates only when it is 
initially displayed or when you click Refresh. The dialog updates every 15 seconds. 

Note: If you look in the network rendering subdirectory on the network server 
system while it is rendering, you will see the network renderer's internal communications
files. These files are automatically deleted when a job is completed. Do not delete them 
while the server is processing a job except while troubleshooting a server crash.



Enter Render Server Mode

Puts the computer into a distributed rendering mode where it processes any tasks that 
have been submitted.
The dialog box shows you the current status of processing. Exit takes the machine out of 
server mode.
The Save As dialog box will appear before the server begins processing network jobs if 
changes to the scene have not been saved. 
Note: A network is not required to make use of distributed rendering. If a directory 
on your machine is specified in Preferences, Enter Render Server Mode will initiate a 
batch rendering process and render any submitted images to the specified directory.



Render to Disk 

Renders the current scene to a file. Before doing a disk render, be sure to check the 
options selected in the Final Render Setup and Window Setup dialog boxes, which also 
affect rendering. 
Note: Render to Disk is dimmed if the active window's Max Render Style is Fast 
Wireframe. To change the active window's Max Render Style, choose Window Setup from 
the Window menu. The Fast Wireframe render style uses an interactive renderer that is 
used for screen display only.

Range
Specifies the number of images to be rendered. These values are displayed in seconds 
rather than frames if the Display Time In option on the Animation page of the 
Preferences dialog box is set to Seconds.

Single Frame--The frame specified in the Frame field will be rendered. This value 
defaults to the current frame but can be changed by entering a new frame number.

Multiple Frames--A series of frames is rendered. To render the entire animation, 
select All. To render a designated section, specify the start and end frames of that section by
frame number in the From and To text fields. 

Rate--When rendering multiple frames, enter a frame rate in the Rate field that is lower 
than the current default rate (set in Preferences), to render fewer frames for the 
sequence. This is a good way to do test renders for scene blocking and object 
relationship. The Number of Frames field displays the total number of frames that will be 
rendered.

Renderer
Select either Interactive or Final. Interactive rendering is faster and better for previews. 
The final renderer uses the options specified in the Final Render Setup dialog box. 
Note: In order to see most materials that have been applied to objects during 
interactive rendering, both the selected object and the current window must use the 
Shader render style. 

Interactive--The size of the rendered image is determined by the current window 
size as specified in the Window Setup dialog box. This size is displayed in the Active Window 
Size field. To make changes to this or any of the other display-only fields, close this dialog 
box and choose Window Setup from the Window menu. The maximum window size is 2048 x
2048 pixels. 

Final--Final Render Size field allows you to specify an output image size for Targa, 
BMP files that is different than the current active window size. The height and width fields 
accept values in pixels. The maximum size for BMP and Targa images is 8192 x 8192 pixels.   

Constrain Aspect Ratio--Computes the height and width of the high resolution 
output image based on the height and width of the active window. Given a value for height 
or width, the other value is automatically computed when you press Tab. Aspect ratio should
be determined by the image size required by the final medium (multimedia, video, or print).

If the aspect ratio is not maintained, the screen display of the render may make the 
image look stretched or squished when rendering an image that is larger than the screen 
size. The rendered image will be correct.

Output 



File Format--Specifies the output file format. You can render in these formats:
Targa 24-bit and 32-bit file sequence (TGA) 
BMP 24-bit and 32-bit file sequence 
AVI movie 

For BMP and TGA sequenced files, the filename is truncated and the frame number and 
file extension are added to the name. For example, if the file name is Project, 
proj0000.TGA is the first frame in the sequence.
A few important points to note about these file formats:

All of the file sequence formats, BMP and Targa, are useful for exporting animations 
directly into image manipulation or digital editing applications. 

32-bit files are created with an alpha channel; 24-bit files are created without an 
alpha channel.

Use the Targa 24-bit and 32-bit formats for cross-platform distributed rendering. Use 
Targa or BMP for single platform distributed rendering. The AVI format cannot be used for 
distributed rendering.

Large final render size options do not apply to AVI movies, which can only render at 
the size of the currently selected window. If you change the Final Render Size while one of 
these formats is selected, the Render button is not available. 

Render--Click Render to render the current scene using the options selected in the Final 
Render Setup, Window Setup, and Render to Disk dialog boxes. Render saves all settings,
except the final renderer name and current time, which are saved elsewhere, and 
performs the render. A render progress counter appears that indicates what frame is 
being rendered and how much of the total rendering is completed. To stop rendering, 
press Esc or F11. To discard any changes made in the Render Disk dialog box, click 
Cancel. Large scenes or scenes with complex or multiple models may take a long time to 
complete.
When rendering to AVI format, you are prompted to save the movie file and then select 
compression options. Read the next section to learn more about software video 
compression.
Submit Job--Adds a task for network rendering. It creates a folder in the location 
specified on the Files page of the Preferences dialog box. The final output file will be 
saved in this folder. The folder is empty until you put a machine in server mode using 
Edit Render Server Mode. Once a machine is in server mode, all submitted jobs are 
rendered and stored in this folder. 
You can use distributed rendering to create BMP or Targa images. You must use one of 
the Targa file formats to use both Windows and Macintosh systems to collaborate on a 
single distributed rendering job.
Note: You cannot use distributed rendering to create AVI movies.
The final output file will be saved in this folder in the location specified on the Files page 
of the Preferences dialog box.



Setting AVI compression options
After naming the AVI file, the Windows Video Compression dialog box appears, allowing 
you to select compression options. 
Compression is the process of decreasing file size by removing or restructuring the data 
in the file. All of the software compression/decompression algorithms (CODECs) listed 
here are supplied with Video for Windows. You may have additional hardware or software 
codecs (that appear in this dialog box) in your system that have been supplied by a 
different vendor.
Tip: Do your final render as sequential stills rather than as a digital movie so that 
you can interrupt the render and experiment with different compression methods.
Compressor--Click the pop-up to select a codec.

Cinepak Codec by Radius is the default. It is ideal for playback from CD-ROM discs.
It has better image quality and better playback speeds than the Microsoft Video 1 codec. 

Intel Indeo(R) Video R3.2 is ideal for playback from CD-ROM discs. The quality is 
comparable to the Cinepak codec. It works well for highly detailed images. 

Microsoft Video 1 is designed for compressing analog video (non-digitally 
generated images) and may produce undesirable results with animation data. 

Microsoft RLE is designed for compressing animation and other digitally generated 
images. It is only available for 8-bit images. This codec works well for images that contain 
large areas with the same color.

Full Frames (Uncompressed) does not compress any data, so there is no 
degradation of quality, much more disk space is required to store the movie. 

You can click the Configure button for some codecs to specify additional compression 
options. 



Note: If compression quality is zero, a zero K file is written. If compression quality is 
100, the file is saved uncompressed.



Final Render to Screen

Shortcut:Control+R
Uses the final renderer and the current settings in the Final Render Setup dialog box to 
render the current view at the current time. 
The output appears in the active window. Final Render to Screen automatically uses the 
best render style possible given the current window's color depth, regardless of the 
scene's current Max Render Style. However, Final Render to Screen is dimmed if the 
active window's Max Render Style is Fast Wireframe. The Fast Wireframe render style 
uses a fast interactive renderer to quickly display objects on screen; it cannot invoke the 
final renderer. All other window render styles can do a final render to screen. To change 
the active window's Max Render Style, choose Window Setup from the Window menu.



Animate menu

The animate menu contains commands for setting up and controlling the animation of a 
scene.
Click a command or submenu to see information about it:

Animation Controls
Score
Play
Stop
Rewind
Step Backward
Step Forward
Fast Forward
Insert Keyframe
Previous Keyframe
Next Keyframe
Simplify Position Track
Animation Path
Repeat Track
Clear All Tracks
Scale Time
Change Motion Style
Ease Settings
Auto Rotate



Animation Controls command

Opens or closes the animation controls, which control the current time and the length 
and playback of animation sequences. The animation controls window retains its position
on screen when it is opened and closed. 
Click a part of the illustration for more information: 

Shortcut:Shift+Control+A
Choosing Animation Controls from the menu or using the accelerator key opens the 
animation controls if they are closed, brings them forward to the top of the stack of 
windows if they are covered by other windows, and closes them if they are at the top of 
the stack of windows.    



Counter (animation controls)

Current frame field--The current frame field at the top of the panel shows the current 
animation time. The time is displayed in either frames or seconds, depending on which 
option is selected in the Preferences dialog box.
Start and End--The start and end times determine beginning and ending points of the 
animation playback. To specify the start time, type the new time in the Start field and 
press Enter. To specify the stop time, type the new time in the End field and press Enter. 
If no start and end time are specified, the animation plays from frame zero to the last 
frame in the animation. 
Use the start and end times to concentrate playback on a portion of the animation 
sequence while you are editing it. The length of the animation is not controlled by the 
end time, but by the frame number of the last keyframe in the score.
Preview FPS--Sets the frame rate (frames per second) for previewing animation 
sequences in the workspace. This setting overrides the Frames Per Second setting in the 
Preferences dialog box for previewing purposes. When you use this option to view the 
animation sequence at a lower frame rate than the final rendered sequence, Extreme 3D 
calculates fewer frames per second. This reduces interactive rendering time while still 
displaying a good approximation of movement in the sequence. 



Playback Mode (animation controls)

Normal--Plays the animation sequentially from the start time to the stop time. If start 
time and end time are both zero, the animation plays through its entire length.
Loop--Plays the animation repeatedly from the start time to the stop time until you 
choose to stop. If start time and end time are both zero, the animation plays repeatedly 
through its entire length. 
Auto Reverse--Plays the animation forward (from the start time to the end time), then 
plays it in reverse (from the end time to the start time), repeating the pattern until you 
choose stop. If start time and end time are both zero, the animation plays forward and 
then backward repeatedly through its entire length until you choose to stop.



Playback Controls (animation controls)

Rewind
Moves the current time back to the start time. Clicking the Rewind button while pressing 
F3 moves the current time back to zero. 

Step Backward
Shortcut:Shift+Control+B
Moves the animation back one frame. If the current time display mode is set to seconds, 
the time change displayed depends on the frames per second setting. For example, at 30
frames per second, the time display changes by one frame, or 1/30th of a second. 

Stop
Shortcut:  Shift+Control+S -- You can also press Control+Break, F11, or Esc to stop any 
task in Extreme 3D, including animation playback. 
Stops the animation at the current time.

Step Forward
Shortcut:Shift+Control+F
Moves the animation forward one frame. If the current time display mode is set to 
seconds, the time change displayed depends on the frames per second setting. For 
example, at 30 frames per second, the time display changes by one frame, or 1/30th of a
second.

Play
Shortcut:Shift+Control+P
Runs the animation sequence in the active window using the current playback mode, 
starting at the current time. 
If the current time is earlier than the end time, the animation runs until it reaches the 
end time. If the current time is after the end time, the animation starts at the start time. 
If start time and end time are both zero, the animation plays through its entire length. 
To pause the animation sequence while the animation is playing, click the Play button. 
Then, to begin playing the animation sequence again from the current time, click the 
Play button again.

Fast Forward
Moves the current time forward to the end time. Clicking the Fast Forward button while 
pressing F3 moves the current time to the last keyframe in the score.
If the Start and End times are zero, Fast Forward moves the current time to the end of 
the animation.





Animation Toggle (animation controls)

The button to the right of the current frame field of the animation controls should be red,
for record animation, when the changes you are making in your scene are changes for 
which you want to create keyframes. To make changes for which you do not want to 
create keyframes (such as positioning a texture map or moving an object to edit another 
object behind it) be sure the button is off. 
When the animation toggle is off, changes to already animated attributes are ignored, 
while changes to attributes that have not yet been animated are included. For example, 
if you animate only an object's position and then turn off the animation toggle, changes 
to the object's position are ignored until you turn the animation toggle on again. 
However, if you also resize the object with the animation toggle off, that change does 
affect the object, and the change is not animated (the previous object size is discarded.)
The Animation Toggle affects only those objects that already have animation tracks. 
Changes made at time zero to objects without animation tracks affect the objects 
regardless of the toggle state. 
Note: Use the Animate Visibility Changes preference in the Preferences dialog box to
toggle between animating visibility and not animating it.



Score

Shortcut:Shift+Control+C
Opens and closes the score, which displays the tracks that contain detailed information 
about animation. The score can be thought of as the animation browser. Like other 
browsers, its window is labeled in the title bar. It is resizable, and retains its last position 
and the state of all of its settings when it is closed. 
Click a part of the illustration for more information: 

Or click a name of a section of the score:
Keyframes
Object Filter
Playback head
Text Entry and Display fields
Time field
Time Scale
Track Filter
Tracks

Choosing Score from the menu or using the accelerator key opens the score if it is 
closed, brings it forward to the top of the stack of windows if it is covered by other 
windows, and closes it if it is at the top of the stack of windows. 
The score serves two functions. It lists all the Extreme 3D elements, such as objects, 
materials, and lights, and it lists the properties of each that can be animated, such as the
position of an object or the color value of a material. The score also manages the 
animation tracks, the timelines associated with each property that are displayed to the 
right of the property name in the list.



Object Filter (score)

The Object Filter provides you with a way to specify the types of Extreme 3D elements 
that you want the score list to display. The Object Filter pop-up contains seven different 
filters: Active Objects, All Objects, Profiles, Surfaces, Lights, Materials, and Camera.
The following table describes the elements that each filter option displays in the list 
when it is selected.

Active Objects--Lists only the names of those objects that have already been 
animated and displays the tracks of those that also match the current track filter. This is the 
default.

All Objects--Lists the names of all elements that can be animated and displays the 
tracks for all elements that match the current track filter.

Profiles--Lists only the names of profile geometry objects and displays the tracks of 
those that match the current track filter.

Surfaces--Lists only the names of surface geometry objects and displays the tracks of
those that match the current track filter.

Lights--Lists only the names of lights and displays the tracks of those that match the 
current track filter.

Materials--Lists only the names of materials and displays the tracks of those that 
match the current track filter.

Camera--Lists only the camera and displays the camera tracks that match the current
track filter.

In addition to the Object Filter, there are several other ways to examine all the 
information in the score list. Use the Up and Down arrow keys to navigate through the 
score list. Click the triangle arrow to the left of any name in the list to display its 
hierarchy of objects and the properties associated with each object.



Track Filter (score)

The Track Filter provides a way to specify which types of property tracks to display in the 
score list. The Track Filter pop-up contains six different filters: Active Tracks, All Tracks, 
Position Tracks, Orientation Tracks, Scale Tracks, and Color Tracks.
The following list describes which tracks each Track Filter option displays in the score 
when it is selected.

Active Tracks--Displays only those tracks that currently contain animation 
information.

All Tracks--Displays all tracks.
Position--Displays only the position tracks.
Orientation--Displays only the orientation tracks.
Scale--Displays only the scale tracks.
Color--Displays only the color tracks.



Time field (score)

The current animation time is displayed in the Time field. It appears in the time format 
specified in the Preferences dialog box.
Note: Whether the Preference setting is frames or seconds controls how keyframes 
are placed and moved in the score. Frame mode snaps keyframes to the current FPS 
setting.



Time Scale (score)

The current Time Scale Units appear in the timeline along the top of the score directly 
above the tracks. To change the time scale, use the Time Scale Zoom pop-up. When you 
select a smaller frame count from the list (for example, 5 frames), you can focus on a 
small portion of the animation. The frame/second markers in the timeline, as well as the 
tracks, expand accordingly. When you select a larger frame count (for example, 3 
seconds), a larger portion of the animation tracks are visible, the distance between 
keyframes appears smaller, and the frame/second markers contract. You can set the time
scale to 0.1 frames, which lets you place multiple keyframes between frames. Because 
the keyframe changes occur between frames, this is useful for making sudden 
movements like camera jumps.



Text Entry and Display fields (score)

Across the top of the score to the right of the filters and time information is a dynamic 
display area. This area provides text entry field(s), slider bars, or color swatches for 
displaying and entering values for the property track that is selected in the score list (for 
example, a position value, a lathe angle, or a color value.) To change a value, click in the 
text entry field, type in a value, and press Enter. A keyframe with that value is created 
for the selected property at the current time.
Note: Numbers can be entered, and are occasionally displayed, in scientific notation.
For example, you can enter a number such as 1.5e-2, which is equal to .015.



Playback head (score)

The playback head on the timeline is represented by a small triangle. Its marker is a 
vertical line that extends from that triangle through the time line and through all tracks. 
The playback head indicates the current time. Dragging the playback head to either edge
of the timeline changes the current time and scrolls that portion of the score into view.
When you enter a new time in the current time field, either on the score or on the 
animation controls, the playback head moves to the corresponding spot on the timeline. 
Likewise, dragging the playback head or clicking the timeline changes the current time 
field on the animation controls.
To do a quick preview of part of an animation, drag the playback head along that section 
of the timeline. The active window displays a bounding box version of the animation as 
the playback head moves, if Bounding Box preference is set. When the playback head is 
released, the active window is drawn in its default render style and all other windows 
update to the current frame. Setting the Update All Windows preference plays the 
animation in all windows. This results in a slower preview.
Dragging the playback head while pressing F3 updates the score's time values and text 
entry fields as the playback head moves.
When the playback head is dragged along the time scale, its marker snaps to time 
increments (tick marks). 
Insert Keyframe and Paste are applied relative to the current position of the playback 
head unless a keyframe is selected in the current track.



Tracks (score)

A track stores all the animation information that belongs to a single property for the 
length of the animation. Before a property is animated, its track is indicated by the gray 
triangle to the right of its name. Once a property has been animated, its track is 
indicated in the score by a bar that extends to the last frame of its animation.
The property's values at time zero are displayed in the text entry fields when the 
property is selected. Changes can be made to a property's time zero values. These 
changes affect that property's starting point.

Selecting tracks
To select a track, click its property name in the score list. Selected tracks are highlighted 
using your system's current highlight color. 
High level names in the score list (Geometry, Lights, Materials) and the next level of 
names below them (Object, Key Light, Blue Plastic, for example) serve as labels and 
provide the necessary visual hierarchy to understand the relationship of properties to 
objects. The high level names cannot be animated, so they do not have tracks. 

Cutting, copying, and pasting tracks
Tracks can be cut, copied, and pasted. Animation information that is cut or copied can 
only be pasted into another track of the same type (for example, color information can 
only be pasted into another color track.) 
To cut or copy a track, select the entire track by clicking the name of the property in the 
score list and selecting Cut or Copy from the Edit menu. To paste a track, select the 
name of the property track you are pasting to and choose Paste from the Edit menu. 
To cut or copy all the tracks of an object, select the object name and choose Cut or Copy. 
To paste these tracks onto another object, select that object by name in the score and 
choose Paste. All tracks that apply to the new object are pasted. Those that do not apply 
are ignored. Tracks can only be cut and pasted between similar objects. For example, 
materials tracks can only be pasted into other materials; surface tracks can only be 
pasted into other surfaces.
All animation information can be removed from a track by selecting the entire track and 
choosing Clear from the Edit menu. Except for cutting and copying all the tracks of one 
object, multiple track selection is not allowed for any of these commands. See the 
Keyframes help topic for information on cutting, copying, and pasting keyframes. 
Note: When a track is cut from the score, the property it represents retains the value
it has at the current time setting. To restore a property to its unanimated state, set the 
current frame field to 0 before cutting the track.

Track display
Tracks display several types of animation information. The information displayed in a 
track depends on the type of track it is and the property that it represents. 
Gray tracks or track sections indicate that a new value is assigned to each frame. This 
value is calculated by interpolating between the value of the keyframe immediately 
preceding it and the value of the keyframe immediately following it. Position, Orientation,



and Color tracks have values that change for every frame between keyframes.
White track sections indicate that the values of the keyframes contained within the range
do not change. White tracks also indicate those parts of any track where the starting 
value of a property is unchanged.
Two-tone gray tracks represent instant on and off state changes. Visibility is an example 
of a state change. If visibility is on in frame 0 and off in frame 5, the object stays visible 
until frame 5. It does not gradually disappear, as it would if the visibility value was being 
interpolated for every frame. White tracks or track sections represent the parts of the 
animation in which the state is off. The keyframe on the left determines the value for the 
range. The keyframe on the right indicates the state change. 

Gray scale ramp displays
When easing has been applied to an interval of time in a track, it is visually represented 
in that track by a gray scale ramp. The duration of the ease and the keyframes it affects 
is represented by the size of the ramp and the range of keyframes over which it extends.
For more information about easing, see the Ease Settings help topic.



Keyframes (score)

Keyframes represent the animation information that a property has at a specific time. 
They are indicated in the score as small rectangles distributed across a track. Although 
all properties have values at every moment in an animation, keyframes provide a way to 
precisely control when an action happens (for example, when a ball turns purple, when 
an object starts to rotate, or where an object is at a given time.) A keyframe is created at
the current time whenever you make a change to a property. 
It is possible to make change to the scene without adding keyframes by using the 
Animation Toggle on the animation controls to temporarily suspend animation. For more 
information, see the Playback Controls help topic.

Keyframe display
The current keyframe is indicated by a red selection bar drawn in the middle of the 
keyframe. Keyframes within ease intervals are highlighted in blue.

Selecting keyframes
Click a keyframe to select it. When selected, a keyframe is marked with a vertical red line
and can be dragged anywhere along the track within the bounds of the two keyframes on
either side of it. Dragging a keyframe assigns it a new time. A keyframe at the end of a 
track can be dragged without limit out in time (to the right). A keyframe can be moved 
back in time (to the left) until it reaches the previous keyframe.
A range of keyframes can be selected by shift-clicking any two keyframes on the same 
track. When multiple keyframes are selected, the selection range is displayed in the 
current system highlight color. This selected range of keyframes can be dragged to any 
place on the track within the bounds of the two keyframes on either side of it. If eases 
have been applied to the keyframes on either side of this selection, the eases are 
updated accordingly. You can move the first and last keyframes of an eased range, but 
you cannot move keyframes within an eased range. To deselect all the keyframes, click 
once anywhere in the track except on the keyframe.

Adding keyframes
To add a keyframe, select a track in the score and set the current frame to the time that 
you want the change to occur (either in the animation controls or with the playback 
head). Then toggle the animation toggle to red and change the object or property in the 
workspace or in a browser. Once a property has a track, you can add keyframes by 
selecting a track and choosing Insert Keyframe.

Cutting, copying, and pasting keyframes
Keyframes can be cut, copied, pasted, and cleared, either as individual keyframes or as a
range of keyframes. If a group of keyframes that are not immediately adjacent to each 
other are either cut or copied, all the keyframes in the range, from the earliest to the 
latest in time, are also cut or copied. 
Keyframes can be pasted anywhere in the track, including at time zero. If a range of 
keyframes is copied from one track and pasted into a new track in the score, they must 
be pasted into the same kind of track from which they were copied. For example, 



keyframes copied from a material color track cannot be pasted into an object position 
track. If no keyframe is selected in the target track, the paste occurs at the current time 
and keyframes in the rest of the track are pushed out.
If a single keyframe is selected, the paste occurs at that keyframe time and its value is 
replaced by that of the pasted keyframe.
If a range of keyframes is selected, the values for the range are replaced by those of the 
pasted keyframes.
Single keyframes retain an absolute value when they are pasted into a new track as do 
single or multiple keyframes for rotations. All other multiple keyframes are pasted with 
values relative to the new track. That is, the copied keyframes adjust their value to fit 
the track into which they are being pasted. 
Note: If a new scene is opened while the score or animation controls are active, they
update to the current time saved with the new scene. Other scenes that are currently 
open, however, do not jump to the new time. The score and animation controls maintain 
their current positions and sizes. (Duplicates of the score and animation controls are not 
created.) The FPS value is derived from the new scene.



Play

Shortcut:Shift+Control+P
Runs the animation sequence in the active window, starting at the current time. 
If the current time is earlier than the end time, the animation runs until it reaches the 
end time. If the current time is after the end time, the animation plays from first 
keyframe to last keyframe. If Play is selected while the animation is running, the 
animation sequence pauses. When Play is selected again, the animation sequence 
begins playing again from the current time.
When the animation sequence reaches the end time, all the windows are redrawn at the 
current frame. Setting the Update All Windows Preference plays the animation in all 
windows. This results in a slower preview.
Play can be selected from the menu whether or not the animation controls are open.



Stop

Shortcut:Shift+Control+S -- You can also press Control+Break, F11, or Esc to stop any 
task in Extreme 3D, including animation playback.
Stops the animation at the current time. Stop can be selected from the menu whether or 
not the animation controls are open. 



Rewind 

Moves the current time back to the start time. 
Selecting Rewind while holding down F3 moves the current time back to zero. Rewind can
be selected from the menu whether or not the animation controls are open.



Step Backward

Shortcut:Shift+Control+B
Moves the animation back one frame. 
If the current time display mode is set to seconds, the time change displayed depends on
the frames per second setting. For example, at 30 frames per second, the time display 
changes by 1/30th of a second. Step Backward can be selected from the menu whether 
or not the animation controls are open.
Note: The preview FPS setting does not affect this command.



Step Forward

Shortcut:Shift+Control+F
Moves the animation forward one frame. 
If the current time display mode is set to seconds, the time change displayed depends on
the frames per second setting. For example, at 30 frames per second, the time display 
changes by 1/30th of a second. Step Forward can be selected from the menu whether or 
not the animation controls are open.
Note: The preview FPS setting does not affect this command.



Fast Forward 

Moves the current time to the end time. If the Start and End times are zero, Fast Forward 
moves the current time to the end of the animation.
Selecting Fast Forward while pressing F3 moves the current time to the last keyframe in 
the score. Fast Forward can be selected from the menu whether or not the animation 
controls are open.



Insert Keyframe

Adds a new keyframe to the selected track at the current time. To add a keyframe, a 
track must already exist for that property. To create a track, select the property in the 
score and modify its parameters in the score or the workspace at a nonzero time.



Previous Keyframe 

Moves the current time back to the previous keyframe for the selected track. 



Next Keyframe

Moves the current time forward to the next keyframe for the selected track. 



Simplify Position Track

Gives you independent control of the x, y, and z values of the position of an object. To 
use this option, select the position track of an object in the score and then choose 
Simplify Position Track.
Once simplified, the x, y, and z positions of the object are represented by separate tracks
in the score, hierarchically related to the object. Each track can then be treated like any 
other track. Once you simplify a position track, the animation path can no longer be 
displayed as a spline in the workspace. 



Animation Path

Show
Displays the animation path representing the positional movement of the selected object
as a spline curve in the workspace. Once displayed the animation path can be selected, 
opened, and edited in the same way as all splines. 
Position paths can also be simplified into discrete x, y, and z positions. Once they have 
been simplified, however, they can only be represented in the score and cannot be 
shown as splines in the workspace. For more information, see    the Simplify Position Track
help topic. 

Hide
Hides the selected object's animation path in the workspace.

Convert Profile to Path
Converts a profile in the workspace into an animation position path for a selected object, 
replacing that object's current position path.
To convert a spline to an animation path, select the object's position track in the score 
and select the profile for the new path in the workspace, then choose Convert Profile to 
Path. The track's current keyframes are deleted and the new path's control points define 
the path's new keyframes.

Convert Path to Profile
Duplicates a selected animation path and converts it to a profile. You can then use this 
profile to create 3D geometry based on an existing animation path.
To convert an animation path to a profile, select the path in the workspace or in the 
World browser and choose Convert Path to Profile. (Use the Animation Path command to 
make an object's path visible in the workspace.)



Repeat Track

Duplicates animation keyframes for an object or property track selected in the score. If 
you select an object name in the score, all of its tracks will be repeated. Select an 
individual property track to repeat only that track without modifying the object's other 
property tracks.
Number of Times to Repeat--Indicates the number of times to duplicate the selected 
track's keyframes.
Repeat Down Tree--When an object is selected, all of the tracks for this object's 
children will also be repeated. When a property track is selected, the corresponding 
children's property tracks will also be repeated.



Clear All Tracks

Deletes all animation tracks in the score. Use this command to erase all tracks in the 
score and start animating again from scratch. You can undo this command.
Note: Set the current time to zero before using Clear All Tracks to restore all 
property values to their unanimated state.



Scale Time

Scales and offsets an animation track. You can scale time for an individual property track,
all the property tracks of an object, or all tracks in the scene. 
To open the Scale Time dialog box, select a track in the score and choose Scale Time 
from the Animate menu.
Apply Scaling To--Determines which tracks will be modified. 

Selected Track Range--Applies the scale or offset to the currently selected track or 
range of a track. It is selected by default when a track is selected in the score.

All Tracks of Selected Object--Applies the scale or offset to all tracks of the object 
that is selected in the score. If an object currently has a range selected for one of its tracks, 
but Selected Track Range is selected, the selected range is ignored. This is the default when 
an object is selected in the score.

All Tracks of All Objects--Applies the scale or offset to every track in the scene. 
This includes object tracks, material tracks, camera tracks, and so on. Because all tracks are 
affected, any existing track range selection is ignored when applying the scale or offset to all
tracks.

Scaling Factor--The amount by which the tracks are scaled. For example, if the selected
track extends from frame 10 to frame 30 and is given a scaling factor of 0.5, the scaled 
track extends from frame 10 to frame 20. When scaling, the position of the leftmost 
keyframe of the affected track is always fixed. Keyframes to the right of the selected 
range are pushed out for a scaling factor greater than 1.0 and pulled in for a scaling 
factor less than 1.0. Negative numbers are not accepted. The default scaling factor is 
1.0.
The scaling range is based on the minimum and maximum time values for a given 
selection. When scaling a single track, the selection extends from the first keyframe to 
the last keyframe in the track. When scaling all tracks of an object or the entire scene, 
the selection extends from the earliest to the latest keyframe time of the affected tracks.
Time Offset--Shifts the starting position of selected tracks forward in time by the 
number of frames specified. (You can use a negative value to move the track backward 
in time as long it's starting time is still greater than zero.) The offset is applied to the first
keyframe of the selection and the rest of the track shifts in time to follow the new 
position of the first keyframe. The default time offset is 0. 
When a track is both scaled and offset, scaling is applied first. 



Change Motion Style

The commands on this submenu change the motion style for selected keyframes to 
linear or smooth by modifying the tangent points for the control points they represent. 
Select any two keyframes to apply motion style to those keyframes and all the keyframes
between them.

Smooth
Makes the motion path of an object a smooth, gradual curve between keyframes. For 
each control point affected, the smooth command makes the control point and both of its
tangents collinear. This kind of motion is good for fluid movement, like a bird gliding or a 
person ice skating. 

Linear 
Makes the motion path of an object the shortest possible distance between keyframes, 
though the speed may vary due to easing in or out. Changes in the path direction are 
abrupt at keyframes. This kind of motion is useful for mechanical motion or motion that 
needs to happen at a specific time, like a ball hitting a bat.



Ease Settings

Displays the Ease Settings dialog box, which controls the way animation is interpolated 
between keyframes. Ease settings control the time over which an object travels along its 
path. To apply easing to a track, you must have at least two keyframes selected. The 
keyframes need not be adjacent. Easing is applied to all the keyframes enclosed by the 
selected keyframes. You can move the first and last keyframes of an eased range, but 
you cannot move keyframes within an eased range. Easing can be applied to all types of 
tracks.
Ease-In--Gradually accelerates the animation from zero velocity.
Ease-Out--Gradually decelerates the animation to zero velocity. 
The slider lets you control the portion of the segment over which easing in or easing out 
extends. A large value performs the ease slowly, that is, over a larger portion of the 
selected range. A small value performs the ease quickly, that is, over a smaller portion of
the selected range. Dragging one slider handle updates the other if the one being 
dragged is pushed past the other's current position. Keyframe ranges to which eases 
have been applied are indicated in the score by a gray scale ramp on the selected track.
To modify a track so that it accelerates into its motion from rest, select a range of 
keyframes, beginning with the key that should have a velocity of zero, and apply an 
Ease-In. Similarly, to modify a track so that its motion decelerates to rest, select a range 
of keyframes, ending with the key that should have a velocity of zero and apply an Ease-
Out. Combining Ease-In and Ease-Out on the same range of keyframes results in motion 
that starts and ends at a velocity of zero.
Ease with Constant Acceleration--Maintains constant acceleration when applying an 
ease to the selected track. 
By default, Ease with Constant Acceleration is not selected, which provides natural 
easing for most motion. This is achieved by using a minimum energy solution in which 
the maximum change in velocity occurs in the middle of the selected easing range. 
Checking Ease with Constant Acceleration provides unchanging acceleration throughout 
the selected range. This is useful for creating motion similar to that of a ball rolling down 
a hill.



Auto Rotate

Opens a dialog box in which you can specify the axis around which the selected object 
will rotate and the number of degrees it will rotate. Although you can still set keyframes 
for rotations manually, Auto Rotate allows degrees of rotation greater than 180 and is 
especially useful for objects that spin repeatedly. Auto Rotate creates four keyframes for 
every 360 degrees of rotation.
Keyframes for the rotation are calculated so that the rotation is completed at the current 
keyframe. Therefore, Auto Rotate cannot be performed at time zero. Extreme 3D adds 
keyframes for the rotation between the current keyframe and the keyframe that 
immediately precedes it. 
Auto Rotate does not record the rotation history of the object, so you cannot select the 
object or its rotation track and view the rotation state in the Auto Rotate dialog box. To 
change the degrees of rotation after using Auto Rotate, delete the objects Orientation 
track and choose Auto Rotate again. 
Degrees to Rotate--Specifies the amount of rotation for the selected object.

Axis of Rotation
Object's X Axis--The object rotates around its x axis.
Object's Y Axis--The object rotates around its y axis.
Object's Z Axis--The object rotates around its z axis.
Working Plane's Z Axis--The object rotates around the working plane's z axis.
Note: To define precisely where a rotation begins, add a keyframe to the Orientation 
track at that time, then set the current frame to the rotation end time and apply the Auto
Rotate command.



Help menu

Click a menu command for more information:
Help
About Extreme 3D



Help command

Invokes Extreme 3D help.



About Extreme 3D

Displays a screen with copyright and credits information, the version number of this 
release, and registration information for this copy of Extreme 3D. This box also displays 
useful information about the number of objects, patches, and polygons in the current 
scene. Click anywhere in the box to close it.
Note: The working plane and animation paths are not included in the object count 
unless they are visible in the workspace.



Browsers

Extreme 3D includes six browsers, which you can view by selecting commands from the 
Window menu.
Click a browser for more information:

Objects
Views
Materials
Lights
World
Layers



Window menu

The commands on the Window menu create new document windows, open and close 
browsers, hide and show the tool space and status bar, and list open scenes and views.
Click a menu command or submenu for more information:

Cascade
Tile
Refresh
Window Setup
New Window
Four-View Setup
Objects
Views
Materials
Lights
World
Layers
Watch Links
Show Tool Space
Show Status Bar
Scenes

At the bottom of the menu are the names of windows that are open in the current scene. 
A checkmark indicates the active view.



Cascade

Stacks multiple windows on top of each other and offsets them by the height of the title 
bar, so that each title bar is visible. A window behind another window can be moved to 
the top by clicking its title bar or by selecting its name from the window menu. 



Tile

Places multiple windows side by side on the screen by resizing them to fit. Up to 10 
windows can be open at a time.



Refresh

Shortcut:Shift+Control+R or F5
Refreshes the workspace in the current window.



Window Setup

Sets the properties of individual windows including image size, color depth, and the 
window's maximum render style.

Image Size
The Image Size pop-up contains options for setting the screen dimensions, in pixels, of 
the current window. The default size is Custom, 512 x 342 pixels. To set the image size, 
make a selection and click OK. If there is not enough memory to set the selected image 
size, Extreme 3D beeps and reverts to the previous size setting.
The possible screen dimensions, in pixels, are:

160 x 120 (Multimedia)
240 x 180 (Multimedia)
320 x 240 (Multimedia)
384 x 288 (Multimedia)
640 x 480 (NTSC Video)
648 x 486 (NTSC Video) 
768 x 576 (PAL Video)
Custom

The Custom Size option opens a dialog box that allows you to set a custom image size. 
Note: Image size is stored with each window. This setting determines the maximum 
size of the workspace for a given window. Final output requirements should be used to 
determine the size of any window that contains the camera view.

Color Depth 
Offers the choice of 8-bit depth (256 colors) or 32-bit depth (millions of colors). These 
choices determine which rendering options are available.

8-bit depth (256 Colors)--When 8-bit depth is selected, only the interactive and 
final 8-bit renderers are available. Colored lights and the Shader render style are not 
available with 8-bit depth. This means that texture maps and some materials will not render.
Because this rendering option only uses 256 possible colors, it requires less memory than 
rendering with millions of colors, so it is faster. Use it for general work, animation 
previewing, and grayscale images for which you don't need 32-bit color resolution.

32-bit depth (Millions of Colors)--When 32-bit depth is selected, the highest 
quality renderer is used for final render. Colored lights are visible when rendered with this 
option. Specular reflections on objects and shading are rendered more accurately than with 
the 8-bit renderer. Images rendered with 32-bit color are rendered with an alpha channel. In 
Windows, the alpha channel is rendered only if selected in the file type pop-up.

Note: Changing bit depth from 32 to 8 may result in unexpected changes to colors.

Max Render Style
This pop-up specifies the threshold rendering style for the current window. This means 
that if the rendering style is applied to a specific object of a lower quality than the Max 
Render Style of the window, the object will be rendered in the style specifically assigned 
to it. If not, it will be rendered in the Max Render Style of the window. The lowest quality 
of render styles is Bounding Box. The highest is Shader.



For example, if an object's rendering style is Wireframe and the Max Render Style of the 
current view is Faceted, the object is rendered as Wireframe. However, if the object's 
rendering style is Shader and the Max Render Style of the current view is Faceted, the 
object will be rendered as Faceted. 
See the following table for the ranking of rendering style qualities. Windows have the 
same render styles as objects plus an additional style, Fast Wireframe, which looks just 
like wireframe but renders faster. It is useful for speeding up rendering time for test 
renders. Background colors and pictures do not appear in Fast Wireframe mode. Also, the
Final Render to Screen and Render to Disk commands are not available when the active 
window's Max Render Style is Fast Wireframe. Because the Fast Wireframe render style is
for interactive previews only, it cannot be used when rendering to screen or to disk.
The following table lists the various render styles (from lowest to highest) and shows 
their uses:
Bounding Box

Draws the outside boundaries and basic geometry information of the object. 
Redraws the most quickly of all rendering styles.
Useful for animation previews or for speeding up the redrawing of finished objects in 

a complex scene as you build others.
Fast Wireframe

Looks like wireframe but previews faster. (Ideal for previewing animation.) Cannot 
render to screen (final) or to disk.

Wireframe
Draws the edges of all polygons.
Reveals the internal structure of the object.
Number of polygons can be adjusted using the Adaptive or Uniform Smoothing dialog

boxes. 
Hidden Wireframe

Draws lines only for the front surface polygons of an object. All other polygon lines 
are hidden. 

Shading is done on a per-polygon basis, without using normals.
May be easier to interpret than the wireframe option.
Gives a clearer representation of the object's outer shape. 
Number of polygons can be adjusted using the Adaptive or Uniform Smoothing dialog

boxes.
Faceted

Draws a flat shade on each polygon of the object, depending on the material 
properties of the object and the lighting.

Uses Polygon normals for the shading.
Number of polygons can be adjusted using the Adaptive or Uniform Smoothing dialog

boxes.
Faceted Wireframe

Draws a combination of hidden wireframe and faceted rendering styles.
Lines clearly delineate the object's front surface polygons.
Shading uses polygon normals and a constant color, which shows the effect of the 

lights.
Number of polygons can be adjusted using the Adaptive or Uniform Smoothing dialog

boxes. 
Smooth



Draws objects with smooth tonal gradations between polygons.
Shading is calculated using vertex normals; reflected highlights are drawn. Intensities

are interpolated between vertices. (This is also known as Gouraud shading.)
Number of polygons can be adjusted using the Adaptive or Uniform Smoothing dialog

boxes. 
Shader

Draws objects using a preview renderer that provides a draft mode preview of a 
model.

Texture maps are rendered but not sampled or anti-aliased; transparencies are not 
rendered.

Draws quickly, but the quality is not as high as a final render.
Normals are interpreted for lighting calculations; also known as Phong shading.
Number of polygons can be adjusted using the Adaptive or Uniform Smoothing dialog

boxes. 



New Window

Shortcut:Shift+Control+N
Creates a new window with the current view settings and the current Window setup. The 
new window displays the scene name and adds Default View:2 (or 3, and so on) next to 
the name. You can then name this view in the Views browser and edit it to define new 
settings for it. The names of all open windows are listed at the bottom of the Window 
menu. Up to 10 windows can be open at a time.
Note: The option Create New View for New Window in the Preferences dialog box is 
on by default. Turn this option off if you don't want to create a new view for every new 
window.



Four-View Setup

Opens a set of four windows that provide a standard four-view configuration. Clockwise 
from the lower left window they display the left, top, front, and camera views. When the 
four-view setup is selected, all other windows are modified for the new views or closed. 
The Max Render Style for all windows, except the one containing the camera view, is set 
to wireframe. You cannot undo this command.
If the left, top, or front views are locked, they are unlocked when the four-view setup is 
selected. The camera view retains its locked status. 



Objects

Shortcut:Control+T
Shows/Hides the Objects browser, in which you can select and edit objects, their defining
geometry, selected vertices, and some properties. 
The accelerator key opens the Objects browser if it's closed, brings it forward to the top 
of the stack of windows if it's covered by other windows, and closes it if it's at the top of 
the stack of windows. The Objects browser retains its last position and the state of its 
settings when it is closed. 
Note: When multiple objects are selected they are all affected by Objects browser 
actions. The Objects browser displays only the values of the last object selected.



Object name (Objects browser)

The Objects browser displays the name of the object that is currently selected for editing.
It also displays the properties and values of the current object. To edit a different object, 
select the object by clicking it in the workspace or clicking its name in the World browser 
list. To rename the current object, highlight its name and type in a new one.
To locate an object that is part of a model hierarchy, double-click its parent's name in the
World browser list. If you select more than one object in the workspace, only the name of
the last object selected appears in the object name box.



Placement page (Objects browser)

The text entry fields in the Objects browser let you edit the position, orientation, and 
scale of the selected object. If you open an object and select some of its control points, 
changes to the position, orientation, and scale apply to the selected control points.

Position
The numbers in the Position fields show, from top to bottom, the x, y, and z coordinates 
of the object. To change the object's position, edit the numbers in these fields and press 
Enter to apply the new values; press Tab to apply the new values and advance to the 
next field. To lock the x, y, or z position coordinate for an object, select the checkbox 
next to the numeric field. When this checkbox is selected, the corresponding coordinate 
cannot be changed from the workspace; it can only be changed by editing the value in 
the position field.

Orientation
The numbers in the orientation fields show the object's rotation around the x, y, and z 
axes, from top to bottom. These numbers are expressed in degrees. To change the 
object's rotation, edit the numbers in these fields and press Enter to apply the new 
values; press Tab to apply the new values and advance to the next field. To lock the x, y, 
or z orientation coordinate for an object, click the checkbox next to the numeric field. 
When this checkbox is selected, the corresponding coordinate cannot be changed with 
the trackball or from the workspace; it can only be changed by editing the orientation 
field.

Scale
The scale field shows the scale of the object, expressed as a decimal. To change the 
scale of the object, edit the numbers in this field and press Enter to apply the new value; 
press Tab to apply the new value and advance to the next field. To lock an object's scale, 
click the checkbox next to the numeric field. When this checkbox is selected, the scale 
cannot be changed in the workspace.

Numbers Are
The pop-up in the Objects browser controls how position and orientation changes are 
applied to the object.

Delta to View--Enters the difference between the current position or orientation, 
relative to the view and a new position or orientation in the view's coordinate system.

Parent Relative--Changes the position or orientation of the selected object relative 
to its parent object. For an unlinked object, Relative to Parent is the same as relative to 
world.

View Relative--Changes the position or orientation of the selected object using the 
view's coordinate system.

Working Plane--Changes the position or orientation of the selected object relative to
the working plane.



Info page (Objects browser)

Layer Name
Reflects the name of the layer to which the object is currently assigned. An object's layer
cannot be changed from the Objects browser. Use the layers browser to change an 
object's layer. An object can be assigned to only one layer.

Material
Reflects the name of the material that is currently assigned to the object. Use the 
Materials browser, the eye dropper, or the paint bucket tool to change the material 
assigned to an object. An object's material cannot be changed from the Objects browser.

Mapping Type
An object can be assigned a mapping type in the Objects browser, or its mapping type 
can be set by choosing a particular texture placement tool. If it is assigned a mapping 
type in the Objects browser, it must be mapped interactively using the associated 
texture placement tool. In either case, the mapping type is saved with the object and is 
displayed in the Objects browser. 

Intrinsic-- The four corners of the two-dimensional texture map are matched to the 
geometry coordinates of the object to which the map is being applied. This is sometimes 
referred to as rubber sheet mapping. Use the intrinsic texture placement tool to interactively
adjust the map on the object. End caps are not mapped. To place a texture map on end caps,
use cubic mapping, or separate the end caps and use projective mapping.

Cubic--Replicates the map so that each face of a cube can be covered by it. Cubic 
mapping isn't represented by a cubic mapping tool. Use the projection tool to interactively 
adjust the map on the object.

Note: Once you have placed the map using the intrinsic tool, reset the mapping type
to cubic in the Objects browser.

Spherical--Wraps the right and left sides of the texture map into a spherical shape 
and then pinches the top and bottom of the image into poles, reducing the top and bottom 
into one point. Then the image is shrink-wrapped onto the object. Use the spherical texture 
placement tool to interactively adjust the map on the object.

Cylindrical--Wraps a 2D texture map into a cylindrical shape and then shrink-wraps 
it onto the object. Use the cylindrical texture placement tool to interactively adjust the map 
on the object. 

Projective--Projects the image like a photo transparency onto the XY planes of the 
object's surfaces. Use the projective texture placement tool to interactively adjust the map 
on the object. Use the material orientation tool to project onto a different plane.

Visible--Determines if the object is hidden or visible at the current time. If the checkbox 
is checked, the object is visible in the workspace. If unchecked, it is hidden. If the object 
is currently visible, hide it by clicking the Visible checkbox or choosing Hide from the 
Object menu. (You can also hide an object by hiding its layer in the Layers browser.) The 
Visible checkbox reflects the object's current visibility state, regardless of where it was 
set. Invisible objects are not rendered.
Tile--Replicates the texture map across the surface of the object. The number of times 
the map is replicated is set interactively using the texture placement tool. See    the 
Materials application tool group help topic. 



Texture X Flip--Rotates the texture map, or neighboring tile textures if the surface is 
tiled, around the x axis of the object.
Texture Y Flip--Rotates the texture map, or neighboring tile textures if the surface is 
tiled, around the y axis of the object.



Defining Geometry pages
(Objects browser)

The values of the object's profile geometry are displayed on a third page. The heading on
that page depends on the profile(s) that are associated with the object: 
Line--Displays the length of the defining line.
Rectangle--Displays the width and height of the defining rectangle. 
Square--Displays the width and height of the defining square.
Circle--Displays the radius of the defining circle.
Ellipse--Displays the semi-major radius of the defining ellipse and semi-minor radius of 
the defining ellipse.
Polygon--Displays the radius and number of sides of the defining polygon.
Polyline--Displays the number of line segments and length of the defining polyline.
Lathe--Displays the lathe angle (in degrees) of the defining lathe operation.
Arc--Displays the angle and radius of the arc.
Bezier--Displays the length of the curve.
Sweep--Displays the amount that the beginning and ending of the sweep is scaled, and 
the number of profiles used to make the sweep.
Skin--Displays the status of the Distribute Along Curve Length and Linear Surface 
Between Profiles options which you can set before creating the skin in the Skin 
Preferences dialog box. 
If the Distribute Along Curve Length checkbox is checked, the sweep was made by 
matching the control points of profiles based on their length. If the Linear Surface 
Between Profiles checkbox is checked, the sweep was made using a linear surface 
between the skin profiles. For more information, see the Skin tool preferences help topic.
Orientation trackball--Using the orientation trackball, you can manually change the 
rotation of the object. Click and drag the x, y, or z face of the trackball to rotate the 
trackball and the model in the selected view. In the workspace, the bounding box and 
axis of the selected object reflect the changes you make using the trackball. 



Views 

Shortcut:Control+E

Shows/Hides the Views browser. 

Views list
The Views browser displays the names of all the views in the scene. The view that is 
currently active and available for editing is highlighted, and the values of its orientation, 
position, and scale properties are displayed. To edit a different view, select it from the list
in the Views browser. Changes to the selected view appear in the workspace as you 
make them. To change the name of the view, type a new name in the text field at the 
bottom of the browser.
The Default View, a front view, is included with Extreme 3D; it is the first view you see 
upon opening the application. A default camera view, The Camera, is also included. 
Default views are saved with Extreme 3D's defaults file in the Scripts directory or folder. 
Extreme 3D automatically reads the default file's contents when creating a new scene. 
Neither the default view nor the camera view can be deleted. You can create a custom 
default view.
The fields on the right side of the Views browser allow you to edit the position, 
orientation, and scale of the selected view. When you type a number in the numeric field 
and press Enter, the view is immediately redrawn using that value. Press Tab to apply the
new value and advance to the next field.

Orientation
The numbers in the orientation fields show the rotation of the eye point around the 
center of the view. These numbers are expressed in degrees. The distance between the 
eye point and the look-at point is determined by the Perspective setting.
For the position and orientation fields, positive values for x shift the view to your left, 
positive values for y shift the view down, and positive values for z shift the view closer to 
you. When the view is shifted, the object appears to shift in the direction opposite to the 
change in view. However, changing values in the Views browser modifies only the view, 
not the object.

Position
The numbers in the position fields show the coordinates of the view's look-at point. From 
top to bottom, the x, y, and z coordinates describe a point in absolute, or world, space. 
When the view is rotated or scaled, it is rotated or scaled around this point. 
Note: In viewspace, the eye point is at 0,0,0 and the view is along the negative z 
axis. Therefore, if you compare the camera view's position values in the Views browser 
with its view position values in the Objects browser or score, you will note they are the 
inverse of each other. If the camera's position is updated in the Views browser, the score 
updates the camera position by calculating this inverse value.

Scale
The scale field shows the scale of the view, expressed as a decimal--1.0 equals 100 



percent. For example, at 2.0 the objects appear twice as large on the screen. If you set 
the scale to 0.5, the objects appear half as large. To change the scale of the view, edit 
the numbers in this field and press Enter to apply the new value; press Tab to apply the 
new value and advance to the next field. The center of the view always remains the 
same. 

Lock View
Clicking the Lock View checkbox locks the values of the view. This constrains the view to 
the current values should you try to change the view in the workspace or in the browser. 

Orientation trackball
To change the orientation of the view manually, use the trackball at the right side of the 
Views browser. Click and drag the x, y, or z face of the trackball cube to rotate the 
trackball. When you use the trackball, a simplified image of the view is redrawn in the 
workspace as fast as your processor allows. The heads-up orientation axis in the lower 
left corner of the view updates to reflect the orientation of the trackball when you release
the mouse button.
Numbers are--This pop-up indicates how position and orientation changes are to be 
applied to the view. 

View Absolute--When this option is selected, Extreme 3D resets the view to the 
exact values that you type in the numeric fields. This is the default.

Delta to View--Reflects the difference between the current setting and the new 
setting.

Note: View changes made using the hand and zoom tools also affect the current 
view. The trackball and position, orientation, and scale fields update appropriately to 
reflect those changes.



Materials

Related topics:

Material Editor
Standard material attributes
Texture editor
Default materials

Shortcut:Control+M
Shows and hides the Materials browser. Use the Materials browser to select, apply, edit, 
delete, and create new materials in the current scene or save them for use in other 
scenes. 
Note: To learn about material attributes and see examples of interesting effects 
created with materials, see the Materials Lab in the Explore section of the Extreme 3D 
Access application.

Materials in Scene
The materials being used in the current scene are listed in the Materials in Scene column
of the Materials browser. Gray Plastic is the only material listed by default. 
To select a material, click its name in the Materials in Scene list. The material name is 
highlighted in the list and appears in the text entry field below the list. To change the 
name of the current material, place the text cursor in the text entry field, type in the new
name, and press Enter. An example of the current material, applied to a standard object 
using the current lights, renders in the preview box. (Because the scene's current lights 
are used to calculate the preview, you may need to adjust the lighting before selecting 
materials.)
Note: Materials with low opacity values do not display as transparent. The preview 
also doesn't preview fog or light effects.
To apply a material to an object, select the object, select a material from the Materials in 
Scene list, and click Apply. To apply the material to the children of the selected object, 
press F2 while clicking Apply.
You can also use the bucket tool to apply the current material to objects. Using the 
bucket tool while pressing F2 applies a material to the parent object and its children. To 
select an object's material and make it the current material, press F3 and click the object
whose material you want to pick up. You can then apply that material to other objects in 
the workspace.
Materials in the Materials in Scene list can be cut, copied, pasted, and duplicated.
There are nine basic material types. To create a custom material from one of the basic 
material types, select the material in the Materials in Catalog list and click the left double
arrow button. Then you can change a material's properties to customize its appearance. 
To do so, click Edit or double-click the material's name. That material's attributes, which 
vary depending on the material type, are displayed in the Material Editor.
The default material type that the current material was created from is displayed below 
the Materials in Catalog list.



To save any customized materials for use in other scenes, move them into the Materials 
in Catalog group by selecting each material and clicking the right double-arrow button. 
Materials are saved in the current catalog as .MAT files. They will appear in the catalog 
the next time you select that catalog.

Materials in Catalog
The Materials in Catalog list includes a set of default material types that can be used to 
generate a number of different materials by editing their basic properties. A variety of 
materials can be created using a single default material. For example, Chrome, Gold, and
Copper are all materials generated from the Chrome+Glass default material.
The default materials available in the catalog are: Chrome+Glass, Marble, Mondo Map, 
Organic Magic, Plastic, Scratched Metal, Solid Pattern, Texture Map, and Tiles. Each 
default material provides a departure point for creating new materials that share similar 
characteristics. The catalog may also contain materials that you have moved from the 
Materials in Scene list and any images that have been converted into texture maps.
To copy a default material from the catalog to the Materials in Scene list, select the 
default material and click the left double-arrow button or double-click the material's 
name. The material appears in the Materials in Scene list and is named after the material
in the catalog, followed by an instance number. The material is automatically previewed. 
You can either use the default material as is or create a new material by editing it.
To open another materials catalog, click the Select Catalog button. This opens the 
standard directory dialog box allowing you to search your system for additional catalogs, 
such as the presets CD that comes with Extreme 3D. Catalogs can contain both .MAT 
(materials) files and .TEX (texture map) files.
Note: Materials you create and catalog are saved into the current catalog. To create 
a new catalog, make a new folder on your system, then choose this folder in Extreme 3D 
by clicking Select Catalog.
Clicking the New Texture button creates a new instance of the Texture Map default 
material and opens a standard directory dialog box. Choose a BMP file and click Open. 
The image is converted into a .TEX file and a new instance of the Texture Map default 
material named after the image appears in the Materials in Scene list. 
If the current catalog exists on a CD or other non-writable media, you are prompted to 
save the new texture map material in a different catalog. 



Material Editor

Related topics:

Standard material attributes
Texture editor
Default materials

The appearance of any surface depends upon three elements: the attributes assigned to 
the material, the orientation of the surface, and the light at that point in space. For each 
basic material type you can use the Material Editor to change its attributes. To enter the 
Material Editor, select the material you want to edit from the Materials in Scene list and 
click Edit. 
Note: To change the orientation of the surface, use the material orientation tool.
Use the Lights browser to change the lighting. The preview button updates the previewer
in the Materials browser and displays the current material with the current settings.



Standard material attributes

Related topics:

Material Editor
Texture editor
Default materials

The following paragraphs describe the basic set of material attributes that are common 
to most materials. For other attributes that are specific to a given material, look for the 
material by name in the section describing each material. To see examples of these 
attributes, see the Materials Lab in the Explore section of the Extreme 3D Access 
application.
In general, if the control for a material property is a slider, a decimal, or a pop-up, the 
value can be animated.    
Color--The color determines the surface color of the object. Click the color chip to open 
the System Color Picker. The actual color that you use in the scene depends on the color 
of the lights shining on the object. For Example, a red light shining on a blue object will 
look black.
Diffuse--If a material has a surface color, there is a corresponding Diffuse slider that 
directly controls the intensity of the diffuse light reflected by the object. When the value 
of the slider is set to 0.0, the surface appears black and reflects no diffuse light. When 
the value is 1.0, the surface reflects a maximum amount of diffuse light. In this case, the 
object appears to have the full surface color as set in the Surface Color attribute. (Diffuse
works just like the Lightness attribute in a Hue, Saturation, Lightness color system.) 
Diffuse reflection is also affected by the angle at which the light strikes it. That is why the
diffuse reflection from a sphere falls off as the surface curves away from the light source.
You can change the diffuse value of a material by dragging the slider or entering a value 
in the field to the right of the slider.
Because the diffuse reflection of the surface color is dependent on the angle at which the
light hits the object's surface, the color's hue, saturation, and brightness change under 
different lighting conditions and at different angles to the light. For example, if there are 
a lot of bright lights in the scene and the diffuse slider is set to the maximum value, your
object may look washed out. To be sure you are setting the surface color value to the 
color you want, make sure you adjust the diffuse value under the lighting conditions you 
will be using for the scene. 
Tip: Most surfaces reflect light in two ways: diffuse and specular. The diffuse 
reflection accounts for the color of the object, while the specular color is what makes it 
look shiny or matte.
Specular--The specular color controls the intensity and color of the specular highlight. 
The specular highlight is the direct reflection of the light source off of the object. If the 
Specular color is a shade of gray, the specular highlight is the same color as the light. 
When the Specular color is close to white, the surface reflects all the light hitting it. 
When the Specular color is any other color, it modifies the color of the light by that color. 
The most familiar example of a colored specular object is a colored Christmas tree 
ornament. A white light reflected in the ornament takes on the color of the ornament. 
This means a pure blue light striking a pure red specular object will have no specular 
highlight of either color.
Roughness--This color also affects the specular reflections from an object. In the real 



world this quality is seen in paints that have high gloss, semi-gloss, satin, or flat finishes. 
The roughness attribute lets you have the same kind of control. The darker the 
roughness color, the glossier the finish, and the smaller the highlight. By allowing the 
roughness to be a color, the size of red, green and blue reflections can be controlled 
independently. The visual effect of this is that the specular highlight can have a colored 
halo. This mimics the reflection of an atmospheric halo around the light and very finely 
textured surfaces. Images render faster if the roughness color is a shade of gray.
Tip: If the Specular and Roughness colors closely match the Diffuse color, then the 
surface looks metallic. If the Specular color is white, the material looks like plastic.
Ambient--Controls how much of the global ambient color the material responds to. It 
determines the minimum illumination for that object. The main use of the ambient color 
is to fill in shadows that are too dark. Because the ambient color is constant over the 
whole surface, it has the effect of reducing the apparent contrast of the scene. Surfaces 
with a high ambient value and a low diffuse value appear flatter and darker. Surfaces 
with a low ambient value and a high diffuse value have darker shadows.
Tip: Fog can also have the effect of reducing the materials contrast. The color of 
the ambient light for the scene is set in Global Effects. You can change how much the 
global ambient color affects a given material by dragging the slider or by entering a 
value in the field to the right of the slider.
Opacity--Determines how much an object's surface occludes those objects behind it. A 
material that has an opacity value of 1 produces a surface with a completely solid or 
opaque appearance, like metal. If a material has an opacity of 0, it produces a 
transparent, glass-like surface. Opacity has no effect on the color or lighting of the 
object, it only controls how much of the color behind it shows through.
Opacity effects only appear in 32-bit final renders of the image. The opacity setting also 
manipulates the alpha channel in the final image.
Tip: To animate the disappearance of an object, make its diffuse, specular, 
ambient, and opacity values go to zero .



Texture editor

Related topics:

Material Editor
Default materials

In addition to the standard material attributes, both texture map materials, Mondo Map 
and Texture Map, display image thumbnails for every attribute that can be mapped. 
Clicking on any image thumbnail opens the Edit Texture dialog box. This displays the list 
of images that are converted and ready for use as texture maps. To convert an image for 
use as a texture map, click Load. The standard directory dialog box opens, allowing you 
to search for a bitmap. Choose a BMP file and click Open. (This image cannot be 
animated.) This converts the bitmap for use as a texture map and stores it as a .TEX file 
in the Extreme 3D Scripts directory or folder. Whenever a texture map material is copied 
back to the catalog, its texture map image is copied to that catalog's directory.
Note: A .TEX file converted from a bitmap is approximately 4/3 the size of the 
original bitmap.
Note: Selecting Cancel in the Edit Textures dialog box does not cancel the 
conversion process or delete the .TEX file. To delete a .TEX file from the texture map list 
in the Edit Textures dialog box, you must quit Extreme 3D, throw the file away at the 
operating system level, and then restart Extreme 3D.



Default materials

Related topic: Material Editor

Extreme 3D includes the following default materials:
Chrome+Glass
Marble
Mondo Map
Organic Magic
Plastic
Scratched Metal
Solid Pattern
Texture map
Tiles



Chrome+Glass

Chrome+Glass creates a highly reflective material that reflects the environment map 
assigned to it. This is useful for surfaces such as polished chrome, gold, copper, and 
glass. 
The Chrome+Glass material takes all its color from the map it is reflecting. That color 
gets modified by each of the properties on the Optics properties sheet. This is not a 
raytracing reflection. It uses a prerendered image as a reflection map. To reflect other 
objects in the scene you'd need to first render an image from that point in space and 
then use that image as a reflection map.

Chrome+Glass: Optics
Opacity--Creates transparency without refraction. A value of 0 is totally transparent and 
allows anything behind the object to be seen. 
Reflection Color--Determines the color of the reflected light. It is the same as the 
specular value on other materials. (For example, set the Reflection Color to yellow to 
create a gold material.) To see any reflections, the Reflections checkbox must also be 
checked.
Glass Color--Determines the color of the refracted light. To create the look of red glass, 
check both Render Glass and Reflections checkboxes. To create the look of polished 
metal, select only Reflections and not Render Glass.
Brighten Edges--Creates an optical effect called the Fresnel factor. When checked, the 
reflection intensity increases at the edges, which is optically realistic. That is, the edges 
are brighter and are the color of the light. When unchecked, the refraction is uniform in 
intensity and color, and creates a flatter, more artistic-looking edge. 
Environment Map--Specifies an image to be refracted and reflected. Clicking on the 
image opens a list of available images that have been converted for use as Extreme 3D 
environment maps. You can select an environment map from the list or you can convert 
a bitmap image into an environment map. To do this, select Load. 

Chrome+Glass: Bumps
Bump Style--Determines the appearance of the bumps.

None results in no bumps.

Smooth Bumps creates a random bumpy surface that moves both above and below 
the original surface.

Smooth Knobs creates bumps above the original surface.

Jagged creates bumps with sharp changes in direction like crumpled tin foil or 
broken rocks. 

Bump Scale determines the overall size of the bump pattern in model units.
Bump Height determines the height of the bumps in model units.











Marble

Marble creates a solid texture material. Objects to which solid texture materials are 
applied appear to be carved out of a solid mass of material. Marble creates a material 
with marble-like stripes. The stripes can be reoriented to any direction using the material
orientation tool.
Each instance of the Marble shader describes a solid "shader space" around the center 
point of the object. Different objects have different center points, so they have different 
"marble spaces." To make two adjacent blocks appear to have been carved from the 
same block of marble, move their center points to the same position. Likewise, if you 
duplicate a marble sphere a few times you can change the center point of each sphere 
arbitrarily to make each look like each was carved from a different piece of marble.
Note: The marble shader does not render as quickly as simpler materials.

Marble: Colors 
Band Size--Four different colors can be selected on the color page. The Band Size 
settings determine the relative thickness of each color. 
You do not need to use all four colors. One or more bands can be set to zero. However, 
because the bands are blended together, even a zero width band may be visible.

Marble: Surface 
On the Surface page you can specify the Standard Material attributes: The amount of 
Diffuse reflection, the Specular and Roughness colors, the sensitivity to the scene's 
Ambient color, and the Opacity value. These settings affect all four colors equally. All of 
these standard attributes are discussed earlier in this section.

Marble: Effects 
Material Scale--Determines the size of the stripes, in model units, relative to the object.
This value can be animated.
Turbulence--Determines how tangled and nonlinear the striations are. A value of 0 
creates a very linear striped look. A value of 1 creates a meandering maze of striations. 
This value can be animated.



    



Mondo Map 

Mondo maps associate a different bitmap image with each one of several specific 
attributes of an object's surface. This allows you create complex mapped surfaces like 
car paint, tiled floors and special effects. The time that Mondo Maps requires for 
rendering is compounded by the number of different maps you use. If you only want a 
single image or a simple reflection, use the Texture Map or Chrome+Glass default 
materials instead.
The mapping style, which determines how a two-dimensional texture map is applied to 
the surface of a three-dimensional object, depends on the texture placement tool you 
choose for that object. The texture placement tools allow you to interactively place and 
adjust a texture map on an object.
Once an object has been mapped using the interactive texture map placement and 
material orientation tools, its mapping type is saved with the object. You can view and 
change the mapping style of an object's texture map from the Info page of the Objects 
browser. Other options that provide additional ways of specifying how the texture map is 
applied, such as tiling, are also available in the Objects browser.
The same map style, tiling, and flip settings are used for all maps in the Mondo Maps 
material except the environment map. Therefore it is best to get all the maps oriented to 
the object before turning on tiling in order to insure more predictable results. 

Mondo Map: Map
Mapped--To apply a map to the surface of an object, check the Mapped checkbox and 
click the Texture Map thumbnail image. This opens the Edit Texture dialog box that 
displays the list of texture maps currently in your Scripts directory or folder.
Texture Map--This image is mapped to the surface color of the object.
Alpha Use--Determines how the alpha channel from the texture map image is used.

Override Alpha assigns the alpha channels a value of 1, making them opaque. This 
is an especially useful setting if the alpha channels of the images you are using have a 
setting you don't want the texture maps to use. 

Composite over Color uses the value of the image's alpha channels to composite 
the texture map over the object's surface color. A higher alpha channel value in the image 
reveals less of the surface color. This setting is useful for producing decal effects. For 
example, to create the effect of a label on a bottle, create a label on a large canvas and 
mask only the label. The rest of the bottle will be the color specified on the Surface page.

Existence of Surface applies all of the standard material properties of the surface 
to the texture maps. To see the effects of this setting create a texture map that has a black 
background and an alpha channel value of 0. Apply this map to an object using the 
Existence of Surface setting. Wherever the texture map has color, the object has color that 
can be affected by the specular, roughness, and diffuse sliders. Wherever the map has alpha
channel information, the object can be made totally transparent by setting the Opacity slider
(on the Surface page) to 0.

Luminance map uses the alpha channel value as a luminance value. A high alpha 
channel value produces a bright glow wherever the texture map has alpha information. A 
low alpha channel value produces a dim glow. The glow takes its color from the color 
information of the texture map. This setting is useful for creating windows that glow 
independently of the scene light.



Mondo Map: Surface
The basic set of material attributes common to most materials are defined on the 
Surface page. For objects using the Mondo Map material, these attributes are applied to 
any place on the surface of the object that is not covered by a map. 

Mondo Map: Bump
A bump map modifies the appearance of an object making it look bumpy. 
Bump Mapped--To apply a bump map to the surface of an object, check the Bump 
Mapped checkbox and click the Bump Map thumbnail image. This opens the Edit Texture 
dialog box that displays the list of texture maps currently in your Scripts directory or 
folder.
Grayscale images will produce the most predictable results for bump mapping, while 
color images may not.
Bump Scale--Determines how bumpy the surface will appear after mapping. A value of 
1 will create a very bumpy surface.

Mondo Map: Environment 
Environment maps are used to represent a surrounding environment that is reflected by 
the surface of the object. 
Environment Mapped--To use an environment map during rendering, check the 
Environment Mapped checkbox and click the Environment Map thumbnail image to open 
the Edit Texture dialog box. Environment maps are modified by the specular map but not 
by the roughness map. 
Environment Intensity--Scales the reflection to be relative to the light. 

Mondo Map: Specular
Specular Mapped--A specular map allows the reflectivity of an object to be determined 
by an image. (The image's alpha channel is ignored.) Specular maps can be used to 
create certain special effects like scuffed floors, soap bubble surfaces, and pearlescent 
surfaces. The specular map appears wherever there are specular highlights on the 
object. The Specular color on the Surface page controls the intensity of the specular 
map. When the Specular color is black, the specular map is not visible. 
To apply a specular map to the surface of an object, check the Specular Mapped 
checkbox and click the Specular Map thumbnail image to open the Edit Texture dialog 
box. 
Roughness Mapped--Roughness maps are used to create surfaces of varying shininess 
like polished granite, in which a reflection can be seen in some parts of the surface but 
not in others. The reflection varies between shiny and dull over the surface. To calculate 
the object's roughness, the Roughness color on the Surface page is multiplied by the 
color of each pixel of the roughness map. The resulting color determines the roughness 
at that point. (The image's alpha channel is ignored.)
To apply a roughness map to the surface of an object, check the Roughness Mapped 
checkbox and click the Roughness Map thumbnail image to open the Edit Texture dialog 
box. 





Organic Magic

Organic Magic creates solid texture materials where the object appears to be carved out 
of a solid mass of material. Organic Magic combines two plastic-like materials in a semi-
random pattern. The Organic Magic pattern is controlled by the type of filter selected and
the attributes assigned to that filter. The material orientation tool can be used to reorient
the pattern to any axis of the object. Organic magic is useful for creating materials that 
look like clouds, granite, gasses, sky, and planets.
Each instance of the Organic Magic shader describes a solid "shader space" around the 
center point of the object. Different objects have different center points, so they have 
different spaces. To make two adjacent blocks appear to have been carved from the 
same block of material, move their center points to the same position. Likewise, if you 
duplicate a sphere a few times, you can change the center point of each sphere 
arbitrarily to make it look like each was carved from a different piece of material. 
Note: If an object using an Organic Magic material has a vertex or free form 
deformation animation, the material will appear to pass over the object as the object 
changes shape.

Organic Magic: Filtering
The Filtering page is used to define the patterns that are used to create the solid texture.
Filter type determines how the transitions between the two main materials are blended:

Natural Blend results in a blurry mix of the two colors using a random pattern. 
There are no sharp edges between one material and the next. 

Linear Blend creates a linear transition between the two materials where they meet.
The definition between the materials is more distinct than if you use no filter. This is the 
default.

Edge Blend creates areas of material 1 with rings of material 2 surrounding the 
areas. The Material Proportions slider controls the size of the rings relative to the areas they 
surround. 

Smooth Blend creates a smoothly blended transition where the two materials meet.
It is less prone to artifacts than Linear Blend.    

Sharp Transition creates very defined transitions wherever the materials meet, with
no mixture between the two materials. The edge is anti-aliased according to the Quality 
setting specified in the Final Render Setup dialog box.

Filter complexity determines the amount of detail in the semi-random loose pattern: 
Simple applies the filter once.
Complex applies the filter five times.

Faster--Calculates the pattern more quickly. Faster should be used for previewing. 
However, it can introduce artifacts which occasionally produce some interesting effects. 
If you have chosen a high contrast filter, like sharp edges, you may not notice a 
difference in the appearance of the final surface when Faster is checked. For a low 
contrast filter, like edge blending, the Faster option can cause the surface to have 
noticeable artifacts or banding and appear less smooth. 



Bump--The Bump slider is used in conjunction with the Bump Filter to create a relief 
pattern. When the Bump slider has a value greater than 0, the Bump Filter has an affect. 
They produce the same effects filters, and in addition they create the appearance of 
depth wherever the materials meet by making Material 2 appear higher and Material 1 
appear lower. (Except in the case of the Edge Blend filter, where the opposite is true.) 
Using the same filters for edge blending and Bump Filter produces a more realistic effect,
but any combination is possible.
Scale--Sets the scale for which the pattern is applied to the surface. The scale is based 
on the unit of measurement that is specified in the Units dialog box. 
Material Proportions--Determines the amount of each material to be used in the 
pattern. The value indicates the proportion dedicated to Material 1, with the remainder 
being reserved for Material 2. A setting of 0.7 means that the pattern will consist of 70 
percent of Material 1 and 30 percent of Material 2. A setting of 0.5 means that the final 
pattern will consist of equal amounts of each material. The pattern rarely consists of 100 
percent of either material.

Organic Magic: Material 1 and Material 2
Use the Material 1 and Material 2 pages to identify the two main materials and set the 
standard material properties for each. 













Plastic 

Plastic is used to create materials that produce plastic or ceramic surfaces. Plastic uses 
only the standard material attributes.



Scratched Metal 

The scratched metal material produces surfaces that appear to have microscopic 
scratches in them. The scratches cannot be seen but they affect the way light is 
reflected. The scratches can be arranged in several scratch patterns over the surface. 
The material orientation tool can be used to orient the scratch patterns to any plane of 
the object. Metal uses the standard material attributes. Metal is used to create materials 
that look like scratched or lathed metal surfaces and can also be used to simulate some 
fabric looks.

Scratched Metal: Scratches
Scratch Patterns--Does not produce real scratches that have depth but imitates the 
scratch patterns typical of a variety of metal surfaces. The direction of all scratch 
patterns can be rotated in any direction using the material orientation tool. 

Constant creates a pattern that looks like constant scratches that are parallel to the 
object's axis. 

Turned creates a pattern that looks as if the metal was turned on a lathing machine 
about the y axis. A different axis can be selected with the material orientation tool. 

Stripes creates the appearance of metal that has been sanded in varying directions. 

Engine Turning creates the repeating circular pattern of burnished metal. The 
engine blocks of some cars have this look.

Checkered creates a pattern of alternating squares with scratches at 90 degrees to 
each other. Shrinking the scale of this pattern can create a cloth-like appearance.

Irregular Patches creates semi-random patches with scratches at 90 degrees to 
each other. 

Random Swirls creates the look of meandering scratches. 

Jagged Swirls creates the look of crumpled aluminum foil. 

Scratch Scale--Determines the size of the pattern of scratches. 
Scratch Depth imitates the way light disperses from metal surfaces that are scratched 
to varying depths. On a surface with a Scratch Depth value of 1, the reflection and 
highlights are stretched out over a broad area, like a metal surface that is deeply 
scratched. A value of 0 will create a surface with no apparent scratches and a symmetric 
highlight that makes the surface look more like plastic.

Scratched Metal: Surface
The Surface page is used to set the standard material attributes of the material. All of 
the attributes apply as they do for plastic. Set the slider to specify how much of the 
global ambient light affects the surface. You can also set the diffuse and opacity values, 
and the roughness and specular colors for the surface. 
Tip: To best create the look of metal, make the Specular and Roughness colors 



identical to the surface color and make the material totally opaque.



















Solid Pattern

Solid Pattern creates a solid texture composed of stripes or layers. It combines two colors
in a pattern of concentric shapes that are applied in strata to the object's geometry. An 
object to which Solid Pattern is applied appears to be carved out of these layers. Each of 
the two materials has the standard set of material attributes. The concentric shapes can 
be distorted or reoriented using the material orientation tool. You can also change the 
pattern's center by moving the object's center point. Solid Pattern is useful for creating 
wood or other layered materials. 
Note: If an object using a Solid Pattern material has a vertex or free form 
deformation animation, the material will appear to pass over the object as the object 
changes shape.

Solid Pattern: Pattern 
All the patterns consist of layers, with each layer alternating between the two materials. 
The layers can have one of several different spatial patterns. 
Pattern Type--Determines which of these patterns is applied. Each type works best with
an object of similar shape. For example, the spherical pattern matches the pattern layers
to the geometry of a sphere. However, you can use any type with any object shape.

Spherical is a series of concentric spheres. Starting from the innermost sphere, each
sphere contains another, slightly larger sphere. 

Cylindrical is a series of concentric tubes, or cylinders, radiating from the y axis. The
axis can be reoriented using the material orientation tool.

Cubic is a series of nested cubes. 

Planar consists of a series of layers or planes of infinite extent, piled up on top of 
each other. Use the material orientation tool to change the direction of the pattern.

Pattern Scale--Sets the distance between each layer of the strata. It is based on the 
unit of measurement specified in the Units dialog box. 
Edge Sharpness--Is a filter that determines the sharpness of delineation between the 
two materials as they appear next to each other. If the number is large, like 0.8, the two 
materials form a sharp edge. A smaller number like 0.1 results in a smooth blend 
between the two materials. 

Material Proportions--Determines the relative proportion of each material as it is 
distributed in the layers that make up the pattern. The number you enter indicates the 
fraction of the pattern dedicated to material 1, with the remainder being reserved for 
material 2. A material weighting value of 0.5 means that the final pattern consists of all 
layers of equal size, with alternating materials.

Note: The material weighting also introduces an asymmetric blend between the two 
materials, which enhances its wood-grain appearance.

Solid Pattern: Warp
Turbulence--Indicates the amount of disturbance to add to the pattern. This gives the 



layers a swirling or warped look.
Turbulence Scale--Determines the size of the disturbances that will distort the layers 
relative to the pattern scale. 
Bumpiness--Used to create a relief pattern. When the Bump slider has a value greater 
than 0, material 2 appears higher and material 1 appears lower. 
Keep Moire Patterns--When the distance between layers is less than a pixel, moire or 
aliasing patterns can occur. Check this checkbox to allow these moire patterns to show. 
Otherwise, the effects will be filtered out. Depending on the look you are trying to 
achieve, you may want to include the moire pattern. If not, deselect the checkbox to 
filter it out. 

Solid Pattern: Material 1 and Material 2
Each of these two materials are like the default plastic material. Any of their attributes 
can be set independently of the other material.











    

Left: Low Edge Sharpness. Right: High Edge Sharpness



    



Texture Map

The Texture map material allows a bitmap image to be applied to the surface of an 
object. This is useful for producing surfaces that look like labels or wallpaper, or for 
creating surfaces that render quickly. 

Texture Map: Map
The Map page specifies what image to use for the texture map and how to use its alpha 
channel. 
Texture--Displays a thumbnail image of the map currently associated with the material. 
To choose a different map or create a new one, click the thumbnail. This opens the Edit 
Texture dialog box. 
After you have assigned a map to the material, use one of the texture placement tools to
interactively place and adjust the map on the surface of an object. The texture 
placement tool you choose determines the object's mapping style. This mapping style is 
saved with the object and establishes how the two-dimensional texture map is applied to
the object's three-dimensional surface. For more information, see the Materials 
application tool group help topic.
The Info page of the Objects browser lets you view and change the mapping style of the 
current object. Other mapping options available in the Objects browser, such as tiling, 
provide additional information for applying the texture map to the object. 

Override Alpha assigns the alpha channel a value of 1 making it opaque. This is an 
especially useful setting if the alpha channel of the image you are using has a setting you 
don't want the texture map to use. 

Composite over Color uses the value of the image's alpha channel to combine the 
map with the object's surface material. A higher alpha channel value in the image reveals 
less of the surface material. This setting is useful for producing decal effects, where a label 
is placed on top of another material.

Existence of Surface setting applies all the standard material properties of the 
surface to the texture map. To see the effects of this setting create a texture map that has a 
black background and an alpha channel value of 0. Apply this map to an object using the 
Existence of Surface setting. Wherever the texture map has color, the object has color that 
can be affected by the Specular, Roughness, and Diffuse sliders. Wherever the map has 
alpha channel information, the object can be made totally transparent by setting the Opacity
slider to 0.

Luminance map uses the alpha channel value as a luminance value. A high alpha 
channel value produces a bright glow wherever the texture map has alpha information. A 
low alpha channel value produces a dim glow. The glow takes its color from the color 
information of the texture map. This setting is useful for creating windows that glow 
independently of the scene light. 

Texture Map: Surface 
The Surface page is used to set the standard material attributes of the material. The 
color applies only where the texture map doesn't cover the object's surface. The other 
attributes apply as they do for plastic. Set the slider to specify how much the global 
ambient color affects the surface. You can also set the diffuse and opacity values, and 
the roughness and specular colors for the surface on this page. 



Tiles

Solid Tiles creates both solid and surface textures of tile using two colors in various 
patterns. Objects to which tiles are applied as solid texture appear to be carved out of a 
solid mass of material. The material orientation tool can be used to orient the tile 
patterns to any direction of the object. Tiles is useful for creating tiled walls and floors as 
well as grids.

Tiles 
Filter--There are ten filter options. 
The seven two-dimensional patterns are (click to see an illustration): Checks, Grid, 
Triangles, Bricks, Dots, Triangle Grid, and Hexagonal Grid. The three three-
dimensional patterns are (click to see an illustration): Cubes, Grid, and Spheres. 
All patterns are anti-aliased. 
Mapping--Two choices determine how the patterns are applied. 

Solid Texture mapping style projects the patterns through the material, with 3D 
patterns varying in the third dimension. Use the material orientation tool to place patterns 
using this style.

Note: If an object using a Solid Texture has a vertex or free form deformation 
animation, the material will appear to pass over the object as the object changes shape.

Intrinsic Surface Map uses the pattern like a texture map, applying it just to the 
surface of the object. Use the Intrinsic texture placement tool to place patterns using this 
style. Using the material as a map rather than as a solid texture speeds up rendering time.

Tile Scale--Determines the size of each tile. It changes the distance between each 
repeating tile pattern. A value of 0.2 is a good starting default for most patterns.

Material Proportions--Determines the amount of each material for the pattern. The sphere
and dot filters use it as the radius of the spheres and dots. On the grid and brick filters it 
changes the mortar between the grids or bricks. The other filters ignore this value.

Tiles: Material 1 and Material 2
Select the material and specify the settings for the diffuse and opacity options for the 
two regions of the pattern. Set colors for the roughness and specular attributes. One 
material provides the color of the pattern element. The other material is the color of the 
pattern background.



























    



    



Lights

Shortcut:Control+L

Shows/hides the Lights browser. 
Use the Lights browser to create, edit, and delete the lights in the current scene.

Light pointer
At the top of the Lights browser is the light pointer. The narrow end of the light pointer 
represents the direction the light is pointing. To edit the orientation of a selected light 
(that is, the angle at which the light is shining) drag the end of the light pointer. As you 
move the light pointer, the numbers in the orientation fields are updated. These numbers
are expressed in degrees and are relative to the current view.
Note: If the light pointer appears to move in a direction opposite the mouse, this 
means the light is behind the light pointer facing you.
When a new view is created, the light pointer updates to reflect the current light's 
orientation in the new view. You can also change the orientation of the current light by 
directly editing the numbers in the orientation fields. To adjust the position of the light, 
use the arrow tool to drag the light icon in the workspace.
Click Update Scene to see the change in the workspace.
Note: Omni lights do not have a direction, so the light pointer does not affect them.

Lights in Scene
The Lights in Scene list shows the available lights in the current scene. 
To edit a light's attributes, click its name in the Lights list and click Edit, or double-click 
the name. The Light Editor window appears, displaying the options for that type of light, 
either distant, spotlight, or omni light.
To create a new light, copy or duplicate a light that is selected in the workspace or in the 
Lights browser. You can also copy a light from the Lights in Catalog list and edit its 
values. To move a light into the scene, select it in the Lights in Catalog list and click the 
left double-arrow button.
Change the name of the selected light by typing a new name in the field below the lights 
list, at the bottom of the browser.
When you've set the light attributes, click Update Scene to redraw the scene in the 
workspace using the newly defined light. Light settings affect both the objects in the 
workspace and the preview in the Materials browser. You can copy any light from the 
Lights in Scene list to the catalog by clicking the right double-arrow button.

Lights in Catalog
The Lights in Catalog column displays the complete list of available lights in the current 
lights catalog. In addition to default light types, the catalog contains any lights that you 
have customized and moved into that catalog. To copy a light from the catalog to the 
Lights in Scene list, select that light and click the left double-arrow button. A copy of the 
light will appear in the Lights in Scene list. 



Extreme 3D's default lights are:

Distant Light--A distant light is similar to sunlight. By default, a distant light 
is a white light at 90 percent intensity. It points toward the center of the view from a position
that is infinitely far away and shines in a definite direction. Any object surface facing the 
distant light is illuminated by it. The intensity of a distant light is independent of its position 
or distance from the light. Distant lights can have shadows and can be turned on and off. 
Because distant lights have an infinite position, they are not represented in the scene by a 
light icon.

Omni Light--A point light that shines in all directions (360 degrees). It has a 
position in space that can be set in the Objects browser or interactively in the workspace. 
Omni lights can have intensity fall off, and can be turned on and off. Omni lights cannot cast 
shadows. Because omni lights shine in all directions, the light pointer and orientation fields 
do not affect them. They do have positions and are represented in the scene as objects.

Spotlight--By default a spotlight is a white cone of light at 90 percent 
intensity. It has a position in space that can be set by value in the Objects browser or 
interactively by moving the spotlight icon in the workspace. It shines as a cone of light in a 
specific direction that can be set by the light pointer, by value in the Objects browser, or 
interactively in the workspace. Spotlights can have shadows, dust effects (which create 
visible light sources), and distance falloff, and can be turned on and off.

Light Editor
Each of the three types has a specific set of parameters that can be edited by the Light 
Editor. Click a type of light for more information:

Distant
Omni 
Spotlight



Distant Light

Light Switch--Turns the light on in the scene. You can turn the light off without losing its 
settings. The Light Switch can be animated
Color--Shows the color of the current light. To change the light color, click the color chip. 
This opens the System Color Picker dialog box, in which you can select a new color. For 
more information about this dialog box, see the User's Guide for your operating system 
software. Color effects for lights work best with the bit depth set to 32-bit color in the 
Window Setup dialog box.
Intensity--Controls the brightness of the light. Change the intensity of a light by typing a
value between -20 and +20 in the numeric field. The higher the number, the brighter the
light. A negative light subtracts light from the scene, making objects darker.
Casts Shadows--When Casts Shadows is selected and Render Shadows is selected in 
the Final Render Setup dialog box, a shadow is calculated for this light. 



Omni Light

Omni Light: Settings
Light Switch--Turns the light on in the scene. You can turn the light off without losing its 
settings. The light switch state can be animated.
Color--Shows the color of the current light. To change the light color, click the Color chip.
This opens the System Color Picker dialog box, in which you can select a new color. For 
more information about this dialog box, see the User's Guide for your operating system 
software. Color effects for lights work best with bit depth set to 32-bit color in the 
Window Setup dialog box. 
Intensity--Controls the brightness of the light. Change the intensity of a light by typing a
value between -20 and +20 in the numeric field. The higher the number, the brighter the
light. A negative light removes light from the scene, making objects darker.
Use Fall Off--Enables the use of the Fall Off distance.
Fall Off--This is the distance at which the light is at half intensity. The light intensity 
continues to decrease as the distance increases. 



Spotlight

Spotlight: Basics
Spotlights have a number of attributes. The Basics options set these spotlight attributes:
Light Switch--Turns the light on in the scene. The Light Switch state can be animated. 
You can turn the light off without losing its settings. Turn off lights to speed up test 
renders.
Color--Shows the color of the current light. To change the light color, click the Color chip.
This opens the System Color Picker dialog box, in which you can select a new color. For 
more information about this dialog box, see the User's Guide for your operating system 
software. Color effects for lights work best in 32-bit depth. 
Intensity--Controls the brightness of the light. Change the intensity of a light by typing a
value between -20 and +20 in the numeric field. The higher the number, the brighter the
light. A negative value removes light from the scene.
Use Fall Off--When checked, the Fall Off distance is calculated.
Fall Off--The distance over which the light loses half of its value. The distance is 
measured in model units. 
Cone Angle--The angle of the light and dust cones. (Set the radius for the cones on the 
Dust page.) The maximum angle is 50 degrees (plus or minus 25 degrees around the 
light's axis.) A slider value of 0 creates a cone angle of 0 degrees. A slider value of 1.0 
creates a maximum cone angle of 50 degrees.
Cone Fuzziness--The percentage of the cone of light that is softened or fuzzed. A value 
of 0.5 softens half of the radius of the cone from the outer edge inward. A value of 1 
softens the whole cone of light.
Casts Shadows--When Casts Shadows is selected and Render Shadows is selected in 
the Final Render Setup dialog box, a shadow is calculated for this light. 

Spotlight: Dust Cone
Spotlights can also create effects such as dust and glows. The options on the Dust Cone 
page create these effects:
Dustiness--Sets the overall intensity of the glowing dust.
Keep Dustiness rather low in most cases. This is the number of particles which reflect 
light, and too many particles can overwhelm the scene.
Use Fall Off--When checked, the dust cone's Fall Off distance is calculated.
Fall Off--The distance over which the dust cone loses half of its value. The distance is 
measured in model units. 
Starting Radius--Sets the radius of the light cone, which determines the size of the 
light and dust cones. Set the angle for the cones on the Basics page. 
Dust Turbulence--Gives an uneven and smoky character to the dust.
Turbulence Scale--Determines how dispersed or thick the dust is in the air. With a high 



number it is possible to make dust clouds.
Turbulence Offset--Sets the relative amounts of dust and empty space.
Dust shadows--When this checkbox is checked, shadows for the dust are rendered. 
Dust shadows increase rendering time.



World

Shortcut:Control+B
Shows and hides the World browser, which gives you access to all objects in every other 
browser. The World browser provides a schematic look at the relationship of objects to 
each other and is organized according to those hierarchical levels. 
At the highest level in the scene hierarchy, the World browser displays the name of the 
original parent object (the world) and below it the list of categories of elements in the 
scene: Objects, Views, Materials, and Lights. Each of these categories is associated with 
one of the browsers.
By double-clicking the names of objects in the World browser, you can move up and 
down in the scene's hierarchy. Double clicking the name of a category displays the list of 
parent objects or elements in that category. Double-clicking the name of a parent object 
or element displays a list of its children and its properties. To get more information about 
any object or element, select it in the World browser and choose Get Info from the Edit 
menu. The browser associated with that object or element's category opens with the 
object or element selected. For example, if you choose Get Info when a light is selected, 
the Lights browser opens with information on that light.
Clicking a name selects the object or element. When an object or element is selected, 
you can edit its name by typing a new name in the text field at the bottom of the 
browser and pressing Tab or Enter. 
Note: You cannot edit the category names: Objects, Views, Materials, or Lights.
Double-clicking the name of a child object in the list moves that object to the top of the 
hierarchy; the names of its children and properties now appear in the child list. If an 
object has no children, nothing is listed. When you have reached the bottom of a specific 
hierarchy, double-clicking once again displays that object's parent at the top; the child 
entry is displayed in the child list with its siblings.
Tip: It's a good idea to use a consistent convention for naming objects. For 
example, you might name a selection of chair styles Chair 1, Chair 2, and so on. You 
could then use the Find command with Add to Selection to select all your chair models at 
one time.
Use the Left arrow key to navigate to the object's parent. The Right arrow key navigates 
to the object's first child. The Up and Down arrows navigate through the current list.
When a parent object appears at the top of the browser, you can add to its list of children
by pasting an object from the Clipboard. When you attempt to paste an object or 
element that does not belong in the current browser--materials into the View category, 
for example--Extreme 3D beeps and does not execute the command.
When a child object is selected, you can cut, copy, duplicate, and clear selected objects 
in the child list, or drag an object to change its position in the list. All changes appear in 
the corresponding Objects, Lights, Materials, or Views browser.



Layers 

Shortcut:Shift+Control+L
Shows and hides the Layers browser, which lets you assign objects to layers and then 
quickly hide, show, and select the objects in those layers. This is useful for managing 
large scenes--you can show only the group of objects you are working on. The current 
layer has an asterisk (*) next to its name. When new objects are created they are 
automatically assigned to the current layer. 

Layers
To create a new layer, click New. A new layer, named layer 2, layer 3, and so on, appears 
in the list. To rename a layer, select it, type in a new name in the text field, and press 
Enter. To make any layer the current layer, select it and click Current, or double-click the 
layer name. 
To delete a layer, select the layer name and click Delete. Any object assigned to that 
layer is then assigned to the current layer. You cannot delete the current layer.
When you click Hide, all the objects in that layer are set to invisible and disappear in the 
workspace. Click Show to make all the objects in a layer visible. Objects can be made 
visible on an individual basis by clicking the Visible checkbox on that object's Info page in
the Objects browser.

Objects
In the workspace, select the object. In the Layers browser, select the layer that it will 
belong to and click Move. 
Note: Child objects are not automatically assigned to their parent's layer. Press F3 
while clicking Move to move the children to a new layer along with the parent.
To select all the objects in a layer, click Select. After selecting the layer, you make 
changes to the whole layer by cutting or copying the objects, nudging them, applying 
materials, and so on.
Note: To affect the objects in the workspace (for example, cutting or nudging) you 
must make the workspace rather than the Layers browser active by clicking one of the 
selected objects, then performing the action. Don't click off of the selected objects or the
entire layer will be deselected.



Watch Links

Opens the Watch Links dialog box, which contains a list of all the watch links created with
the watch link tool. Use it to unlink the watch link relationships between objects. 
The list items appear in the form Object1 -> Object2, where Object1 is the name of the 
watcher object, and Object2 is the name of the watched object. Click a list item to select 
it. This also selects the two watch-linked objects in the workspace. 

Delete
Click Delete to remove the currently selected watch link from the list. 



Show Tool Space

Displays the tool space. The tool space displays the editable fields of information that are
needed by the current command or tool. 



Show Status Bar

Turns on and off the context-sensitive help bar at the bottom of the screen.



Scenes

Shortcuts: Press Control+F6 or Control+Tab to view the next open scene. Press 
Shift+Control+F6 or Shift+Control+Tab to view the previous open scene.
Displays the names of open scene files on the Scenes submenu. A checkmark indicates 
the active scene. Up to four scenes can be open at once. 



Tool palette

    Related topics: Tool preferences
Cursor feedback
Status bar for tools
Tool space

Click a tool in the illustration for more information.

The Extreme 3D tool palette contains tools you can use to create and modify profiles and
3D geometry, and to adjust your view of the scene. Select a tool by clicking it in the tool 
palette.

A shaded notch in the lower right corner of a tool indicates that the tool is one of a group
of tools that perform related functions. When you click and hold one of these tools, the 
tool group pops out.

The arrow tool is the default tool. It automatically becomes the selected tool again after 
you finish using any tool. You can make any tool the default tool by pressing a modifier 
key and clicking the tool.

To make a tool the default tool, Press F3 and select the tool.

Tip:    You can make the last selected tool the default tool by checking the All Tools Sticky
option in the Preferences dialog box.



The entire tool group pops out when you click and hold the hand tool on the tool palette.



Tool preferences

Some tools have dialog boxes for setting tool preferences. These tools are identified by a 
white notch in the lower left corner.

Open the dialog box by double-clicking the tool. For information about preferences for 
specific tools, see the help topic for that tool.



 



Cursor feedback (tools)

Unless otherwise noted, Extreme 3D uses the arrow cursor for selection, the cross-
hair cursor for point placement, and the modified cross-hair cursor for reference 
point placement. 
In addition, many Extreme 3D tools have custom cursors that show you what tool you're 
currently using and prompt you through various steps in using the tool. Most Extreme 3D
cursors provide feedback to show you what type of object the "hot spot," or selection 
area, is currently over. 
When the cursor is over a profile, such as an ellipse or polyline that has not been 
extruded, a hollow dot appears next to the cursor.
When the cursor is over 3D geometry, a solid dot appears next to the cursor.
When using Extreme 3D's tools where profiles and objects overlap, the cursor feedback 
helps you to determine which type of object or control point you're about to select.
Any tool that begins a process that takes longer than five seconds to complete displays 
the hourglass during wait time. Tools that have special state cursors are noted in the tool
descriptions in Extreme 3D Help. 



    



    



    



    



    



Status bar for tools

The status bar help at the bottom of the screen gives you information about using 
Extreme 3D tools, menu items, and controls. When the cursor is over a tool in the tool 
palette, the status bar displays the name of the tool. When a tool is selected and the 
cursor is in the workspace, the status bar tells you how to use the tool. If there are 
several steps involved in using a tool, the status bar displays each step in succession--
when you complete one step, the next is displayed.
Use Show Status Bar in the Window menu to turn the status bar on or off. 



Tool space

When you select a tool, the tool space above the status bar displays information about 
that tool. For most tools, the space displays numerical data for the tool. If you have not 
used the tool previously during the current session, Extreme 3D displays default values 
in the tool space; otherwise the last values used appear.
You can define an object by typing values in the editable fields in the tool space and 
pressing Enter. When you press Enter without modifying the values in the tool space, 
Extreme 3D applies the current values. 
Fields in the tool space are separated by vertical lines.
Note: When using the spline and polyline tools, which allow multiple values to be 
entered, press Enter after entering the values for each segment. Press Shift-Enter to 
terminate the process. 
Move between editable fields in the tool space by pressing the Tab key, or press Shift-Tab 
to move backward.
The information displayed in the tool space depends on the selected tool. For information
on using the tool space with a specific tool, refer to the section on that tool in Extreme 
3D Help.



 Center-corner toggle
At the bottom of the tool palette is the center-corner toggle, which modifies how several 
tools operate.

When the toggle is set to center, the first point establishes the center, and dragging 
the cursor sizes the object about that center. 

When the toggle is set to corner, the first point is locked down, and dragging the 
cursor sizes the object's bounds from corner to corner.

If the operation of a tool can be modified using the center-corner toggle, that fact is 
noted in the description of the tool in Extreme 3D Help. 



 Arrow tool 
Related topics: Selecting hidden objects

Opening and editing an object
Moving objects
Rotating objects
Nudging objects
Scaling objects
Arrow Tool Preferences

The arrow tool selects, opens, closes, edits, and moves objects. Select multiple objects 
by holding the Shift key while using the arrow tool or by drawing a marquee around the 
objects. 
Each object, when selected with the arrow tool, is enclosed in a red bounding box. The 
axis, located at the object's center, is labeled with a tick mark at the ends of the x and y 
axes. Only positive directions are indicated. You cannot snap onto the bounding box or 
the axis.
The object's coordinate axis is displayed by default. The Preferences dialog box has an 
option for enabling and disabling this feature. You can disable the axes only for the 
workspace as a whole, not on a per-object basis. 
 The object axis indicates the orientation of the object.
Tool space: When the arrow tool is selected, the numbers in the tool space show the 
cursor's position in the workspace. The coordinates represent locations in the world.
In the default view, the origin (0,0,0) is at the center of the screen. Units shown are those
selected in the Units dialog box. As the arrow tool moves over 3D objects, the tool space 
shows the coordinates of the 3D geometry that the tool will snap to at that point. 



Selecting hidden objects

Objects that are hidden or that do not appear in the current view can be selected by 
name in the World browser or by using the Find command on the Edit menu.



Opening and editing an object 

To edit an object--that is, to change the shape of its underlying defining geometry--an 
object must be open. To open an object, double-click it or choose Open Geometry from 
the Object menu.
An open object displays the control points and lines that define its geometry. 

To close an object, double-click it or choose Close Geometry from the Object menu. A closed 
object can be moved, scaled, rotated, and modified with the deformation tools, but its shape
cannot be edited.



This 3D object is open for editing. Moving the control points changes the shape of the object.



Moving objects 

Related topics: Nudging objects
When you drag selected objects, Extreme 3D always moves them parallel to the current 
working plane and indicates where they are being moved by placing the object's 
bounding box in the new location before redrawing the object.



Rotating objects 

Use the arrow tool to rotate an object around its center. You can move the center of the 
object using the move object center tool in the control point tool group. To rotate an 
object in the workspace, select the object with the arrow tool and drag it in the desired 
direction while pressing a modifier key. 
To rotate an object: 

Around x and y only, press F4 while dragging the object
Around y and z only, press F3 while dragging the object.

To constrain rotation to a specific axis, lock the orientation of the other two axes in the 
Objects browser.



Nudging objects

Related topic: Moving objects
Use the arrow keys on the keyboard to nudge objects--move, scale, and rotate them by 
specified increments. 
To nudge an object's position, select the object and press an arrow key. 
To nudge an object's scale, press F2 while nudging the object with the Up and Down 
arrow keys.
To nudge an object's rotation: 

Around its x axis only (pitch), press F4 and the Up and Down arrow keys.
Around its y axis only (yaw), press F3 or F4 and the Left and Right arrow keys.
Around its z axis only (roll), press F3 and the Up and Down arrow keys.

The Preferences dialog box lets you set increments for nudging.
The units for the Nudge Position and Nudge Scale fields are determined by the options in 
the Units dialog box. The unit for Nudge Angle (orientation) is degrees. 



Scaling objects

Use the arrow tool and the F2 key to scale objects. When the object is scaled, it grows or 
shrinks around its center point. 



Arrow Tool Preferences

Use the options in the Arrow Tool Preferences dialog box to select the planes within which
you can drag surface control points and tangent points when editing. Constraining these 
points to specific planes gives you increased control when editing objects.
Double-click the arrow tool to open the Arrow Tool Preferences dialog box.

Move Surface Relative To:
Surface Tangents--This option applies only when you are editing a point's surface 

tangents on an open object. Otherwise, Bounding Box to View is used.
The points move in the plane defined by the point being moved and the line normal 
to the surface. To visualize this, imagine a plane that touches the object only at the 
point you are editing. The surface tangents option allow you to move the point only 
within that plane. This is useful when you want to edit an irregular point on an 
object--for example, to edit the bump and not the log.
Bounding Box to View--When you select an object you'll see its bounding box. The 

face of the bounding box that is most nearly parallel to the screen defines the plane in which
control points move when this option is selected. This is the default option, and is suitable in 
most cases. 

Working Plane--With this option on, the points move only within a plane that is 
parallel to the working plane.

By manipulating the working plane, you can easily pull points along any arbitrary axis or 
plane using this option.
Note: The point being edited will stay on the plane established by any of these arrow
tool preferences. However, dragging while 3D snapping is in effect can cause the point to
move off the established plane.



View tool group

Related topic: View Tool Preferences
Click a tool to see more information about it:

This tool group consists of the hand and rotation tools. Use these tools to set the position 
and orientation of the current view. This lets you move around the scene and see it from any
position in three-dimensional space. All of the tools in this group use the hand cursor.

Note: If the camera is watch linked to an object (where the object is the parent), it 
cannot rotate independently, so it is not possible to rotate the camera's view.



View Tool Preferences

Options in the View Tool Preferences dialog box let you specify the center of rotation and 
scale for view changes. This option applies to all of the tools in the view tool group. 
Double-click any of the view tools to open the View Preferences dialog box.

Rotate and Scale View Relative To:
Look-at Point--The view rotates and scales around its own center point. This is the 

default.
Center of Selected Objects--The view rotates and scales around the center of the 

bounding box of the selected object. If no object is selected, the view rotates and scales 
around its center point. If multiple objects are selected, the view rotates and scales around 
the center of a bounding box that surrounds all of the selected objects.

Eye Point--The view rotates and scales around its eye point. The eye point can be 
thought of as the origin of the view--the position in the world of the camera or the viewer 
that is looking at the scene. 



 Hand tool
Moves the view's position along the screen. How this movement affects the coordinates 
in the Views browser depends on the orientation of the view.
To move the view's position, select the hand tool and drag the workspace in the desired 
direction. As you drag, the view moves and all objects in the scene move as well. 

Rotating the view
To rotate the view:

Around the x and y screen axes, press F4 while dragging in the workspace with the 
hand tool.

Rotate the view around the y and z screen axes, press F3 while dragging in the 
workspace with the hand tool.

Scaling the view
To scale the view, click and drag with the hand tool while pressing F2. When a view is 
scaled, it grows or shrinks around its center point or according to the current preference 
setting.
Note: Dragging while pressing the N key moves the camera view along the working 
plane's z axis.



 X-, Y-, and Z-rotation tools
Rotate the current view around the x, y, or z axis of the screen. Each of these rotations is
performed as an exact view change around a single axis without affecting the scale or 
perspective of the view. 

 The x-rotation tool -- Performs a pitch (rotates view around the x axis).
 The y-rotation tool -- Performs a yaw (rotates the view around the y axis).
 The z-rotation tool -- Performs a roll (rotates the view around the z axis).



Placement tool group 

Click a tool to see information about it:

The placement tool group consists of the rotate point tool, the rotate axis tool, and the 
placement tool. These tools allow you to rotate and place an object with great precision.



 Rotate point tool
Rotates an object around a specified point. 

To rotate an object around a point:
1 Define the center of rotation.

Click to define the point around which the object will rotate.

2 Click a point on the object that you want to use as a handle for rotating the 
object.

3 Drag the handle point around the center of rotation. 

Tool space: You can also enter rotation values in the tool space to rotate a precise 
number of degrees. To do this, click to define the point around which the object will 
rotate. Then type the number of degrees of rotation in the tool space and press Enter.
Tip: This tool can be particularly useful when the center of rotation is snapped to a 
construction line.



The object rotates around the defined center of rotation.



 Rotate axis tool
Rotates an object around an axis in 3D space. 

To rotate an object around an axis:
1 Define the axis. 

Click to define the axis start point. Click again to define the end point.

2 Click a point on the object that you want to use as a handle for rotating the 
object.

3 Drag the handle to rotate the object around the defined axis.
The object rotates around the axis you defined.

Tool space: You can also enter rotation values in the tool space to rotate a specific 
number of degrees.
Tip: This tool can be particularly useful when the axis is snapped to a construction 
line.







 Placement tool
Places an object precisely in relation to another object by connecting the objects at two 
points, then rotating one object around the axis that the two points form. 

To place an object:
1 Click a point on the first object that will coincide with the second object and

drag it to the target point on the second object.
After the object snaps into place, the point becomes a pivot around which the object 
can rotate.

2 Click and drag a second point on the first object to a second point on the 
target object.
The two points form an axis around which the first object can rotate. After you move 
the first object away, the object's edge remains aligned to the axis on the second 
object.

3 If you want, rotate the first object around the axis by clicking and dragging 
the first object.

Tip: This tool is easiest to use if you set up the objects and view so that you can 
see both faces of the objects.









 Zoom tool
Changes the scale of the current view so you can zoom in to a part of an object or zoom 
out to view an entire scene. By zooming in, you can edit and align objects very precisely. 
By zooming out, you can set up a view to render or you can preview and position objects 
in relation to each other. This tool uses the magnifying glass cursor.

To zoom in on a particular portion of the view:
Select the zoom tool and drag a rectangle around the area you want to see 

more closely. 
The center of the rectangle becomes the new look-at point, and the view changes to 
fit the contents of the rectangle on the screen.

To zoom in to a particular point in a view:
Click that point with the zoom tool. 
That point becomes the new look-at point, and the view is scaled by the scale factor 
displayed in the tool space.

To zoom out:
Press F3 while zooming.

Tool space: While you drag the zoom rectangle, the current zoom scale appears in the 
tool space. The value is expressed as the number of times that you want the view to 
increase or decrease in scale. 
To zoom in or zoom out by a factor, type a zoom factor into the tool space. For example, 
to double the current view scale, type 2 in the tool space. To zoom out by 50 percent, 
type 0.5 in the tool space.
Note: Zooming can also be controlled in the Scale field of the Views browser. 
Zooming in on a very small area from a very large view can result in the object not being 
displayed on the screen. This happens when the view zooms in past the plane that the 
object is on. Choose Fit to Window from the View menu to see all visible objects in the 
workspace.



 Working plane tool
Reorients the working plane. 
There is only one working plane in Extreme 3D. It serves as a grid for drawing and 
moving objects. All profiles and objects are drawn and moved relative to the working 
plane. Like a drafting table, the working plane is flat, but it can be moved and rotated 
using the arrow tool. Although the working plane behaves as if its dimensions are infinite,
it appears as a finite visible grid when displayed on the screen. The measurements of the
working plane grid are determined in the Units dialog box. Several tools in the tool 
palette use the coordinates of this grid.
The horizontal and vertical coordinates of the working plane are labeled h and v. These 
correspond to the H and V modifier keys, which constrain the movement or placement of 
a point or object to the horizontal or vertical coordinates of the working plane. In 
snapping, if Extreme 3D fails to find a snap location within the hit radius, objects snap to 
the working plane.

To reorient the current working plane: 
1 If it isn't already showing, make the working plane visible by choosing Show

Working Plane from the Object menu. 
2 Select the working plane tool and define the origin (center) of the working 

plane by clicking once.
3 Define the x axis (horizontal direction) of the working plane by clicking a 

second time.
4 Define the y axis (vertical direction) of the working plane by clicking a third

time on a point that's included in the plane. 
The surface defined by the three clicks is the new working plane. 

To align the working plane to an object:
Press the O (not zero) key while clicking the object. 

Tool space: When the arrow tool is not over an object in the workspace, the tool space 
coordinates identify the working plane's location under the arrow tool. In the default 
view, the origin of the working plane (0,0,0) is at the center of the screen.
Note: If Auto Working Plane To View option on the Object menu is enabled, the 
working plane always shifts to face you directly when you change the view. 





Construction geometry tool group

Click a tool to see information about it:

This tool group consists of the four types of construction geometry: construction point, 
construction line, construction axis, and construction grid. Use these tools to create 
construction geometry--frameworks that provide visual references, like scaffolding, for your 
scene. 
Construction geometry remains on the screen and can be moved or rotated with the arrow 
tool like any other object. 2D and 3D objects can snap to construction geometry. 
Construction geometry does not appear in final renders. 

To make construction geometry objects invisible and visible as you work: 
Use the Hide and Show commands on the Object menu. 

To permanently remove construction geometry in the workspace: 
Choose Clear Construction Objects from the Object menu.



 Construction point tool
Places a reference point in the workspace. Objects can snap to this point. 

To place a construction point:
Select the construction point tool and click once in the workspace. 
You can move the construction point using the arrow tool.



These construction points were placed in the workspace, then used as reference points for 
drawing the spline curve.



 Construction line tool
Places a construction line in the workspace. A construction line can be snapped to or 
used as a visual reference.

To place a construction line:
1 Select the construction line tool. 
2 Click once to place the center of the line, then drag the line around its 

center point. 
You can move, rotate, and scale the construction line using the arrow tool.



 Construction axis tool
Creates a three-axis construction object to align and orient objects.

To create a construction axis: 
Select the construction axis tool and click to define the center of the 

construction axis. 
If you click directly on an object with the construction axis tool, the construction axis is 
oriented to that object. 
To place the axis at the origin (0, 0, 0) in the world, press Enter after selecting the tool.

Tip: When animating, you can attach a watch link between the camera and a 
construction axis in the scene. The camera will then watch the construction axis as it 
changes position. For more information, see the Watch link tool help topic.





 Construction grid tool
Creates a reference grid. Each point and line on the grid can be snapped to or used as a 
visual reference. You can move and rotate a construction grid using the arrow tool or 
hand tool. Units on the grid are set in the Units dialog box.

To create a grid:
1 Select the construction grid tool and click where you want the origin of the 

grid to be. 
2 Drag the grid to the desired size. 

To create a grid parallel to an object's surface:
Press the Snap to Object (O) key while placing the construction grid.
The Snap to Object key causes the grid to snap to 3D geometry and assume the 
orientation of the object you are snapping to.

Center-corner toggle: When the corner toggle is set, you can draw the construction 
grid from the perimeter.
Tool space: When the construction grid tool is selected, the tool space displays the 
width and height of the construction grid. Change the dimensions of the construction grid
by tabbing to the numeric fields, typing new numbers, and pressing Enter. These 
numbers you type in will be rounded to the nearest grid division for the unit of 
measurement specified in the Units dialog box.





 Text tool
Click for more information: Text Tool Preferences
Creates profiles of characters and words that can be extruded to form 3D objects. 
Extreme 3D extracts the TrueType and Adobe Type 1 font outlines to form the letters. 
The text tool uses the text insertion cursor.

To create a character or line of text:
1 Select the text tool and click the point in the workspace where you want to 

place the lower left corner of the first character. 
2 Type the text in the tool space. Press Enter when you've finished.

You can type up to 63 characters at a time. 
Once the letters have been created, you can edit them like any other spline or polyline 
object. Select the first character to move or manipulate the entire line of text. (The 
second and subsequent characters are free linked to the first character.) Select individual
characters to edit them as individual objects. Use the unlink tool to unlink a character 
from the line of text. 
Note: When you perform a 3D geometry operation on linked text profiles, links are 
discarded.
Tool space: When the text tool is selected, the tool space text entry area is used to 
enter the desired text.



Text Tool Preferences

Double-click the text tool to open the Text Tool Preferences dialog box, where you can set
the font and size of text. 
From the Font pop-up you can choose any of the available TrueType and Adobe Type 1 
fonts in your system. To change the font size, enter a number in the Size field. It uses the
units set in the Units dialog box, not points. The default text size is 1 inch tall.
You can also import text from a DXF, FreeHand, or PICT    file if you select the Import Text 
option in the Preferences dialog box.



 Polyline tool
Creates open or closed polygons. A polyline in Extreme 3D is a line that has more than 
two points. Polylines can be used alone or combined with other profiles to create 
complex models. A polyline can also be used to create a path for a sweep object. For 
more information, see the Sweep tool help topic.

To draw a polyline:
1 Select the Polyline tool and click to define its points. 
2 Double-click to complete the polyline.

To create a closed polyline shape, complete the object by double-clicking the start 
point.

Tip: You can also use the polyline tool to create smooth, predictable 3D spline 
curves. To do so, approximate the shape of the curve with the polyline tool, then use the 
Smooth Polylines command on the Object menu to make it into a spline.
Tool space: When the polyline tool is selected, type the angle and length of the next 
line segment and press Enter to draw that segment. Press Shift-Enter to terminate the 
process. 
Angle is expressed in degrees; length is expressed in the units set in the Units dialog 
box.



 Line tool
Draws a line on the current working plane. A line in Extreme 3D has two points. To draw 
lines with more than two points, use the polyline tool. To draw curves, use the spline tool.
Lines can be used alone or combined with other profiles to create complex models. A line
can also be used to create a path for a sweep object. For more information, see the    
Sweep tool help topic.

To draw a line:
Select the line tool and drag in the workspace. 
Alternatively, click to define the start point and click again to define the end point. 
Extreme 3D draws the line between the defined points.

Tool space: When the line tool is selected, the tool space displays editable fields for the 
angle and length of the line. 
To define a line in the tool space, click to specify the start point, enter the length and 
angle of the line, and press Enter.
Angle is expressed in degrees; length is expressed in the units set in the Units dialog 
box.



 Spline tool
Creates open or closed splines on the working plane. A spline in Extreme 3D is a Bezier 
curve. You can use a spline as part of a profile or use it to create a path for a sweep 
object. For more information, see the    Sweep tool help topic.
You can also use a spline as an animation motion path. See the Animation Path submenu 
help topic for more information.

To create a spline: 
1 Select the spline tool, click to define the start point of the spline, then drag

to define the tangent for the point. 
2 Continue to click and drag to add new control points and tangent lines to 

the spline curve.
3 Double-click to finish drawing the spline. 

Double-clicking does not automatically close the spline curve. To make a closed spline
curve, double-click on top of the first point.

You can also click points in the workspace and let Extreme 3D automatically define the 
tangent lines. Tangent lines can be adjusted after creating the spline. To do so, double-
click the finished spline to open it, then click any point on the spline to display its 
tangent.
Tool space: When the spline tool is selected, type the angle and length of that segment 
of the spline, then type the angle and length of that segment's tangent point. Press Enter
to draw the segment. Press Shift-Enter to terminate the process. 
Angle is expressed in degrees counterclockwise from the horizontal on the current 
working plane; length is expressed in the units set in the Units dialog box. 
Modifier keys: Press F3 while clicking a point on a spline to set the tangent line for the 
next point, which you can define by dragging and releasing. This allows you to create a 
control point with a sharp corner. This only works when creating a spline, not when 
editing an existing spline.

While editing a spline, press the B (break tangent) key while dragging a tangent point to 
move it independently, producing a discontinuity on the spline. This is especially useful 
for creating discontinuities in the animation position path in the workspace.



 
An unmodified control point and tangent line of a spline.

A tangent line that has been broken with a modifier key, giving the spline a sharp corner.



Arc tool group

Click a tool for more information: 

 
The arc tool group consists of the center arc tool and the tangent arc tool. Use these tools to
create curved line segments on the current working plane. Use these objects as part of a 
profile or as a basis for 3D objects.



 Center arc tool
Draws an arc profile by specifying its center and radius. 

To create a center arc:
1 Select the center arc tool.
2 Click to define the center of the arc and drag the radius. 
3 Click and drag again to define the portion of the arc you wish to create 

(included angle).
Alternatively, you can select the tool and then click to define the center, start, and end 
points of the arc.

Tool space: When the center arc tool is selected, the tool space displays editable fields 
for the Radius, the Start Angle, and Included Angle of the arc. To define a center arc 
using the tool space, click to specify the center point for the arc, then type the values 
and press Enter. 



1. First click defines the arc's center.
2. Second click defines the arc's radius.
3. Third click defines the size of the arc in degrees.
4. Release the mouse to complete the arc.



 Tangent arc tool
Draws an arc profile by specifying the line to which it is tangent. 

To create a tangent arc: 
1 Select the tangent arc tool.
2 Click to define the starting point of the arc.
3 Then drag a line to which the arc will be tangent. 
4 Finally, drag to define the arc's end point. 

Tool space: When the tangent arc tool is selected, the tool space displays editable fields
for the tangent angle, the chord angle, and the chord length. To define a tangent arc 
using the tool space, click to specify the origin of the arc, then type in the values and 
press Enter. 



1. First click defines the arc's starting point.
2. Second click defines the arc's tangent.
3. Third click defines the arc's end point and completes the arc.



 Regular polygon tool
Creates regular polygons. A regular polygon is a profile of three or more sides, all of 
equal length.

To create a polygon: 
1 Select the polygon tool and click to define the object's center. 
2 Set the number of sides in the tool space. 
3 Drag away from the center to define the object's perimeter.

Tool space: The polygon's radius and number of sides are set in the tool space. The 
default is six sides. You can set up to 256 sides.
Center-corner toggle: When the corner toggle is set, clicking or clicking and dragging 
defines a rectangle that describes the bounding box of the polygon.



Rectangle tool group 

Click a tool for more information:

The rectangle tool group consists of the rectangle tool and the square tool, which allow you 
to create rectangular and square profiles.



 Rectangle tool
Creates rectangular profiles. When you've made a rectangle, you can use it as a basis for
3D objects, or use the profile modifier tools to make a compound profile.

To make a rectangle: 
Select the rectangle tool and click to define a center point of the profile, 

then drag away from the center point to define its size.
You can independently control both the width and height of the profile.

Tool space: When the rectangle tool is selected, the tool space displays editable fields 
for the width and height of the object. To define a rectangle using the tool space, click to 
specify the start point, type the width and height of the rectangle and press Enter.
Center-corner toggle: With the corner toggle set, click to define the starting corner of 
the object, then drag to the opposite corner.



 Square tool
Creates square profiles. When you've made a square, you can use it as a basis for 3D 
objects, or use the profile modifier tools to make a compound profile.

To make a square: 
Select the square tool and click to define a center point of the profile, then 

drag away from the center point to define its size.
Tool space: When the square tool is selected, the tool space displays an editable field 
for the width of the object. To define a square using the tool space, click to specify the 
start point, type the width of the square and press Enter.
Center-corner toggle: With the corner toggle set, click to define the starting corner of 
the object, then drag to the opposite corner.



Circle tool group

Click a tool for more information:

 
The circle tool group consists of the circle and ellipse tools.



 Circle tool
Creates circular profiles. Once you've made a circle, you can use it to make more 
complex objects.

To create a circle:
Choose the circle tool from the tool palette and drag in the workspace to 

create the profile. 
You can also click to define the center point and click a second point to set the radius.

Tool space: The tool space displays the radius of the circle. To define a circle using the 
tool space, click once to define the starting point and then type the radius in the tool 
space. Press Enter to set the value in the tool space and draw the circle.
Center-corner toggle: With the corner toggle set, click a point on the perimeter of the 
circle and click or drag to create the opposite side. 



 Ellipse tool
Creates elliptical profiles. Once you've made an ellipse, you can use it to make more 
complex objects.

To create an ellipse:
Choose the ellipse tool from the tool palette and drag in the workspace to 

create the profile. 
You can also click to define the center point and click a second point to set the radius.
The two clicks define the center and corner of the rectangle that bounds the ellipse.

Tool space: The tool space displays the width and height of the ellipse. To define an 
ellipse using the tool space, type the width and height of the ellipse and press Enter.

Center-corner toggle: With the corner toggle set, click a point on the perimeter of the 
ellipse and click or drag to create the opposite side. 



Materials application tool group 

Click a tool for more information:

 
The materials application tool group consists of the bucket tool and the eyedropper tool, 
which let you apply the current material type to 3D geometry and pick up a material from a 
piece of geometry, making it the current material.



 Paint bucket tool
Applies the current material to any object you select. For example, if you create a 
material called Aluminum, you can set selected objects to have those material 
properties. The paint bucket tool uses the paint bucket cursor.

To apply the current material to an object:
Click the object with the paint bucket tool. 

To apply the current material to several objects:
Drag a marquee around the objects to select them and then click one of the

selected objects with the paint bucket tool.

To apply a material to an object and all the child objects in its hierarchy:
Press the F2 key while clicking the parent object.



 Eyedropper tool
Picks up the material on an object and makes it the current material. When you create 
3D geometry, it automatically uses the current material. The eyedropper tool uses the 
eyedropper cursor. 

To copy an object's material attributes:
Select the eyedropper tool and click the object whose material you want to 

copy.
That object's material becomes the current material. It can then be applied to other 
objects using the bucket tool or the Apply button in the Materials browser.



Texture map tool group 

Related topic:    Placing a texture map
Click a tool for more information:

 
The texture map tool group consists of the intrinsic, cylindrical, spherical, and projective 
texture placement tools, and the material orientation tool. These tools define how a texture 
map, which is selected in the Materials browser, is placed on the object. Extreme 3D uses a 
u-v coordinate system to apply a two-dimensional image to a three-dimensional surface. The
u value is the width of the image and the v value is the height of the image.



Placing a texture map

All of the texture map placement tools are interactive. You can experiment with the exact
placement by releasing the mouse and adjusting the placement of the tool. The new 
position of the texture map updates in the workspace every time you release the mouse. 
The type of tool you use determines the mapping type for the texture map. In general 
you should choose the tool that matches the object type you are mapping onto. (That is, 
use the spherical texture placement tool on spheres, and so on.) Use the intrinsic texture
placement tool for objects that do not map to any of the standard shapes. The mapping 
type appears on the Info page of the Objects browser and can be changed after the map 
is placed. 
Note: To do cubic mapping; use the projective placement tool, then change the 
mapping style to Cubic in the Objects browser.

To place a texture map:
1 Use the Materials browser to assign a texture map to an object.

You may want to hide other objects in the workspace to speed up the screen redraw. 

2 Choose the appropriate texture placement tool and use these modifier keys
to apply the map: 
You can also use the tool space to enter exact values for texture map position and 
orientation. See the individual tool descriptions for more information. 
To specify the starting point of the texture map (except Projective mapping style), 

press F4 while clicking in the workspace
To control the width of coverage (except Projective mapping style), press F3 while 

dragging in the workspace
To scale the texture map, press F2 while dragging in the workspace

3 When you're finished specifying the location of the texture map, press 
Enter or double-click the workspace to complete the placement.

4 Use the material orientation tool to reorient the texture map, if needed. 
To use the material orientation tool to change the orientation of the map, press F3 or 
F4 while dragging in the workspace

5 Press Enter or double-click in the workspace to complete the reorientation.
You can place an intrinsic texture map on an object's end caps only if the end caps 
have been separated. For more information, see the Separate End Caps help topic.



Specifying the starting point

Controlling the width of the texture map

Scaling the texture map



Drag the texture map's orientation axis while pressing the appropriate modifier key to re-
orient the texture map.



 Intrinsic texture placement tool
Calculates the surface of an odd-shaped object and interactively adjusts a texture map to
fit it. Sometimes this is referred to as rubber sheet mapping. You can change the guides 
of the intrinsic texture placement tool interactively to fit a texture map precisely to any 
object.
Tool space: The tool space displays the u and v offset (position) and scale for the 
texture map. To define the placement of the texture map using the tool space, press Tab 
to move to the tool space, then enter the values and click OK.



 Cylindrical texture placement tool 
Calculates the surface of a cylindrical object so you can interactively adjust any texture 
map to fit it.
Tool space: The tool space displays the starting angle (the position where the texture 
map should begin on the surface), the angle (the amount of the surface that will be 
covered by the texture map), and the v offset and scale (the vertical position and size of 
the texture map). To define the placement of the texture map using the tool space, press 
Tab to move to the tool space, then enter the values and click OK.



 Spherical texture placement tool 
Calculates the surface of a spherical object so you can interactively adjust any texture 
map to fit it.
Tool space: The tool space displays the starting angle (the position where the texture 
map should begin on the surface), the angle (the amount of the surface that will be 
covered by the texture map), and the v offset and scale (the vertical position and size of 
the texture map). To define the placement of the texture map using the tool space, press 
Tab to move to the tool space, then enter the values and click OK.



 Projective texture placement tool 
Projects a texture map directly on to the front and through to the back of an object as it 
is oriented to the screen. You can change the guides of the projective placement 
interactively to fit a texture map precisely to any object.



 Material orientation tool
Orients the texture map along the surface of an object to guide you in placing the texture
map. Use the material orientation tool to define the x, y, and z axes of the material upon 
the object.
You can also use the material orientation tool to reorient all of the material types, except 
for plastic.
Tool space: The tool space displays the x, y, and z coordinates for the texture map's 
orientation. To define the placement of the texture map using the tool space, press Tab to
move to the tool space, then enter the values and click OK.



Mirror tool group 

Click a tool for more information: 

 
The mirror tool group consists of the 2D and 3D mirror tools and the offset tool.

The mirror tools create mirror images of profiles and 3D geometry, either duplicating 
the object or flipping it across a mirroring plane. 

The offset tool creates a duplicate copy of a profile that is set off from the original by 
the same distance at each point.

Mirror Tool Preferences
Double-click the 2D or 3D mirror tool to open the Mirror Tool Preferences dialog box.
To duplicate an object and mirror it, select Copy Mirrored Objects in the Mirror Tool 
Preferences dialog box. For example, you can create a pair of airplane wings by modeling
one wing and then copying and mirroring it across the body of the airplane. If this option 
is not selected, the object is flipped across the mirroring plane, but not duplicated.



 2D Mirror tool
Creates a copy of a profile or 3D surface that is its mirror image, or flips the profile across
a mirroring plane.

To create a mirrored profile:
1 Select the 2D mirror tool and click the object that you want to mirror. 
2 Click and drag an axis on the current working plane. 

The mirrored profile is flipped across this axis.

By default, the 2D mirror tool creates two objects that mirror one another. To only change
the position of the selected object, without creating a copy of itself, change the option in 
the Mirror Tool Preferences.





 3D Mirror tool
Flips a profile or 3D surface across a mirroring plane, or creates a copy of an object that 
is its mirror image.

To create a mirror image of an object across an arbitrary plane: 
1 Select the 3D mirror tool and select the object.
2 Click three points to establish three corners of the mirror plane.

By default, the 3D mirror tool creates two objects that mirror one another. To change the 
position of the selected object, making it a mirrored image of itself, change the option in 
the Mirror Tool Preferences.





 Offset tool
Creates a copy of a profile and offsets it from the original by the same distance at each 
similar point, like an outline. You can use this tool to offset any profile, whether it's closed
or open.

To offset a profile:
Select the offset tool, then click the profile and drag. 
As you drag away from the profile's center, the offset profile grows. Drag toward the 
profile's center to make the offset smaller.

An offset is different from a scaled duplicate in that the proportions of the shape change 
to maintain a consistent difference from the original profile.
When offsetting splines, extra control points may be added so that the shape of the new 
profile closely matches the original. On some splines an offset can twist acute angles. 
Adjust the tangent handles of the twisted angles after performing the offset.
Tool space: When the offset tool is selected, the tool space displays an editable field for 
the offset distance. To define the offset using the tool space, select the object with the 
offset tool, type the offset value, and press Enter to draw the object. 





Profile modifier tool group

Click a tool for more information:

 
The profile modifier tool group consists of the fillet tool and the 2D trim tool. 

The fillet tool rounds corners on profiles. 
The 2D trim tool lets you cut away parts of profiles.



 Fillet tool 
Rounds corners on profiles by replacing the corners with arcs. You can fillet lines, 
polylines, splines, regular polygons, and rectangles. The fillet tool uses a fillet cursor.

To fillet a corner:
1 Select the fillet tool. 
2 To change the fillet's radius, tab to the tool space and enter a new radius 

before clicking the corners of the object.
By default, Extreme 3D fillets a .25-inch radius. Small objects may require a smaller 
fillet radius.

3 Click one side of the corner where you want the fillet to occur. 
4 Then click the opposite side of the corner.

You can also create a fillet out of two profiles that intersect, such as a line through an 
ellipse.
Note: After filleting, the arc is a separate profile. To reconnect the pieces, use the 
Join Profiles command on the Object menu.
Tool space: When the fillet tool is selected, the tool space displays an editable field for 
the fillet radius.



Filleting the upper right corner of the square produces the smooth corner shown here.



 2D trim tool 
Removes a section of geometry, such as a line segment or a corner, from an object. You 
can then insert and join other geometry into this space to form compound profiles. This is
useful for creating nonstandard profiles for modeling. The 2D trim tool uses the trim 
cursor.

To trim a profile:
1 Select the 2D trim tool and click to define the beginning of the segment to 

be removed. 
2 Click a second time to define the end of the segment to be removed. 

3 Click a third time on the portion of the profile to remove.

To cut the profile into two pieces, press F3 while clicking a point on the object.
Tip: Cutting an object into two pieces can be useful for changing the start and end 
points of a curve.
Note: All clicks must fall on lines within the same object. When trimming a small part
of a 2D object, if it seems to get rid of the part you want to keep, try zooming in.







Control point tool group 

Click a tool for more information:

 
The control point tool group consists of the control point tool and the move object center 
tool.

The control point tool lets you add and remove control points on open or closed 
profiles and simplified 3D geometry. 

The move object center tool lets you move the object center on profiles and 3D 
geometry.



 Control point tool
Adds and removes control points for both profiles and 3D objects. The control point tool 
uses the control point cursor.

To add a control point to an object: 
1 Display the object's defining geometry by choosing Open Geometry from 

the Object menu. 
Some objects must be simplified before the control points are available; select the 
object and choose Simplify Geometry from the Object menu. 

2 Once the control points are displayed, select the control point tool. 
3 Click any place on the object, except where one already exists, to add a 

new control point. 
A new control point appears where you clicked. This control point can be selected and 
dragged like any other control point. 

To add a control point to closed 2D shapes and specify it as the first point on 
the profile:

Press F2 while adding the point.
You can also click an existing point to specify it as the first point.

To delete a control point:
Press the F3 key while clicking an existing control point.



 Move object center tool 
Repositions an object's center point--the point around which the object rotates and is 
scaled, and the point to which the object's parent and children are aligned. The move 
object center tool uses the object center cursor.

To reposition an object's center: 
1 Double-click the object with the arrow tool to open it for editing.

The center of the object is displayed as a small green dot. This step is not required, 
but it is useful so that you can see the center point after moving it.

2 Using the move object center tool, click anywhere on the object and drag to
indicate the new position of the center point.
The center point moves to the location where you released the mouse button.



Surface modifier tool group

Related topic: Trim Preference

Click a tool for more information:

 
The surface modifier tool group consists of the projection, 3D trim, and intersection tools. 

The projection tool projects an image of a profile onto a piece of 3D geometry and 
marks it with trim curves. 

The 3D trim tool lets you cut away pieces of 3D geometry that have been marked 
with trim curves created with the projection and intersection tools. 

The intersection tool marks the intersection of two pieces of geometry with trim 
curves. 



Trim Preferences

The tolerance for trimming is set by double-clicking the 3D trim tool.
All 3D geometry is represented in the workspace as polygonal approximations of a 
surface. The trim tolerance represents the difference in the distance between the actual 
surface and the polygon that represents the surface. The smaller the number, the closer 
the trim will be to the actual surface of the object. 
Tolerance Options:

Use Display Tolerance--Uses the object's interactive smoothing values.
Use Custom Tolerance--Lets you define a custom trim tolerance.

How precise you need the trim tolerance to be is determined by factors such as the 
object's scale or how close it will be to the camera in any given scene or image. 
Trim tolerances are measured in model units. A user-defined value increases the time it 
takes to complete the trim and the number of points in the trim.
Note: Trim curves do not use Final Smoothness Settings.



 Projection tool 
Related topic: Trim Preference

Projects a 2D profile onto the front and back faces of a 3D object. (Both faces of the 
object will have trim curves projected on them.) You can then use the 3D trim tool to cut 
out the projected shapes. 

Setting up the projection
When using the projection tool, make sure the projecting object is placed directly in front 
of the area that you want to project onto. Projection direction is along the normal of the 
object being projected and goes to the object being projected onto. Some perspective 
settings may make it difficult to determine whether the profile is positioned correctly.
The easiest way to set up a projection is to change your perspective to Orthographic. In 
Orthographic view, you view the objects without a sense of perspective, so it is easy to 
see how one object will project a shape onto another.

When you place the object that will be projected over the target object, the projecting object
remains visible when deselected as long as it is in front of the target object. Otherwise, it 
disappears behind or inside the other object when it is deselected. 

To perform a projection:
1 Once the projection profile is properly positioned, choose the projection 

tool.
2 Select the 2D projection profile. 
3 Press F3 and drag to set the direction of the projection (optional).

By default, the direction of the projection is along the Z axis of the projected object. 
You can override this default and define a new direction of projection by drag-clicking 
two points. In most cases, the working plane, the projected object, and the object 
onto which the profile is projected are all parallel, so the default direction of 
projection is not obvious. When the projected object is rotated slightly, it is clearer 
that it is projecting along its Z axis. 

4 Select the target object. 
Extreme 3D places an outline of the projected image (the trim curve) onto the front 
and back faces of the object. Use the 3D trim tool to cut away an area marked by the 
trim curve. You may need to move the original profile out of the way to see the trim 
curve, which is blue when it is deselected. Trim curves cannot be edited, moved, or 
smoothed. 

Note: Projecting and trimming cannot be performed on end caps because they are 
already trimmed surfaces. You must separate the object's end caps in order to use these 
commands on them. To do so, select the object and choose Separate End Caps from the 
Object menu.

Creating 3D geometry with trim curves
After projecting a trim curve, you can turn it into a regular polyline profile by simplifying 
it. Once a trim curve is simplified, it is no longer a trim curve. 



To simplify it, select it and choose Simplify Geometry from the Object menu. You can 
then, edit it, extrude it, and create other 3D geometry from it. This is a good way to 
create a piece of 3D geometry that conforms exactly to another piece that it extrudes 
from. This works best on flat or slowly curving surfaces.



When perspective is Moderate, it may look like the profile is not aligned correctly for the 
projection. In Orthographic perspective, you can see how the objects line up.



After projecting the profile onto the object, move it aside to see the trim curve. Use the 3D 
trim tool to cut out the area defined by the trim curve.



 3D trim tool
Related topic: Trim Preference

Removes single, closed areas of 3D objects that have been defined with the projection 
and intersection tools. After defining the area that will be trimmed, blue trim curves 
appear on the object. 

To trim a 3D object:
1 Select the 3D trim tool. 
2 Click the trim curve. 

The arrow pointer displays a hollow circle when the cursor is directly over the trim 
guide. 

Note: The Show and Hide commands on the Object menu let you show and hide trim
curves.

3 Click the area on either side of the trim curve that you want to trim. 
After you have selected the trim curve, the cursor becomes a matte knife cursor, 
reminding you that any surface you click next will be cut. The 3D geometry within the
bounds of the trim curve is removed.

Note: The polygon face display setting is important when trimming. Trimming lets 
you see backfacing polygons when a hole is created. In order to display back faces, Back 
Faces or Both must be set using the Display Polygons command on the Object menu.

To undo a trim:
1 Navigate the hierarchy in the World browser and select the trim curve.

You can't select it in the workspace because it's not visible.

2 Choose Show from the Object menu and Selected Objects from the 
submenu.
The trim curve becomes visible in the workspace. (You can also select Trim Curves 
from the Show submenu to display all of the trim curves in the workspace.)

3 Press F3 and click the trim curve with the 3D trim tool.
The trimmed area is restored.



 Intersection tool
Related topic: Trim Preference

Draws trim curves at the points where two objects intersect. After using the intersection 
tool, use the appropriate trim tool (2D or 3D) to cut away parts of the object.

To mark an intersection of two objects:
1 Place two objects so that they intersect. 
2 Choose the intersection tool. 
3 Click near the intersection points of the first object and then the second. 

Extreme 3D marks the intersection points with a blue trim curve.

When showing the intersection of 3D objects, Extreme 3D highlights the area of 
intersection. For 2D profiles, one intersection point is placed closest to the intersecting 
area.
Intersecting two 3D shapes will produce two trim curves--one attached to each 3D shape.
In most cases, you may need to hide one of these objects to trim away part of its 
surface. If it seems like 3D trimming is not working, then you may be selecting the trim 
curve of object A and a surface of object B. If you hide objects, you'll be able to reliably 
select the desired object's trim curve.
Note: To define object intersections on an object's end caps, you must first separate 
the end caps. However, after end caps are separated, the object becomes three objects: 
the main body and two end caps, which makes these operations more difficult. An easier 
way to do this is to use the cross section tool to create the object (a cylinder or cube, for 
example). Because the cross section tool does not create objects with end caps, 
intersection and trimming operations are simplified greatly.





Unlink tool group 

Click a tool for more information:

 
The unlink tool group consists of the unlink and reparent tools. 

The unlink tool breaks existing links. 
The reparent tool moves an object up one level in the link hierarchy.



 Unlink tool 
Separates linked objects. When you break a link, the object reverts to the default parent, 
the world. The unlink tool can break all links except a watch link. To break a watch link, 
use the Watch Links command on the Window menu.
The unlink tool uses the unlink cursor to remind you that you're breaking a link.

To break a link:
Click the child object that you want to unlink with the unlink tool.

Note: You can also break a link by linking a child to a new parent or to the world, or 
by using the reparent tool.



 Reparent tool 
Moves the children of a selected linked object up one level in the link hierarchy. After 
applying the reparent link, the children of the linked object have the same parent as the 
former parent object. 
The reparent tool uses the reparent cursor to remind you that you are changing the 
hierarchical relationship of two objects.

To change an object's parent: 
Click the object with the reparent tool.
The object's children move up one level in the link hierarchy.

Modifier keys: Press F3 while clicking a parent object to place all of the objects in its 
hierarchy on the same level as the parent.



Because the pit is linked to the avocado, it stays with it when the avocado is removed.

By reparenting the pit, it stays with the plate when the avocado is removed.

In this example, the avocado halves and the banana are free linked to the plate. The 
avocado pit is free linked to the avocado. To remove the avocado but leave the pit behind, 
use the reparent tool to remove the avocado from the link hierarchy. The pit stays linked to 
the plate.



Link tool group 

Click a tool for more information:

 
This tool group consists of the free link, lock link, ball-joint link, and watch link tools, which 
allow you to create hierarchical relationships among objects and to edit the object hierarchy. 
By linking individual objects together, you can simulate the movement of complex 
mechanical and biological objects. By establishing hierarchical relationships among objects, 
you can make changes in one part of the hierarchical structure that affect other objects in 
the structure.

When you link two objects together, one object becomes the parent and the other 
becomes the child. The child object moves as the parent object does. For example, when
you link the movable joystick handle (the child) to a base (the parent), the handle moves
through space when the base does. 

By default, all objects have the world as their parent. Using the different link tools, you can 
define a new parent for an object, and specify how freely the child rotates and moves in 
relation to the parent. There are four types of links in Extreme 3D:

Free link: The child can move and rotate independently of the parent but the parent 
drags the child along when it moves. When the parent rotates, the child rotates around the 
parent's center point. This is the least constrained type of link.

Lock link: The child can't rotate independently of the parent, and it always rotates 
around the parent's center point. The child moves when the parent moves and vice-versa; 
neither can move independently of the other. 

Ball-joint link: The child can rotate independently of the parent, but can't move 
independently of the parent. When the parent rotates, the child rotates with it around the 
parent's center point.

Watch link: The z axis of the child object stays oriented to, and "watches" the center
of the parent object. When the parent moves, the child rotates to orient its z axis to the 
parent's new position. Both parent and child can move independently of one another.

An object can have a watch link and a hierarchical link. Each object's link constraints can 
be modified in the Objects browser.
Most link relationships are shown in the workspace. When you select the parent of a free,
locked, or ball-joint link in the workspace, all child objects are automatically selected and
highlighted in gray bounding boxes. To view the link relationships of watch links, use the 
Watch Links dialog box on the Window menu. Objects are listed according to their link 
hierarchies in the score and the World browser.
Note: You cannot link objects to the working plane.
Links cannot be animated. That is, an object cannot be linked, unlinked, or have its link 
changed over the course of the animation. However, an object can be animated in any 
direction that is not constrained by its link. 
Tip: Break sequences up into separately submitted rendering jobs to give the 
appearance of animated links.



The joystick handle is linked to the ball using a lock link; the ball is linked to the base using a
ball-joint link; the base is linked to the table using a free link. 



 Free link tool 
Links two objects with a free link in which the child object can be moved and rotated 
independently from its parent. When the parent moves, the child moves with it. When 
the parent rotates, the child rotates around the parent's center point. 

To create a free link:
Click the child object with the free link tool and drag a line to its new 

parent. The free link tool uses the free link cursor to remind you which kind of link
you are creating.



The cup is the child free-linked to the tray, which is the parent. The cup can move freely 
around the tray, but whenever the tray is moved the cup moves with it.



 Lock link tool 
Creates a link in which the child object rotates around the parent's center as the parent 
rotates. With a lock link, the parent and child always move together: neither can move 
independently. 

The lock link tool uses the lock link cursor to remind you which kind of link you are creating.

To create a lock link:
Click the child object with the lock link tool and drag a line to its new 

parent.



The socket is lock-linked to the base. It has the same orientation as the base and moves with
it.



 Ball-joint link tool
Creates a link in which the child object can rotate on all axes, but only moves as its 
parent moves. When the parent rotates, the child rotates around the parent's center. 
Some human joints, such as the shoulder, have ball-joint links.

The ball-joint link tool uses the ball-joint link cursor to remind you which kind of link you are 
creating.

To create a ball-joint link:
Click the child object with the ball-joint link tool and drag a line to its new 

parent.



The handle is linked to the base (the parent) with a ball-joint link. The handle can move back
and forth, but the handle always remains attached to the same location on the base.



 Watch link tool 
Identifies a link between two objects in which the z axis of the child object stays oriented
to the center of the parent object. Both objects can move independently of one another. 
This is most useful for creating tracking links between a light or camera and an object in 
the scene.
The watch link tool uses the watch link cursor to remind you which kind of link you are 
creating.

To create a watch link:
Click the child object with the watch link tool and drag a line to its new 

parent.
The child orients its negative z axis to the center of the parent when either of them 
moves. The child can still rotate around its own center, but will follow the parent in all
its movements. If the object selected as the child already has orientation tracks 
anywhere in the score, a link will not be allowed and a beep will sound.
Watch links are not duplicated when the object is duplicated or duplicated with links.

To automatically watch link the camera to an object: 
Press F3 while clicking an object with the watch link tool.
The camera is the child and reorients itself to watch the object as it moves.

Note: If the camera is watch linked to an object (where the object is the parent), it 
cannot rotate independently. 
To see which objects currently have watch links, or to break a watch link, select Watch 
Links from the Window Menu.



Extrude tool group 

Click a tool for more information:

 
This tool group consists of the extrude and bevel extrude tools, which pull profiles along an 
extrude depth line to create objects. For example, you can turn circles into cylinders and 
squares into cubes.



 Extrude tool 
Pulls profiles along a depth line to create objects.

To extrude a profile or set of profiles:
1 Select the extrude tool and click the profile to be extruded. Use Shift-click 

to select more than one profile.
If the selected profile contains other profiles, and those profiles are also selected, 
they are also extruded, creating holes in the larger object. 
The extrusion profiles need not be planar. Extrusion profile curves can have points in 
the x, y, and z dimensions. 

2 Click and drag the depth for the 3D object. You can drag along any axis. 
Extreme 3D always extrudes along the z axis of the working plane. 

Tool space: When the extrude tool is selected, the tool space displays an editable field 
for the extrude depth. To specify the depth of the extruded object, type the depth in the 
tool space and press Enter.

End cap preferences
To automatically include front and back caps on all 3D objects, including extruded 
objects, use the Cap Ends option in the Preferences dialog box.



 Bevel extrude tool 
Creates an extruded object with beveled edges. 

1 Select the bevel extrude tool and click the profile to be extruded. Use shift-
click to select more than one profile.
If the selected profile contains other profiles, and those profiles are also selected, 
they are also extruded, creating holes in the larger object. 
The extrusion profiles need not be planar. Extrusion profile curves can have points in 
the x, y, and z dimensions. 

2 If necessary, change the bevel width in the tool space. 
3 Click and drag the depth for the 3D object. 

You can drag along any axis. Extreme 3D always extrudes along the z axis of the 
working plane. 

Tool space: When the bevel extrude tool is selected, the tool space displays editable 
fields for the extrude depth and bevel width. To specify these parameters, type numbers 
in the tool space and press Enter.
Note: The extrude depth must be greater than the bevel width.

End cap preferences
To automatically include front and back caps on all 3D objects, including extruded 
objects, use the Cap Ends option in the Preferences dialog box. 

Bevel Preferences
You can set the style of the bevel in the Bevel Preferences dialog box. Open the dialog 
box by double-clicking the bevel extrude tool.

Bevel Options:
Bevel Front--Applies a bevel to the front cap of the extruded shape. 
Bevel Back--Applies a bevel to the back of the extruded shape. 
Hard Bevel--Applies a chamfered bevel to the object; if this option is not checked, a 

curved bevel is applied.



From left to right: Hard Bevel (chamfered), Front and Back, Back only, No Bevel



3D Primatives tool group

Click a tool for more information:

 
The 3D primitives tools draw basic 3D objects. 



 Cone tool
Draws a cone on the working plane.

To draw a cone:
Select the cone tool and click in the workspace. 
A cone is drawn with the default height and width of 1.0 model units. 
You can also drag in the workspace to draw the cone. Click to define the apex and 
then drag to define the base. Release the mouse button when the cone is the desired 
size.

Tool space: The dimensions for the cone appear in the tool space. To define the cone 
using the tool space, type the dimensions you want in the tool space and press Enter or 
click in the workspace to draw the object. 
Center-corner toggle: When the corner toggle is set, click to define the starting point 
of the object and drag to define a point on the perimeter. 



 Sphere tool
Draws a sphere on the working plane.

To draw a sphere:
Select the sphere tool and click in the workspace. 
The sphere is drawn with the default radius of .5 model units. 
You can also drag in the workspace to draw the sphere. Click to define the center and
then drag to define the radius. Release the mouse button when the sphere is the 
desired size.

Tool space: The dimensions for the sphere appear in the tool space. To define the 
sphere using the tool space, type the dimensions you want in the tool space and press 
Enter or click in the workspace to draw the object. 
Center-corner toggle: When the corner toggle is set, click to define the starting point 
of the object and drag to define a point on the perimeter. 



 Cube tool
Draws a cube on the working plane.

To draw a cube:
Select the cube tool and click in the workspace. 
The object is drawn with the default width of 1.0 model units.
You can also drag in the workspace to draw the cube. Click to define the center and 
then drag to define the radius. Release the mouse button when the cube is the 
desired size.

Tool space: The dimensions for the cube appear in the tool space. To define the cube 
using the tool space, type the dimensions you want in the tool space and press Enter or 
click in the workspace to draw the object. 
Center-corner toggle: When the corner toggle is set, click to define the starting point 
of the object and drag to define a point on the perimeter. 



 Sweep tool
Related topic: Sweep Tool Preference

Pulls a profile along a path to create a 3D swept object. For example, sweeping a circle 
along a line produces a cylinder, which could be done using the extrude tool, as well. 
However, sweeping a circle along a spline curve creates a segment of curved tubing, like 
a bent pipe.

To create a swept object: 
1 Select the sweep tool.
2 Click the profile (or Shift-click to select multiple profiles) that you want to 

specify as the sweep profile. 
Selecting multiple sweep profiles that overlap or are entirely contained within another
profile creates swept objects with interior cavities. 

3 Select the profile that you want to specify as the sweep path. The sweep is 
performed immediately after selecting the sweep path. 
By default, the swept object inherits the position and orientation of the original sweep
path, so if multiple profiles and a single path were used, some of the final swept 
objects may be obstructed by others. To change this default, use the Sweep 
Preferences dialog box.
The profile and path need not be planar curves. Both can have curves that have 
points along all three coordinates, x, y, and z.

Tool space: When the sweep tool is selected, the tool space displays editable fields for the 
beginning scale and ending scale of the sweep. This allows you to create a tapered sweep 
object--a nautilus shell, for example, or a lamp post, like the one below. The spacing of 
control points or polygon vertices affects the change in scale. Where control points or 
vertices are far apart, the taper is more gradual. Where control points or vertices are close 
together, the taper is steeper.



Sweep Tool Preferences

Open the Sweep Tool Preferences dialog box by double-clicking the sweep tool in the tool
palette.
Number of Sections--Controls the number of interior cross-sections for each segment 
of the sweep path. (A segment is the area between two control points.) The greater the 
number of cross-sections, the smoother the swept object will appear. This is particularly 
useful in making a sweep path with steep or irregular turns look smoother. The default 
number of cross-sections is 1.
You can view the number of sections in a swept object on the Sweep page of the Objects 
browser.
Sweep with Respect To:

Fix Path Location--Aligns the sweep profile to the path. This is the default setting. The 
resulting object inherits the position and orientation of the path.

Fix Profile Location--Aligns the sweep path to the profile. The resulting 3D object 
inherits the position and orientation of the profile.

End cap preferences
To automatically include front and back caps on all 3D objects, including swept objects, 
check the Cap Ends preference in the Preferences dialog box.



The tube was created by sweeping the two concentric circles (top illustration) along the 
sweep path.



Editable text fields were used to set the beginning and ending scale of the tapered lamp 
post.



 Lathe tool
Rotates a profile around a defined axis, creating a 3D object.

To lathe a profile: 
1 Select the lathe tool.
2 Click the profile to be lathed.

If the selected profile contains other profiles, and those profiles are also selected, 
they are lathed as holes. This is more obvious if the lathe angle is less than 360 
degrees, because otherwise the hole is entirely enclosed inside of the object.

3 Click and drag a line to define the axis around which the object will be 
lathed, or click two points of the axis in the workspace.
The placement of the axis in relation to the object determines the shape of the final 
object. 

Tip: To create a donut (torus), draw a circle and then draw the lathe axis outside 
the circle.
Tool space: When the lathe tool is selected, the tool space displays an editable field for 
the lathe angle, expressed in degrees. By default, an object is lathed 360 degrees around
the specified axis. However, you can type any lathe angle in the tool space. If you want a
half-lathe, for example, type 180 degrees in the tool space and press Enter. Then define 
the axis around which you want to lathe. You can edit the lathe angle in the Objects 
browser. The lathe angle can be animated.

End cap preferences
To automatically include front and back caps on all 3D objects, including lathed objects, 
use the Cap Ends option in the Preferences dialog box. You will see end caps only if the 
lathe angle is less than 360 degrees. 





Deformation tool group 

Click for more information: Deformation Tool Preferences
Or click a tool for more information:

 
This tool group consists of the twist, bend, taper, stretch, and skew tools. These tools deform
objects over a defined range in a number of ways. 
To deform 3D objects, their surface geometry must be simplified. When you select an object 
that hasn't been simplified for use with any of the deformation tools, a dialog box appears, 
giving you the option to simplify the object or deselect it. The deformation tools use the 
arrow cursor when you select the object to be deformed. You can perform the deformation 
interactively when the cursor changes to a hollow arrow.

For greater control when using all of these tools, insert additional control points, 
particularly when deformations are confined to a specific region of the object.
All deformations can be animated. When experimenting with deformations, make sure 
that the current time in the score is set to zero, or that the animation toggle is off, if you 
don't want deformation changes to animate in the scene.



Deformation Tool Preferences

The Deformation Tool Preferences dialog box specifies the axis along which the tool 
deforms the selected object. Open the dialog box by double-clicking a deformation tool in
the tool palette.
By selecting the options in this dialog box, you can set the tool to deform the object 
along a particular axis or plane. 

Deform Along:
Object's X Axis--The tool deforms around the object's x axis (deforms the object's y-

z plane).
Object's Y Axis--The tool deforms around the object's y axis (deforms the object's x-

z plane).
Object's Z Axis--The tool deforms the object around the object's z axis (deforms the 

object's x-y plane). This is the default.
Working Plane's Z Axis--The tool deforms the object along the z axis of the working

plane, rather than along the object's coordinates.

Opposite Direction
When this checkbox is selected, the object deforms in the opposite direction

Deform Down Tree
When this option is checked, the children of the selected object also deform.



 Twist tool
Twists the selected object around the object's axis, as defined in the Deformation Tool 
Preferences dialog box. By default, the object is twisted around its z axis.
Using this tool you can apply a twist over the entire length of the object. Alternatively, 
you can twist a section of the object.

To perform an unlimited twist:
1 Select the twist tool and click the object. 
2 Drag anywhere in the workspace.

The object continues to twist as long as you drag.
To perform a limited twist, you must define the beginning and end of the 
section to be twisted. 

1 Select the twist tool and click the object. 
2 Press F3 and click the beginning and ending points for the twist. 
3 Drag anywhere in the workspace. 

When you drag the object, the object twists between the points. Tangents outside the
section may move slightly to provide a smoother transition between the twisted and 
untwisted section of the object.

Note: To gain greater control over a limited twist, add more control points to the part
of the object that you want to twist. 

Tool space: When this tool is selected, the tool space displays an editable text field showing
the twist angle. The amount of twist is expressed as an angle in degrees of counterclockwise
twist.
Modifier keys: Press F3 to define the beginning and end of the section to be twisted. 



Left to right: no twist, boundary of a limited twist, limited twist, unlimited twist



 Bend tool
Bends the selected object within a plane, as defined in the Deformation Tool Preferences 
dialog box. Deformation Preferences settings constrain bending as follows:

Setting Bending plane
Object's X Axis Y-Z plane 
Object's Y Axis X-Z plane
Object's Z Axis X-Y plane
Working Plane's Z Axis X-Y plane

Note: Select the working plane's z axis preference and rotate the working plane to 
control the direction of the bend.
Using this tool you can apply a bend over the entire length of the object. Alternatively, 
you can limit the bend to a section of the object.

To perform an unlimited bend:
1 Select the bend tool and click the object. 
2 Drag anywhere in the workspace. 

The object continues to bend as long as you drag.
To perform a local bend, you must also define the beginning and end of the section to be 
bent. 

1 Select the bend tool and click the object. 
2 Press F3 and click the starting and ending points of the section you want to

bend. 
3 Drag anywhere in the workspace. 
When you drag the object, the object bends between the points. Tangents outside the 
section may move slightly to provide a smoother transition between the bent and unbent
sections of the object. To make a sharper bend or to confine the bend further, add extra 
control points around the bend start and stop points before bending.

Tool space: When this tool is selected, the tool space displays an editable field for the bend
angle, expressed in degrees of counterclockwise bend.

Modifier keys: Press F3 to define the beginning and end of the section to be bent. 



Left to right: before bending, bending along entire length, limited bend



 Taper tool
Tapers the selected object along an axis, as defined in the Deformation Tool Preferences 
dialog box. By default, the object tapers along its z-axis.
Using this tool you can apply a taper over the entire length of the object. Alternatively, 
you can taper a section of the object.

To perform an unlimited taper:
1 Select the taper tool and click the object. 
2 Drag anywhere in the workspace. 

The object continues to taper as long as you drag.
To perform a limited taper, you must also define the beginning and end of the section to 
be tapered. 

1 Select the taper tool and click the object. 
2 Press F3 and click to define the starting and ending points of the taper. 
3 Drag in the workspace.

When you drag, the object tapers between the points. Tangents outside the section 
may move slightly to provide a smoother transition between the tapered and 
untapered section of the object.

Tool space: When this tool is selected, the tool space displays an editable field for the 
amount of taper, expressed as a scaling factor for the amount of taper applied to the end
of the taper. 
Modifier keys: Press F3 to define the beginning and end of the section to be tapered. 



Left to right: original object, tapered along entire length, limited taper



 Stretch tool
Stretches the selected object along the object's axis, as defined in the Deformation Tools 
Preferences dialog box. By default, the object is stretched along its z axis. You can apply 
a stretch over the entire length of the object. Alternatively, you can stretch a section of 
the object.

To perform a global stretch:
1 Select the stretch tool and click the object. 
2 Drag anywhere in the workspace. 

The object continues to stretch as long as you drag.
To perform a limited stretch, define the beginning and end of the section to be stretched.

1 Select the stretch tool and click the object. 
2 Press F3 and click to define the starting and ending points of the section 

you want to stretch. 
3 Drag anywhere in the workspace.

When you drag the object, the object stretches between the points. Tangents outside 
the section may move slightly to provide a smoother transition between the 
stretched and unstretched section of the object. 

Tool space: When this tool is selected, the tool space displays an editable field for the 
scaling factor to be applied to the stretched object.
Modifier keys: Press F3 to define the starting and ending points of the stretch. 



Top to bottom: original object, limited stretch, unlimited stretch



 Skew tool
Shifts an object along a plane, as defined in the Deformation Tool Preferences dialog box.
Deformation Preferences settings constrain skewing as follows:

Setting Skewing plane
Object's X Axis Y-Z plane 
Object's Y Axis X-Z plane
Object's Z Axis X-Y plane
Working Plane's Z Axis X-Y plane

Note: Select the Working Plane's Z Axis preference and rotate the working plane to 
control the direction of the skew.
Using this tool you can skew the entire length of the object. Alternatively, you can skew 
only a section of the object.

To perform an unlimited skew:
1 Select the skew tool and click the object. 
2 Drag anywhere in the workspace. 

The object continues to skew as long as you drag.

To perform a limited skew, you must also define the beginning and end of the section to 
be skewed. 

1 Select the skew tool and click the object. 
2 Press F3 and click to define the starting and ending points of the skew. 
3 Drag anywhere in the workspace.

When you drag the object, the object skews between the two points. Tangents 
outside the section may move slightly to provide a smoother transition between the 
skewed and unskewed section of the object.

Tool space: When this tool is selected, the tool space displays an editable field for the 
skew amount, expressed as the maximum distance any point of the object will be shifted.
Modifier keys: Press F3 to define the starting and ending points of the skew. 





Skin tool group 

Click for more information: Skin tool preferences
Or click a tool for more information:

 
This tool group consists of the skin tool and the cross-section tool. The skin tool stretches a 
surface between two or more profiles. The cross-section tool stretches one profile along the 
shape of a second profile.



Skin Tool Preferences

Open the Skin Tool Preferences dialog box by double-clicking the skin tool.
Linear Surface Between Profiles--Creates a noncurved surface between the skin 

profiles. By default, this option is off, and a curved surface is created between skin profiles.

From the same skin profiles, Extreme 3D created two different objects.
Auto Profile Direction--When you skin two open profiles, this option reconciles the 

order of the points along the open skin profiles and sets the location of the start point of all 
profiles to the location of the start point of the first profile of the skin. 

For example, when this option is selected, and one skin profile is created from top to 
bottom and another is created from bottom to top, Extreme 3D reconciles them so 
that the points go in the same direction. When this option is not selected, Extreme 3D
skins the profiles in the order that the points on the skin profiles were created.

Note: You can also achieve this same effect manually for a single profile by choosing
Reverse Ordering from the Control Points submenu on the Object menu. This reverses 
the order of control points in the profile.

Distribute Along Curve Length--Matches the control points of profiles based on 
their length. The length of the first curve is calculated and control points are distributed 
uniformly along its length. Then each successive profile length is calculated and its control 
points are uniformly distributed. Extreme 3D makes the skin by matching control points by 
their location on the profile. 

For example, the first control point, located at half the length of the first profile, is 
matched to the control point that is located at half the length of the second profile. 
This option works well with profiles that do not have the same number of control 
points. You can change the start and end points of any profile manually using the 2D 
trim tool. Holding the F3 key, trim at the new start point. Then use the Join Profiles 
command on the Object menu to join the profiles. The point at which you trimmed is 
now the first control point.

End cap preferences

To automatically include front and back caps on all 3D objects, including skinned objects, 
check the Cap Ends checkbox in the Preferences dialog box.



Left to right: original profiles, Linear Surface Between Profiles off, Linear Surface Between 
Profiles on



Left: Auto Profile Direction off
Right: Auto Profile Direction on



 Skin tool
Click for more information: Skin tool preferences

Creates a new object by stretching a surface between a series of two or more profiles. By
skinning a series of arcs, for example, you can make a canoe or an airplane wing. You 
can skin a path, such as a spline, or closed shapes, such as rectangles.

To create a skinned object:
1 Create the skin profiles and situate them in their desired positions and 

orientations.
You may want to rotate some profiles to achieve the desired shape of the skinned 
object.

2 Select the skin tool, then select the profiles to be skinned in the order that 
they should be skinned.

3 Double-click or press Enter to perform the skin. 

You can also create a skin by first selecting all of the skin profiles and then selecting the 
skin tool. A dialog box opens asking whether you want to create the skin or deselect the 
profiles.

If you choose Create, the tool determines a probable ordering of the profiles and 
produces the skinned object. 

If you choose Deselect, the profiles are no longer selected and you must reselect 
them by clicking them in the order you want them to be skinned.

The order in which profiles are selected plays a part in the look of the final skinned 
object. Extreme 3D creates the skinned object by matching the control points of one 
profile with those of the next profile. The Skin Preferences dialog box provides options for
how the control points on the skin profiles are matched to perform the skin. 
Note: Curves are skinned from the first point of the first profile to the first point of 
the second profile, and so on. If your profiles don't skin as expected, open them up and 
check the relative positions of the first points on each curve. You can use the control 
point tool to specify a different first control point.
Note: Skin profiles need not have the same number of vertexes or control points.



The profiles on the left were selected and then skinned to form the smooth 3D object on the 
right.

The profiles in bold have more control points than the other profiles. To create a shape with 
notches, you need cross-sections with different numbers of control points



 Cross-section tool
Creates 3D objects from two profiles that become the face and the cross-section of the 
object. The face and cross-section profiles can be created using any of the 2D tools.
In an operation that is a cross between lathing and skinning, Extreme 3D stretches the 
cross-section over the front profile. When the 3D object is generated, the front profile 
maintains its shape, while the cross-section may be stretched to conform to the 
dimensions of the front profile.

To generate a 3D object:
1 Draw the profiles that you will use as a front profile and cross-section. 
2 Select the cross-section tool and click the profiles. 

The first profile you click becomes the object's cross-section. The second object you 
click becomes the front and side profile. 

3 Press F3 and drag to define the axis for the cross-section or front profile. 
The axis must cross the front profile.

4 After the cross-section and front profile are defined, press Enter to build 
the 3D object.
Extreme 3D automatically pulls the cross-section along the front profile and lathes 
the front profile in the direction of the axis. 

Modifier keys: Press F3 and drag to define the axis for the cross-section or front profile.










